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1

Introduction

Welcome
GraFit version 6 for Microsoft® Windows™ combines presentation-quality scientific
graphs with comprehensive data fitting. The result is a powerful package that is
easy to use, produces stunning output, and can also fulfill the needs for
quantitative data analysis. Data can be fitted using various types of theoretical
models, and your own equations can easily be added to those supplied with the
program. Comprehensive graph plotting facilities allow you to display your data onscreen and edit the graphs interactively.

Key Features of GraFit
GraFit provides the experimental scientist with a tool for visualization and analysis
of their data. For the occasional user, GraFit can be configured to perform routine
analyses with minimal intervention—in many cases it is possible just to enter the
data and allow GraFit to calculate the results and plot the graphs in the
background. Advanced users can utilize the full power of GraFit for analyzing
complex equations, and may create custom fitting templates for routine data
processing.
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About this Guide
This manual describes how you can use GraFit to examine your data, and to plot
graphs. We recommend that you read the manual fully, and try out some of the
examples described.

Notational Conventions
The following notational conventions are used throughout this manual:
Convention

Meaning

SMALL CAPITALS

Small capitals indicate keys to be pressed. For instance,
A

indicates ―press the ‗A‘ key‖. If more than one key needs to be
pressed this is written as (for instance)
SHIFT END

which would mean ―hold down the ‗Shift‘ key and then press the
‗End‘ key‖.
Monospace

Monospace type indicates text that should be entered on the
computer keyboard. For example, to obtain a directory of drive
A: when running a Command Prompt window, you would enter
DIR A:

Bold

RETURN

Bold text is used for menu item commands, e.g. the Edit menu.
Where cascading menus are present, an arrowhead () is used
to separate the sub-menus. For example, the Windows Control
Panel application is started from the desktop Start  Control
Panel command.

Important information that should be noted is written in italics, and separated from
other text by horizontal rules, as here.

Contacting Erithacus Software
Address
Erithacus Software Limited
PO Box 274
Horley
Surrey
RH6 9YJ
UK
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Technical Support
At Erithacus Software we are working hard to provide you with intuitive technical
products. However, if you find yourself with a technical question that you cannot
resolve, please contact our technical support department. Registered users can
obtain technical support from one of the following sources:



Fax:

[+44] (0)1342 841 939



Email:

support@erithacus.com



Internet:

http://www.erithacus.com/grafit

Note

Always quote your serial number and the product version, which are shown
on the About screen (Help  About GraFit command).

Internet
Our web site can be found at http://www.erithacus.com and here you will find
latest information about our software products. In addition, we post technical
notes, tips and answers to common problems.
Tip

Be sure to check out http://www.erithacus.com/grafit to download the
latest fixes and updates.
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2

Installation and Activation

System Requirements
Software
GraFit version 6 requires Windows 2000, Windows XP, Windows Vista or later.

Hardware
Any computer that is capable of running the Windows operating system in use.

The GraFit Package
The GraFit package comprises the following:



GraFit program on CD-ROM or via electronic download.



The GraFit User‘s Guide (this manual). Depending upon the GraFit package that
was purchased, this guide may only be available in electronic form.

When GraFit is first run you will be able to register the product. Registration is
optional, but will ensure that you are informed of the latest updates to the
program.

Installing GraFit
Online Installation
Download and run the installation
(www.erithacus.com/grafit).

program

from

the

GraFit

website

CD-ROM Installation
Insert the GraFit CD-ROM into your CD or DVD drive. The Welcome screen will load
automatically.
Note

Some systems are configured so that automatic running of CD-ROM
software is disabled. If your system is set up in this way, the Welcome
screen can be displayed by selecting the Run command from the Windows
Start menu, and entering the command D:\CDRUN where D: is the drive
letter of your CD-ROM.
17
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GraFit
Select the Install GraFit option to install GraFit onto your computer. The
installation program will copy the files to your hard disk, and place an entry for the
GraFit program on the Start button, under the Programs entry.

Adobe Acrobat Reader
The GraFit installation includes this user manual saved in Adobe Portable Document
Format (PDF). If you wish to read this file, it is necessary to have the Adobe
Acrobat Reader (version 5 or later) installed. If you do not already have this
software installed, you can choose to do so by selecting Install Acrobat Reader.
Installation of Acrobat Reader requires your computer to be connected to Internet.

Activating the GraFit Program
After installing GraFit, whether from the CD-ROM or online, it is possible to run the
software in evaluation mode for 21 days. During this time the program is fully
functional. To continue running the program after the evaluation period expires, it
is necessary to activate the program online by entering a valid activation code
(serial number). Activation codes are purchased; after the program has been
activated it will run without showing the activation dialog box again.

Activation Dialog Box
Before GraFit has been activated, running the program will produce the following
dialog box:

This shows the remaining evaluation period; if you are still within the 21 day
evaluation period then you may run the program by clicking the Evaluate button.
Once the evaluation period has expired you will not be able to run the software
until you have entered an activation code.
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Setting Proxy Settings
For some users, access to the internet needs to be via a Proxy Server. Providing
you can access the internet using a browser such as Microsoft Internet Explorer,
GraFit will automatically make use of any proxy settings that might be needed. In
some rare circumstances it may be necessary to use custom proxy settings in order
to access the internet; these can be set by the Change Proxy Settings button.

Running in Evaluation Mode
The software can be evaluated for 21 days prior to purchase. To start your
evaluation period, click the Evaluate button. In order to start the evaluation your
computer must be able to access the internet.
The first time you evaluate the software, you will need to supply information about
where the Evaluation code should be delivered. This code will be emailed to you at
the address entered into the following dialog box:

Click OK to request an evaluation activation code. This code will be sent
immediately, but you should allow a few minutes for your email system to process
the message.
Note

Most email systems are set up to move unsolicited email to a "Junk" email
folder. In the event that you cannot find your evaluation code email, try
looking in your Junk folder in case it has been moved there.

Using the Evaluation Activation Code
When you receive the email with your code, paste this into the Activation Code
box and click the Activate button.
During activation you will be asked to provide a password, which will be needed in
future if you reactivate or deactivate the software and an email address that is
used to allow automatic reminders to be sent if you forget your password.
During the evaluation period the software is fully functional. After the evaluation
period has ended it will no longer be possible to run the software unless you
purchase and enter an evaluation code.
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GraFit running in evaluation mode

Purchasing a Full Activation Code
Full Activation codes can be purchased online by following the link on the Activation
dialog box.

Activating the Software
Once you have purchased a full activation code, paste this into the Activation
Code box and click the Activate button. If you purchased GraFit on CD-ROM the
activation code (serial number) will be present on the software case; if you have
downloaded the software you may purchase an activation code online.
During activation you will be asked to provide a password, which will be needed in
future if you reactivate or deactivate the software. You will also be asked to provide
an email address. This address is used to allow automatic reminders to be sent if
you forget your password.
Activation is done via the internet; if your computer is not connected to the
internet it is possible to carry out offline activation. See the online help for a full
description of how offline activation is carried out.

Deactivating GraFit
Your GraFit software needs to be activated on-line, during which time a count is
made of the number of times an individual activation code is used. You will not be
allowed to activate software more than the number of times allowed by your
license agreement. This means that if you wish to move your software to a
different computer you should first deactivate it on the original computer.
Warning

Once you have deactivated your software it will no longer run until it is
once more reactivated.

Deactivation
To deactivate your previously-activated software, select the Help About dialog and
select the Deactivate button. You will need to enter the password that you gave
20
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when you originally activated the product. If you have forgotten your password,
clicking the Forgotten password? button will automatically email this to you

Changing Computers
If you change computer, it is necessary to deactivate your GraFit installation from
the old computer before reinstalling the program on the new computer.

Checking for Software Updates
You can check to see whether any program updates are available by running the
Help  Check for Updates command. If updates are available online you have the
opportunity of downloading and installing them.

Uninstalling GraFit
GraFit can be removed from your system by the following procedure.
1. From the Windows Start menu, launch the Control Panel application.
2. Double-click the Add or Remove Programs icon.
3. Choose GraFit 6 to uninstall, and click the Change/Remove button.
4. Follow the instructions
Note

We recommend that you deactivate GraFit, as described above, prior to
uninstalling the program.
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3

GraFit Basics

Running GraFit
The GraFit installation program will add a GraFit entry to the Programs list on your
Windows Start menu. When you run the GraFit program, the main GraFit window
will open.

Ribbon or Menu and Toolbars
GraFit 6 uses by default an Office 2007-style ribbon bar to access the various
commands. The ribbon bar combines the functionality of both toolbars and menu
bars, which are used in more traditional Windows programs.

Office 2007-style Ribbon Bar
GraFit logo button. Click here to access the File menu
Quick Access Toolbar

GraFit 6 using the Office 2007-style ribbon bar
The ribbon bar displays commands grouped on a series of tabs, giving a less
cluttered layout than the traditional display, together with a ―Quick Access Toolbar‖
that can be customized to hold commonly used commands in a consistent manner.
The File menu is accessed via the GraFit logo button, found in the top left of the
GraFit window.

Using the Ribbon Bar
The ribbon bar comprises a set of tabs that hold related commands. Each tab has
one or more ribbon groups that collect toolbar buttons. Click on the button to
activate the command.
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Currently selected tab
Tab specific to current item window

Ribbon groups
The Home tab holds frequently used commands; the Text tab has commands that
are used for text formatting; the View tab has commands that relate to the way
information is displayed. These three tabs are always present, but in addition there
are some tabs that hold commands specific to particular item windows. When a
data table windows is selected (as above), a Table tab is present on the ribbon
bar; when a graph item window is selected a Graph tab will be found.

Using the Quick Access Toolbar
The Quick Access Toolbar can be used to hold any commands that you frequently
access. In the example below, various formatting commands have been added.

Click
here
customize

to

The Customize button allows various aspects of the toolbar to be specified,
including whether the toolbar is drawn above (as shown) or below the ribbon bar.
To add commands to this toolbar, either use the Customize button or right-click
on any command button that is found on the ribbon bar and select Add to Quick
Access Toolbar.

Legacy-style Menu and Toolbars
It is also possible to run GraFit using a legacy-style combination of menu and
toolbars, giving an appearance that is similar to GraFit version 5 and earlier. The
legacy style may be preferred by existing users of the program.
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Menu

Toolbars

Toolbar
options, click
here to
GraFit 6 using legacy-style menu
and toolbars
customize

Customizing Menus and Toolbars
To customize menus and toolbars, click the Toolbar Options button that is found
on the right of each toolbar. You can completely customize the commands that are
found on each toolbar and menu by dragging and dropping the various command
button icons.

Swapping Between Ribbons and Menu/Toolbars
The Appearance command is used to change the layout of the program. The
location of this command is found on the Options menu of the ribbon bar, or the
View menu when in menu and toolbar mode.

Changing from ribbon to menu and
toolbars

Changing from menu and toolbars to ribbon

The GraFit Workspace
When initially opened, the GraFit workspace is empty. A GraFit file can comprise
one or more data tables, graphs, data analyses, equation definitions,
transformation definitions, notepads and embedded objects. Collectively, these
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items make up the GraFit workspace, which are stored to disk as a single file. After
adding a number of items to the workspace, the appearance of the GraFit window
is shown below.
Items pane
Item window
selection tabs

Active item
window

A GraFit workspace with a number of items added
In this example, one each of the following items has been added: a data table; a
graph window; a non-linear fitting item; a linear fitting item; an equation definition.
The linear fit and graph items have been closed so that their windows are not
visible in the workspace; their icons within the Items pane are drawn lighter to
reflect this. All the added items are stored inside the same GraFit workspace, and
can be saved and loaded from disk using the File menu commands. If you run a
second copy of GraFit, you can copy items between workspaces by drag and drop
or by using the commands in the Clipboard group1 to copy and paste items via the
1
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Windows Clipboard. Each item in the workspace is represented by an icon in the
Items pane.

GraFit Items
GraFit items are initially created in a new window that residues within the main
GraFit window, and are identified by the presence of an icon in the Items pane.
Closing an item window does not delete the item — it simply makes the window
invisible. This allows you to keep open only those items that you are currently
working on.

Managing Items
Adding New Items
To add a new item to the workspace:



Use the Add command on the Home tab2 and select the type of item that you
require.

Switching Between Items
To switch between items:



Click on the window to activate, or click on the icon that represents this item in
the project window, or use the item window selection tabs.

Removing Items
To delete an item from the workspace:



Select the icon that represents the item in the project window, and choose the
Clear command3.

Item Representation
When an item window is closed, the contents of the item still remain present in the
GraFit workspace file. The item window can be reopened by double-clicking on the
icon, which is found in the Items pane. The icon that represents the item is shaded
so that it indicates the current state of the item, as shown below.

Linear Fit,
open

Linear Fit,
closed

2
3

GraFit item, open. The icon is drawn normally.

GraFit item, closed. The icon is drawn as a ghosted image, which is
lighter than normal.

The Add menu in legacy mode
The Edit  Clear command in legacy mode
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Embedded
item, open

Embedded
item, closed

Linked item,
closed

Embedded object, open for editing. The object icon is shown
overdrawn with hatched lines.

Embedded object, closed. The icon is drawn ghosted.

Linked object, closed. A shortcut overlay (

) is added to the icon.

Switch between item windows to edit their contents. Information about using each
of the GraFit item types is found in Chapters 5-13.

Editing the Item Name
Items are referred to by the name shown in the project window, so it is useful to
change this from the default to something more meaningful. To edit the item name,
select the icon in the project window, choose the Edit  Rename command and
type in the new name.
Item names can contain any characters, but must be different from any other item
name in the workspace.

Changing the Item Icon
The icon that represents an item may also be changed. This can be useful to allow
similar items to be visually distinguished. To change the icon, select it and choose
the Icon command4 (on the View tab of the ribbon). For each item type there are
a number of alternative images that can be used. In addition, it is possible to use
an icon image that resides in any executable or DLL file on your computer.

Item-specific Commands
Although some commands apply to all GraFit items, many are item-specific. For
example, the Fit Data command applies to the Linear fit and Non-linear fit items,
but not to the Data table or Graph items. Commands that are not available are
shown grayed. In addition, each item window has one or more specific menus that
are only present when this window is selected. For example, only graph items have
Graph and Object menus.

Printing the Item Contents
The contents of any item window can be printed using the File  Print command,
and the printing previewed using the File  Print  Preview command.

4
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Print preview

Page Settings
The File  Print  Page Setup command5 allows the paper size and orientation to
be specified, and the margin sizes to be entered. These settings are stored
separately for each item in the workspace.

5

File  Page Setup command in legacy mode
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A header and footer are printed at the top and bottom of the page, respectively.
The header and footer text can contain special strings such as the file name or the
time that the item was printed. These special strings are specified by clicking on
the
button. To omit the header and/or footer from the output, leave the entries
for the Header text and/or Footer text blank. The font used to display the header
and footer text can be selected by clicking on the Fonts button.

Changing the Printer
To change the printer from the default, click on the Printer button.

Stock Items
Individual GraFit items can be stored for future reuse by selecting an item and
using the Store Stock Item command. They are reloaded using the Add Stock
Item command6. Storing and loading of items is especially useful for saving and
restoring equation definitions, but can be used for any GraFit item. See Chapter 4
for more information about the location of item files.

GraFit Templates
Workspace files can be created by adding a number of items as described above.
Alternatively, it is possible to load a pre-built workspace from a template, using the
File  New command. See Chapter 4 for more information about using templates.

6
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In legacy mode these commands are File  Store Stock Item and File  Add Stock Item
respectively.
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Accessing Help
GraFit includes a complete on-line help system to guide you through using the
program.

To view the help topics


From the Help menu, select the Contents command.
Help menu

To obtain specific help for a dialog box


Click on the Context Help button in the top right of the dialog box to display the
help that is available for that dialog box.
Context Help menu
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4

Working with Files

GraFit Workspace Files
The GraFit workspace consists of all the items displayed in the main GraFit window
(data tables, graphs etc.). The contents of the workspace are stored together in a
GraFit workspace file, which has the .GFF extension. In addition to the contents of
the workspace, the current window sizes and positions are also stored in the
workspace file.

Opening an Existing File
Choose the File  Open command to open an existing GraFit workspace file. This
will bring up the Open dialog box.

Windows Vista
When running GraFit on Windows Vista, the program uses the new Vista-style Open
dialog box, as shown below.
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The locations of your GraFit Data and GraFit Templates directories are added to
your Favorite Links entries, allowing you to navigate quickly to these. (The
locations of these special directories are chosen from the Options command, on
the View tab7.)

Windows 2000/XP
Earlier versions of Windows use the older-style file open dialog box.

The buttons marked GraFit Data and GraFit Templates allow you to rapidly to
the default data and user template directories respectively. (The locations of these
special directories are chosen from the Options command, on the View tab7.)

Saving a File
GraFit workspace files are saved using the File  Save or File  Save As
commands. The contents of the workspace are saved, along with the current
window positions and order. When the file is reloaded, these positions and order
are restored.

Loading and Saving Individual Items
Saving Items
The GraFit workspace comprises a number of individual items, such as data tables,
graphs and analyses. These individual items are saved in one of the following
ways:



7
8
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Select the item in the Items pane (or click on the item window), and then
select the Store Stock Item command8.
The View  Options menu in legacy mode
The File  Store Stock Item command in legacy mode
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Items are stored as files that have a .GFC file extension. By default, items should
be saved in the item store directory, or a subdirectory off this. (The location of the
item store directory is specified using the Options command, on the View tab.)

Loading Items
Stored items can be loaded using the Add Stock Item command9.

Creating a New File
To reset the GraFit workspace:



Select the File  Close command10.

Importing Data Files
Data can be imported into GraFit to create a new data table item that holds the
imported data. To create this item, select the Import Data command11. Any file
for which a filter is available can be imported into GraFit (see the following section
on Import/Export Filters).
It is also possible to paste data from a file directly into an open data table. To do
this, use the Paste From command found on the Table tab12.

Import/Export Filters
In order to perform conversions between GraFit and other data types, GraFit uses
installable import/export filter files. Several standard filter types are supplied by
default with GraFit, and other filters may be available from certain instrument
manufacturers or from Erithacus Software. These filter files, which have the .GFR
file extension, are installed into GraFit from the Options command, on the View
tab, Data Filters page.
Please contact Erithacus Software if you have special requirements for a specific
filter file.

GraFit Template Files
Template files are pre-made workspace files that are used to speed up use of
common procedures. Template files differ from workspace files in the following
ways.



They are represented by a different icon.



Double-clicking on a template file opens a copy of the file rather than the file
itself.

9
10
11
12

The File  Add Stock Item command in legacy mode
In legacy mode, click on the New command button,
toolbar.
The File  Import Data command in legacy mode
The Edit  Paste From command in legacy mode
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Templates stored in the user or group template directories can be rapidly
accessed using the File  New command.

Creating a Template File
To store a workspace as a template file, select the File  Save As command, and
save as type ―GraFit Template Files.‖ If you wish to access this template using the
File  New command, ensure that the file is saved into your user or group
template directory (see the following section on Template Directories). To help with
this, the Save As dialog box contains a button that will jump immediately to your
user template directory.

Creating a File Based on a Template
The File  New command creates an untitled file based on a selected template.
This command in described in the following section. Chapter 23 describes the
standard templates that come pre-defined with GraFit.

Template Directories
There are two directories that have special significance when storing template files.
These are the user and group template directories, the location of which is specified
from the Options command, on the View tab, Directories page:

Click on the
button to change a directory setting. By having two separate
locations for templates it is possible to keep user-specific files separate from
general templates that are used by a group of users. It can be useful, for example,
to maintain a group directory on a network server.
36

Chapter 4: Working with Files
Files in a template directory appear on the General tab of the File  New dialog
box. Any subdirectories have special significance, and result in additional tabs on
this dialog; clicking on the tab accesses the files in these subdirectories.
Note:

Empty subdirectories do not appear in the File  New dialog box.

The files displayed on this dialog box are the sum of those present in the user and
the group template directories. (The specific location of any individual file can be
found by right-clicking on the icon, and choosing the Properties command. In the
event that a file with the same name is found in both the user and group
directories, the user file has precedence.) To create a new workspace file based on
one of these templates, select the one to use and click OK.

GraFit Version 6 at 22:08 on 25 March, 2009
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5

Data Tables

The Data Table Item
To add a new, empty data table to the GraFit workspace:



Select the Add  Data Table command.

The parts of the data table window are shown in the following illustration.
Column selection
region
Column resize
region
Type indicator row

Column heading

Data entry
position
Row selection
region
Splitter box
Position row 1 column 1 in the above figure is marked by a dark outline; this is the
current data entry position. Data entries are edited in situ by typing in the new
entry. When the entry is complete, pressing RETURN, TAB or a cursor key, or clicking
the mouse on a different position in the data table, will accept the data, and move
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the data entry position. To edit the value at the current data entry position, select
the Edit Current Cell command13, or press F2.
The following table describes the elements in a data table. Certain sub-regions are
distinguished by the mouse cursor changing shape when it is over them.
Element

Description

Data table

The data values themselves are listed in the
data table. Click the mouse on a value to
move the data entry position; drag the
mouse to select larger regions of the data
table. Newly entered data is placed at the
data entry position, which can be moved
using the cursor keys or by clicking the
mouse on a different part of the data table.

Column selection region

Click and drag the mouse on the column
numbers to select entire columns of data.

Column resize region

Click and drag the edges of a column to
resize it.

Row selection region

Click and drag the mouse on the row
numbers to select entire rows of data within
the data table.

Row resize region

Click and drag the edges of a row to resize it.

Split table horizontally

Drag the splitter box on the horizontal scroll
bar to divide the data table window in two.
The two halves can be independently
scrolled, allowing distance regions of the
table to be viewed simultaneously.

Split table vertically

Drag the splitter box on the vertical scroll
bar to divide the data table window in two.
The two halves can be independently
scrolled, allowing distance regions of the
table to be viewed simultaneously.

Cursor

Resizing Rows and Columns
The row height and column width can be set using the Row Height and Column
Width commands on the Table tab14, respectively, or by using the mouse to drag
the edges of the rows or columns within the row or column selection region.
Columns can be sized to fit their contents using the Size Column to Fit command
on the Table tab15.

13
14
15
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The Edit  Edit Current Cell command in legacy mode
The Table  Row Height and Table  Column Width commands in legacy mode
The Table  Size Column to Fit command in legacy mode
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Data Types
The number of data points that can be entered is limited only by available memory.
The data are grouped into columns, and the contents of one or more columns can
be used for data fitting or graph plotting.
Within a column, each individual cell holds a data value that may be one of three
different types:
Data Type

Description

Numbers

Numbers are the most common data form that will be entered
into GraFit. They are used to plot x/y scatter plots, and for data
fitting by regression analysis. Very small or large numbers can be
entered in exponential format, for example 1e7 is equal to
10000000, and 1e-23 represents 10-23.
Note

The representation of numbers, particularly the symbol
used for the decimal point, differs from country to
country. By default, GraFit uses the country-specific
settings selected for your Windows installation (using the
Control Panel application, Regional Settings). However,
you can override these from the Options command16 on
the View tab, Number Format page.

Text

Text entries can be used for annotation, and are also used to
provide the text for the category axes of charts. Text values are
treated as missing data during data fitting.

Missing Data

Experimental data often contain certain values that are not
available (perhaps because that particular experimental sample
was the one that fell on the floor!). GraFit allows you to insert
―missing‖ values by leaving the data entry blank. All the graphing
and data fitting elements of the program will recognize such
points, and omit them from the analysis.

The representation of these different data types is illustrated in the following
diagram.

16

The View  Options command in legacy mode
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Text

Number

Missing value

Ignoring Individual Data Values
It is possible to mark one or more data entries to be ignored during data fitting
procedures or any calculations performed within the data table. This can be useful
if a data value is known to be (or thought to be) erroneous and you do not wish to
include it in an analysis. Marking the data value to be ignored is preferable to
deleting it as this does not remove the data point completely, allowing it to be
reinstated later if required.
To ignore a data value, select it and use the Ignore Data command17 on the Table
tab.

Ignored data point

17
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Numeric values that are flagged to be ignored as treated as Missing Data during
any data analysis procedures. To restore the data value, select it and repeat the
Ignore Data command.

Moving the Data Entry Position
When you have entered your data value you will need to move to the next data
entry position by pressing TAB, RETURN or DOWN after entering the value. The
following keys control movement of the data entry position within the data table.
To

Press

Move the entry point to the right

TAB

Move the entry point to the left

SHIFT TAB

Move the entry point up

UP

Move the entry point down

DOWN

Move to the first column of a row

CTRL LEFT

Move to the last column that contains data entries

CTRL RIGHT

Move to the first row of a column

CTRL UP

Move to the last row that contains data entries

CTRL DOWN

It is often convenient to press
Note

RETURN

or

DOWN

or

RIGHT

or

or

LEFT

RETURN

between entering data points.

If you have a region of the table selected, pressing RETURN will move the
data entry position left to right within the selected region. If you prefer to
enter {x, y} data pairs in sequence “x1, y1, x2, y2…” then it is convenient
first to select the columns (see “Selecting Entire Columns”) that will hold
the data and then to enter the values, pressing RETURN between each data
entry.

Moving the data entry position using the mouse
To move the data entry position using the mouse, move the mouse pointer to the
position you require, and click the left mouse button.

43

GraFit User’s Guide

Selecting Regions of the Data Table
Selecting Part of the Data Table
To select a portion of the data table, drag the mouse over the required region.
Alternatively, hold down the SHIFT key, and use the cursor keys to extend the
selection. The selected region is displayed shaded, as shown below.

Selected region

Clicking the mouse within the row selection area results in the entire row being
selected.

To make a more extensive selection:


Click on the start position.



Use the scroll bars to move the window as necessary.



Hold down the

SHIFT

key, then click on the end position for the selection.

Discontinuous selection
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Hold down the

CTRL

key and click the required entries.
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Selecting Entire Columns
Whole columns of data are selected by clicking on the column selection region. The
selected column is displayed inverted.

Column selection
region

Drag the mouse along the column selection region to extend the selection. In a
similar fashion, clicking in the row selection region allows whole rows to be
selected.

Copying and Pasting Data
Selected regions of the data table are copied to the Clipboard using the Copy
command, and pasted using Paste18. Data may also be pasted to and from other
applications in the same way.

Copying and Pasting Regions of the Data Table
1. Select the region of data that you wish to copy.
2. Select the Copy command19.
3. Move the data entry position to where the data is to be copied.
4. Choose Paste. The data will be inserted at the data entry position.

Copying and Pasting Columns
Entire columns of data can also be copied and pasted. Pasting into the data table
when a column is selected results in the pasted values being placed in a new
column, in front of the selected column.

18
19

The Edit  Copy and Edit  Paste commands in legacy mode.
The Edit  Copy command in legacy mode
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1. Select the column(s) of data that you wish to copy.

2. Select the Copy command19
3. Select the column in front of which the data are to be inserted.

4. Choose the Paste command. When pasting into a fully selected column, you
have the option to overwrite the selected data or to insert the new data in front
of the selection (the overwrite option is only available if the number of columns
available to paste is the same size as in the selected region).
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The data are then pasted into the table.

Removing Data
Clearing a Region of Data
The Clear command on the Home tab20, or the
currently selected data or columns.

DEL

key, can be used to clear the

1. Select the data value(s) (or columns or rows) to be cleared.

20

The Edit  Clear command in legacy mode
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2. Choose the Clear command, or press

DEL.

Data in the selected region are cleared, leaving a gap in the table.

Deleting a Region of Data
Select the data value(s) (or columns or rows) to be cleared.
Choose the Delete command21 on the Table tab.
When deleting a range of cells, the data values are moved up so that no gap
appears in the table. When deleting a column, the remaining columns to the right
of the selection are moved along to fill the gap.

Inserting Values into the Table
Values are inserted into the data table using one of the Insert commands22 on the
Table tab.
Command

Action

Insert Cells

Inserts blank cells in place of the current selection. Cells are
moved down to accommodate the new entries.

Insert Column

Inserts blank columns in place of the current selection.
Columns are moved to the right to accommodate the new
entries.

Insert Row

Inserts blank rows in place of the current selection. Rows are
moved down to accommodate the new entries.

21
22
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Sorting Data
The data in one or more columns can be sorted into ascending or descending order
using the Sort command23 on the Table tab, after first selecting the columns that
you wish to sort.

The Index column selection specifies the column on which the sort order is based.
In addition to this column, any of the other columns can be included in the sort by
checking the box to the left of the column name.

Data Table Appearance
Colors and Fonts
The colors used to display the items in the data table, and the font that is used to
draw the table, are set using the Preferences command24 on the Table tab.

Number Format
The manner in which numbers are formatted for display can be set on a column by
column basis. The Column Format command25 on the Table tab is used to control
the displayed numerical precision. This command applies to all columns that fall
within the current selection.

23
24
25

The Table  Sort Column(s) command in legacy mode
The Table  Preferences command in legacy mode
The Table  Column Format command in legacy mode
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Column Format
dialog box

Specification

Meaning

Decimal places

Enter the number of decimal places to be displayed for
numbers.
Note

50

To ensure that all decimal places are displayed
set Trailing zeros in fraction to “Show 0’s.”

Max digits

Enter the maximum number of digits to use when
displaying numbers.

Thousands
separator

Check this box to include a grouping separator. The
symbol used for this separator, and the number of digits in
the group, are set for the Options command16 on the
View tab.

Scientific format

Check this box to display the values using scientific format
(e.g. -2.435e003 instead of -2435.000).

Use scientific
format for small
values

Check this box to ensure that small values, which would
otherwise be displayed as 0.0000, are shown in scientific
format (e.g. 2.0987e-008).

Trailing zeros in
fraction

Chooses the way that trailing zeros are displayed in the
formatted numbers. It is possible to show the ―0‖
characters, to omit them, or to replace them with spaces.

Chapter 5: Data Tables
Specification

Meaning

Save As Defaults

Stores the current settings as the default for future GraFit
sessions.

Restore Defaults

Restores the current GraFit formatting defaults to the
selected columns.

Magnification
The magnification of the data table text can be adjusted to allow more or less
values to be visible. Magnification is controlled by the Zoom command26, found on
the View tab.
Changing the magnification and altering the font size (Preferences command24 on
the Table tab) both modify the size of text displayed on-screen. However,
changing font size using Preferences also changes the size of printed text, while
Zoom only affects the on-screen appearance.

Importing and Exporting Data
Importing Data
To import data into a data table, position the data entry position where you want
the data values to start and select the Paste  Paste From command27 on the
Table tab. Select the file that holds the values to import, and press the Open
button. The contents of the file will be inserted into the data table.

Importing Data as a New Data Table
It is also possible to import a file into the GraFit workspace as a new data table
item. To import a data file in this way, use Import Data command28 on the Home
tab.

Exporting Data
To export data from a data table into a file that can be read by other programs,
select the range of values to be exported and use the Copy To command29 on the
Table tab.

Windows Vista
When running GraFit on Windows Vista, the program uses the new Vista-style Save
dialog box, as shown below.

26
27
28
29

The View  Zoom command in legacy mode
The Edit  Paste From command in legacy mode
The File  Import Data command in legacy mode
The Edit  Copy To command in legacy mode
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The Save as type entry determines the format in which to save the exported data.
GraFit supports a number of data export formats, and the available types are listed
in this box. GraFit supports export as ASCII (Text), DIF and CSV formats as
standard, though additional formats may be available.

Windows 2000/XP
Earlier versions of Windows use the older-style file save dialog box.

The Save as type entry determines the format in which to save the exported data.
GraFit supports a number of data export formats, and the available types are listed
in this box. GraFit supports export as ASCII (Text), DIF and CSV formats as
standard, though additional formats may be available.

Column Types
Columns can hold simple data values, or can be set to hold the results of various
calculations or data manipulations. For example, a column can hold the difference
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between the values in two other data columns. The results of these calculations are
automatically updated when the source data change, allowing powerful processing
of the underlying data.

Example: setting up a difference calculation
As an illustration, we will show how to set up the following data table in which the
third data column holds the difference between the values in the first and second
columns.

Type area of
column 3

The column type of the third column needs to be set by moving the data entry
position to somewhere within this column and choosing the Column Type 
Column Combinations  A - B command30 from the Table tab. Alternatively, the
Column Type submenu can be accessed by double-clicking in the type area of the
column. For this column type setting, the following dialog is displayed.

Choosing Value 1 as the first column and Value 2 as the second gives the result
above. The values that are displayed in this column cannot be overwritten or
30

The Table  Column Type  Column Combinations  A - B command in legacy mode
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edited, and are updated whenever the values in the source columns changes. The
text color of the calculated values can be adjusted using the Preferences
command24 on the Table tab, but is typically shown a different color than the
editable text in order to distinguish it. The dialog settings for the calculated values
can be altered by repeating the command, or by choosing the Properties
command31 on the Table tab.
To reset the column type to the default (non-calculated) settings, choose
Column Type  (General).
Note

Even though columns that hold calculated values do not allow these values
to be edited, it is always possible to modify the column name entry.

(General) Column Type
By default, all columns are set to be of (General) type, and hold general data
values that can be edited normally.

Data Types
The column types under this submenu are used to designate that the column holds
a certain type of data, which may have associated additional values. The entries in
the column are editable, but the data held in the column may have special
significance for data fitting.

x Data
You may optionally select this column type if the data in the column are used as
the x values for data fitting. Designating a column to contain x data is not essential
for data fitting, but can be useful to document the data layout.

x(n) Data
When fitting an equation that has more than one independent (x) variable, one way
to hold the data is to have n separate columns for the different xn values. During
the data fitting, GraFit needs to know which column holds which xn data set. This is
done by setting the column type to x(n) Data, which gives the following dialog:

31

54

The Table  Column Properties command in legacy mode

Chapter 5: Data Tables

It is necessary to have one x(n) Data column for each independent variable in the
equation, and these must have their X data set # entries set to correspond to the
X variables number in the equation definition. See Chapter 6 for information about
using this option when fitting data.

y Data
You may optionally select this column type if the data in the column are used as
the y values for data fitting. Designating a column to contain y data is not essential
for data fitting, but can be useful to document the data layout.

y Data with Associated Value
It is common that an equation has two independent (x) variables. Under these
circumstances, the most usual way of collecting data is to measure a series of y
values at varying x1 for a fixed x2, then to collect a further set of y values at the
next x2 value, etc. For example, the variation of enzyme catalyzed reaction rate
might be measured as a function of substrate concentration at a certain fixed
inhibitor concentration. The measurements are then repeated at the next inhibitor
concentration and so on. Here, the second independent variable (x2, in this
example is the inhibitor concentration) is the same for an entire set of x1, y
(substrate, rate) data pairs. Under these circumstances, it simplifies the data entry
to associate a single x2 value with a whole column of different y values. This is
done by specifying the column type as y Data with Associated Value.
The y Data with Associated Value command is also available
from the Table tab32.

32

It is found on the Data toolbar in legacy mode
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The x2 data value is entered in the above dialog, and is normally displayed in the
column type area. Data columns that have associated values are used when fitting
to equations with two independent variables. See Chapter 6 for information about
using this option when fitting data.
Up to four values can be associated with a data column, allowing x2, x3, x4 and x5
values to be stored, if required, for equations having up to five independent (x)
variables. If your equation definition has only 2 independent variables, the values
for x3, x4 and x5 are ignored.

Column Combinations
These column types allow the values within the designated column to be the result
of an arithmetic combination of two other columns. In each case, the number of
calculated entries depends upon the number of values in two selected columns, and
the values are updated whenever one or more data values in the source columns
change.

A-B
The column holds the result of subtracting values from the second column from
those in the first.

A+B
The column holds the sum of adding values in the first and second columns.

A/B
The column holds the result of dividing values in the first column by those in the
second.
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A.B
The column holds the product of values in the first and second columns.

Statistics
The column types under this submenu allow the result of various statistical
procedures to be displayed in the column.

Mean

Each row entry in the column is set to be the calculated mean of the corresponding
values from the columns selected in the above dialog.
𝑥=

1
𝑁

𝑥𝑖

The calculated values are updated whenever one or more values within the selected
columns are modified.

No. Data Points
Each row entry in the column is set to be the number of data values (N) present in
the corresponding rows from the selected columns. This will be less than the total
number of selected columns if missing data values are present.

Standard Deviation
Each row entry in the column is set to be the calculated standard deviation of the
corresponding values from the columns selected in the above dialog. Standard
deviation, , is defined as:
𝜎=

1
𝑁−1

𝑥𝑖 − 𝑥

Standard Error of the Mean
Each row entry in the column is set to be the calculated standard error of the mean
for the corresponding values from the columns selected in the above dialog. SEM,
, is defined as:
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𝜎𝜇 =

𝜎
𝑁

Column Summary
The entries in the column give a summary of the values present within a single
selected column.

This summary gives the number of data points, minimum and maximum data
values, the data range, sum, mean, median, variance (calculated for a divisor of n
and of n-1) and standard deviation (calculated for a divisor of n and of n-1).

F Test
The entries in the column show the results of performing an F test comparing the
goodness of fit of two fitting analyses that use different equations. A fuller
description of this test is found in the theory section (Chapter 20), but briefly the F
test evaluates whether one fit is significantly better than another. This test can be
used to ascertain whether it is realistic to use an equation with additional
parameters over a simpler version, or whether one equation fits a data set
significantly better than does a second. For example, the analysis shown below fits
an exponential decay to a single exponential equation:
𝑦 = 𝐴𝑒 −𝑘𝑡
In addition it fits the data to an equation that has an additional background
parameter:
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𝑦 = 𝐴𝑒 −𝑘𝑡 + background
A sample set of data fitted to each of these equations is shown below.
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Time
Using the F test, it is possible to test whether the data are fitted significantly better
by the presence of the extra parameter. By eye, the fit obtained with the additional
background parameter seems slightly better than the one without, but this is
subjective and it is better to use a statistical test.
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The results show that the probability that the two fits are equally appropriate is
0.0016 or 0.16%, which is low. This indicates that we can have reasonable
confidence in the merit of including the extra parameter (generally we require this
value to be <5%, but may prefer a value <1% to be sure).
Note

Although the F test results have been shown incorporated into the same
data table as the raw data, it is also possible to create the analysis in a
separate data table. Using separate data tables can be preferable if you
wish to keep the raw data separate from any analysis.

Data Fitting
The column types under this submenu allow the results from data fitting to be
displayed in a column, or entry of parameter/constants values associated with an
equation. This lets the results be viewed, but more importantly allows the values to
be used for subsequent analyses. For example, the results of one set of data fitting
might provide the source data for subsequent fits.
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Results
This column type lists the results from data fitting.

After the fit to be displayed is selected, the parameters available are listed. Some
or all of these can be included by clicking in the check box to the left of the
parameter name. If more than one set of data were analyzed in the selected fit, the
results for each fit are given. It is possible to display either the fitted parameter
value, or the fitted standard error value, as chosen in the Display settings. In
addition, the name of the parameter can optionally be displayed next to the data
value, by checking the Value name option.
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Information
This column type lists information about a data fitting item.

After the fit to be displayed is selected, the available information items are listed.
Some or all of these can be included by clicking in the check box to the left of the
parameter name. If more than one set of data were analyzed in the selected fit, the
information for each fit is given. The name of the information type can optionally be
displayed next to the data value, by checking the Display value name option.

Parameter Entry
The Parameter Entry column type gives a convenient way of entering parameter
values for a particular equation into a column. Certain graph plotting options allow
these values to be used when displaying graphs. The equation to use is selected,
after which it is possible to enter values into the column.
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The column display differs from normal in that the name of the parameter remains
displayed on the left, with the value on the right. When a new parameter value is
entered from the keyboard, the parameter name remains but the revised value is
displayed in the table.

Constants Entry
The Constants Entry column type allows the values of any constants associated
with an equation to be entered in the data table. This option works in the same way
as the Parameter Entry option described above, but shows the constants associated
with the selected equation.

Calculated Values
The column types under this submenu allow the x or y values to be calculated using
the results from a data fitting item.
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x Values
Use this column type to calculate theoretical x values corresponding to userentered y values, according to the fitting model described in a selected workspace
item.

The fitting item that holds the results is chosen in the dialog box. It is possible to
use either the results from the data fitting or the parameter values used as the
initial estimate values (starting values only) when carrying out the calculations.
Values are calculated for x values that correspond to the y values present in the
selected Y data column entry.
A potential problem with calculating x values for a given y value is that some
equations will have multiple solutions. For example, consider the curve shown
below:
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At y = 4 the value of x read from the curve is 2.5; but at y = 7.5 there are three x
values, 3.4, 5.2 and 7.5. Clearly, whether the curve is single or multiple-valued in x
depends upon the equation in use and the value of y that is used.
To overcome this complication it is necessary to specify limits to the x values
between which the data are to be calculated. The Interpolate between X limits
entries in the above dialog control the range between which the values are tested.
For example, in the plot above the solution x = 3.4 at y = 7.5 would be correctly
found by setting interpolation limits between x = 2 and x = 4.
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y Values
Use this column type to calculate theoretical y values corresponding to userentered x values, using the fitting model described in a selected workspace item.

All fitted GraFit equations have only a single y value that corresponds to each x
value, and so there is no need to specify interpolation limits as in the previous
column type.
When calculating y values, it is possible to choose whether to use the fitted values
or the explicit initial estimates that were used in the Estimatrix (see Chapter 6).
This allows the generation of a hypothetical data set, which would result from the
initial estimate values. When no initial estimates were used, these options are
unavailable (as in the figure above, as the estimates were generated automatically
for the equation used).
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Difference
Use this column type to calculate the difference between the experimental and the
calculated y values, using the fitting model described in a selected workspace item.

Plots of difference versus x or y values are very useful to indicate whether the
calculation accurately reflects the variation in the data. A good fit is characterized
by a random distribution of (small) differences between the raw and fitted data.

Data Processing
The column types under this submenu allow various types of processing to be
performed to generate data values for the column.

Calculated Function
The calculated function column type fills the selected column with the results of a
user-defined function. This column type can be used to perform sophisticated
processing of data, including background subtraction, calculation of logarithmic
values and complex rescaling. The calculated function dialog box is shown below.
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The Number of Rows of data to be calculated can be a defined number, or can be
set to be the same as the number of entries in one of the other columns. The
function definition is entered into the Result = field, and uses the same syntax as
is used for equation definitions (see Chapter 9). By default, the text entered into
this field is used to calculate a result without the need for an explicit assignment
statement. However, the name ―Result‖ is predefined so that it is possible to
assign values using a ―Result =‖ statement. In addition to the standard arithmetic
functions (sin, cos etc.), the following can be included within this definition
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Function
Data(x,y)

Description

ValidData(x,y)

Returns TRUE if a valid number is present in the data table at
column x, row y, and FALSE otherwise.

SetBlank

If this statement is encountered, the current cell is set to be
blank and the calculation skips to the next row.

Column

Returns the number of the current column. This value is most
useful in conjunction with the Data() function.

Row

Returns the number of the current row. This value is most
useful in conjunction with the Data() function.

_rnd_

Returns a random number between 0 and 1.

Returns the data value present within the data table at column
x, row y.
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Function
_grnd_

Description
Returns a random number that falls within a Gaussian
distribution that has a zero mean and unit variance.

The following examples show how calculated functions might be specified and used.
Process

“Result =” field

Description

Background
subtraction

Data( 1, Row ) – 0.234

Subtracts the value 0.234 from
the values in column 1.

Log
calculation

log( Data( 2, Row ) )

Takes the logarithm (to base
10) of the values in column 2.

Complex
rescaling

(Data(1,Row) * 1.34) –
Data(2,Row) / Data(3,2)

For each row in column 1,
multiplies this value by 1.34,
then subtracts the data in
column 2 which has been
divided by the value in column
3 row 2.

Multiple line
statement

If (ValidData( 1, Row ) Then
Result = Data( 1, Row ) + 23.3
Else
SetBlank
EndIf

For each valid data entry in
column
1,
sets
the
corresponding entry in the
current column to be 23.3
greater.

Note

It is essential to inform the program, by checking the appropriate boxes,
which columns (if any) the calculation depends upon. Failure to do this will
result in the calculation not being updated correctly when these values
change.
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Derivative
The derivative column type fills the column with the calculated derivative (order 0
to 5) of a selected source data column. The contents of the source column are not
affected by this operation.

Calculation of derivatives for a set of data is performed after application of
Savitzky-Golay smoothing to the source data, and so it is necessary to set the
Savitzky-Golay smoothing factors. A full description of Savitzky-Golay smoothing is
found under the Smooth data processing type.

Series
The series column type provides a convenient way of filling a column with a series
of equally spaced values, for example, time-series values.
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Smooth
This fills the selected column with the result of applying a Savitzky-Golay
smoothing function to a source data column. The contents of the source column are
not affected by this operation.

Savitzky-Golay smoothing is probably the most effective means of smoothing a set
of data in such a way that noise is removed without too much loss of resolution (as
happens with simple moving window averaging). In this smoothing procedure, the
underlying function is approximated by a polynomial fit applied to a window of
points around each data value. The degree of smoothing is therefore controlled by
the window width, and by the order of the polynomial applied. The lower the order
of the polynomial or the greater the window width, the smoother the result but at
the expensive of losing resolution. For a polynomial order of 4, best results are
obtained when the window width is between 1 and 2 times the full width at half of
maximum of the desired features in the data. An excellent discussion of the effects
of various smoothing parameters can be found in Press, W.H., Teukolsky, S.A.,
Vetterling, W.T. & Flannery, B.P. (1992) Numerical Recipes in C. Cambridge
University Press.
Warning

Smoothing of data should always be undertaken with care. Although
smoothing can improve the appearance of a set of data, this
improvement is cosmetic only. If you are fitting data, it is almost
always preferable to fit to the raw data values rather than the
smoothed ones.

Subset
Data that are imported from other applications, or obtained from an instrumental
source such as a spectrometer, often have more data values than are necessary to
define the experimental curve. For example, the data obtained from a spectrometer
may contain more than a thousand points; fitting so many points would be
extremely time consuming, and would not necessarily give a ―better‖ fitted value
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than if (say) thirty points spread over the data range were analyzed. The Subset
type fills the column with a subset of the data values present in one of the other
columns, and provides a convenient means of reducing the number of data values
for analysis.

Select the source data column, and enter a value in the Retain 1 point in every
field. For example, choosing to retain one data point in every 10 of a data set that
has 200 data values would fill the column with point 1, 11, 21… giving 20 data
points in this column. The contents of the source data column are not affected by
this operation.

Locking a Data Column
It is possible to lock a data column to prevent any further modifications being made
to the values that are present. To lock one or more columns:



Move the data entry point to the column that you wish to lock, or select a
range of values encompassing the columns that you wish to lock.



Choose the Lock Column command33 on the Table tab.

Repeat these actions to unlock the column(s).

33
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6

Non-linear Fit Item

Overview of Non-linear Fitting
A non-linear fit item is used to control data fitting by non-linear regression. This
item specifies the data source and equation to use, and also presents the results of
the data fitting. The item is created from the main GraFit window using the Add 
Non-linear Fit command. The non-linear fit window itself contains a tabbed dialog
box with several panes that are used to specify how the fit is calculated. Each of
these panes is discussed below. Data fitting involves making appropriate selections
in the Settings pane (and possibly one or more of the other panes as described
below), then selecting the Fit Data command34 on the Home tab. After fitting the
data the results can be viewed from the Results pane.

Differences from Linear Fitting
Non-linear regression allows much more general equations to be used for analyzing
data. The biggest practical difference, however, is that non-linear regression
requires starting estimates of the unknown parameter values; linear regression
needs no such estimates.

Status Bar Indicators
When a fitting item is selected, the status bar shows the current fitting status,
indicating whether the item is Fitted or Not Fitted. In addition, the status bar
shows when a calculation is in progress. Whenever any calculation is being
processed, the calculation pane shows an animated abacus.

Fitting status pane
Calculation pane

34

The Calculate  Fit Data command in legacy mode
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Settings Pane
The Settings pane is used to specify the main details of the fit.

The Settings pane of the
Non-linear Fit item

Equation
Choose the equation to use for the data analysis. The equation must exist as a
separate item within the main GraFit window. See Chapter 9 for information about
equation items.

Weighting
All types of regression analysis require information about the error distribution in
your data. The reason for this is explained fully in Chapter 20, but briefly it is
necessary to specify whether the inaccuracies are likely to be the same for each
data point (―Simple‖ weighting), are proportional to the value of the y data points
(―Proportional‖ weighting) or have been individually estimated (―Explicit‖
weighting). The default Simple weighting is often the most appropriate setting.
Robust weighting is additional weighting that provides a way of removing outliers
(see Chapter 20). Check the Robust box to add robust weighting to the fit.

Data Table
The data to be fitted must reside in a separate data table item within the GraFit
workspace. Select the table that holds the data from this drop-down list.
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Data Layout
The data layout specifies how the data are arranged for data fitting. The default
layout, as shown in the figure above, is that the x and y data columns are to be
selected individually. This is used to fit a single {x, y} data set. It is also possible
to specify that multiple data sets are present, which will result in several sets of
results being generated. The available options for a standard equation having a
single independent variable are given below.
Layout

Meaning
A single data set is present and the columns holding the x and
y data values are specified individually from the X data
column and Y data column entries. The x and y data
columns do not need to be in any particular order within the
data table.
Multiple data sets are present, although all data sets have
common x data values. The x and y data columns are
consecutive in the data table. The location of the x column is
set from the X data column entry; the location of the final y
column is set from the Last Y data column entry. The
number of data sets present is determined automatically.
Multiple data sets are present, and the data sets have
different x data values. Pairs of x, y data columns are present
consecutively in the data table. The location of the first x
column is set from the First X data column entry; the
location of the final y column is set from the Last Y data
column entry. The number of data sets present is determined
automatically.

Equations with Multiple Independent Variables
Equations that have multiple independent variables (x axes) need to access
multiple x data columns. They therefore have a different set of data layout options.
Layout

Meaning
This option is only available if there are two
independent variables. In these circumstances,
it is often the case that a series of y data values
are collected at a fixed value of the second x
variable. For example, the progress of a reaction
might be collected with time at a number of
different reagent concentrations. The first x
variable would be time, the second would be
reagent concentration. Within the data table it is
possible to associate a value with an entire
column; when this layout is selected the
associated value is taken as the second x
variable. The associated value is set by setting
the column type to ―y Data with Associated
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Layout

Meaning
Value‖ and entering a numeric x2 value as
appropriate. See Chapter 5 for further details.
The x1 and y data need to be arranged
contiguously in the data table, and multiple y
data sets can be present. The location of the X
data column and the Last Y data column are
selected, and from the program can work out
how many data sets are present. All the y data
sets need to be in columns that are of the type
―y Data with Associated Value.‖
This option is only available if there are two
independent variables. As with the previous
layout, the second x variable is obtained from
the column type header. The difference is in the
arrangement of data columns. For this layout,
pairs of x, y data columns are arranged
contiguously in the data table, and a separate
set of x data values are used for each y data set.
All the x data columns hold values corresponding
to the first independent variable as defined in
the equation; values for the second independent
variable are obtained from the type header. The
First X data column and the Last Y data column
are selected, and from this the program can
work out how many data sets are present.
This layout is available whenever there is more
one independent variable, and is the only layout
type when three or more independent variables
are present. When using this layout, the
program determines which column is associated
with which independent variable by examining
information present in the column type headers
of the data table. The column types of the
various independent data sets (x axes) need to
be set to ―x(n) Data‖ with the ―n‖ value
representing the order of the x variable found in
the equation definition. See Chapter 5 for further
details on column types. The position of the y
data column is selected from the Y data column
entry.

X Data Column
This entry specifies the column that holds the x data values. See the Data Layout
section (above) for further information.
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Limiting X Data Range
It can sometimes be useful to restrict data fitting to a subset of the values in the
columns. For example, it can be useful to fit just the initial portion of a data set.
Checking the Limit X range box allows a lower and upper limit to be set on data
that will be included in the analyses.

Y Data Column
This entry specifies the column that holds the y data values. See the Data Layout
section (above) for further information.

Error Column
If explicit weighting is chosen, the error values are read from a separate column,
which is selected here.

Constants Pane
Some equations are defined to include Constants, the values of which are passed to
the equation when fitting data. If the selected equation includes Constants values,
these are entered into the grid found on this pane. For equations that lack
Constants, this pane is empty.

Estimatrix Pane
Non-linear regression analysis requires approximate starting estimates for the
parameter values. These starting values are then improved upon by iteration, until
the best-fit curve is calculated. Some equations provide a means of generating
estimates automatically; for other equations it is always necessary to enter explicit
estimates (see Chapter 9). For the former case, this pane allows supplementary
estimates to be entered; for the latter it is essential to enter initial estimates into
the grid found on this pane.
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The Estimatrix pane of
the Non-linear Fit item

For equations that automatically provide estimates, the Estimates from matrix
box needs to be checked in order to allow supplementary estimates to be entered
into the grid. If automatic estimation is not available then this box is always
checked. The grid is used for entry of estimates, which can be done in one of two
ways.
1. Just the Start value is specified. In this case the value entered is taken as the
initial estimate for this parameter.
2. Values are entered under the Start, End and Steps columns. In this case a
range of estimates, total number Steps, is generated between the Start and
End values inclusive.
It is possible to enter just a Start value for some parameters and a range for
others. Whenever a range of values is involved, a matrix of permutations is tested.
It is important to limit this grid search to a sensible number of combinations, for
example if 10 parameters were present and 10 steps were selected for each, this
would involve 1010 values to be tested – clearly an unrealistic number. When data
fitting starts, each permutation is tested and the combination that gives the best fit
(lowest 2 value) is used as the starting estimates for non-linear regression. If both
automatic and manual estimates are present, each is tested and the best of the
two is used as the starting estimates for regression.

Interactive Estimator
Finding suitable initial estimates can be a laborious task, and to simplify things
GraFit provides an interactive visual tool that is accessed by pressing the
Interactive Estimator button. The Interactive Estimator dialog is shown below:

78

Chapter 6: Non-linear Fit Item

The Interactive
Estimator dialog

A simple graph of the data, selected on the Settings pane, is shown. The graph is
automatically scaled by default, although the scale can be altered if desired. To see
the curve generated by a particular set of parameter values, type in values into the
Estimates value column of the grid. When you move the data entry position, the
graph will be updated to show the curve generated by the current set of values.
These estimates should be such that the calculated curve falls close to the data
values. Just how accurate these parameter estimates need to be depends upon the
equation in use and the data present. However, it is usually only necessary to
produce a curve that roughly follows the data (as shown above) for the subsequent
data fitting to find the best-fit values.
When acceptable parameters have been found, pressing OK will return these
values into the Start column of the Estimatrix pane.

Fitting Criteria Pane
As described in Chapter 20, non-linear regression calculates best-fit parameters by
a series of iterations that produce successively more accurate results. It is up to
the program to decide at what point the values are deemed acceptable, and at
which point the calculations stop. The criteria used to decide this are set from the
Fitting Criteria pane. It is likely that for most situations you will not need to change
the default values on this page.
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The Fitting Criteria pane
of the Non-linear Fit item

Fitting Criteria
GraFit uses three separate criteria to decide when the calculations are acceptable.
Criterion

Meaning

% Chi2 change

This setting is optional, and is activated by checking the
% Chi2 change box. When selected, fitting will terminate

2


when the change in the
value is less than the
percentage value entered (providing the minimum
number of iterations has been reached).

Minimum iterations

GraFit will always perform the specified number of
iterations.

Maximum iterations

Fitting will terminate when the specified number of
iterations has been reached, irrespective of whether the

2


designated change in
has taken place. The
maximum iterations limit serves to guard against the
possibility that the calculations will never reach a
minimum, and so forces control to return to the program
eventually.

The settings can be stored as the defaults by clicking the Store settings as
defaults button; GraFit will remember these defaults next time the program starts.
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Results Pane
The Results pane holds a summary of the fitting results.

The Results pane of the
Non-linear Fit item

If more than one set of data is specified in the Settings pane, each fit can be
viewed by clicking the arrow buttons. The File  Print and File  Print  Print
Preview commands display the results as illustrated below:

Using Print Preview from
the Non-linear Fit item

The formatting of these results is controlled from the Number Format, Fonts and
Indents panes.
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Showing the Fitted Results on a Graph
A listing of the fitted parameter values can be displayed in a graph item window by
selecting the Results Listing command35 on the Graph tab. See Chapter 12 for
further information.

Number Format Pane
The numeric result values are displayed formatted as is specified on this pane.

The Number Format pane
of the Non-linear Fit item

Specification

Meaning

Decimal places

Enter the number of decimal places to be displayed for
numbers in the results listing.
Note

Max digits

Enter the maximum number of digits to use when
displaying numbers in the results listing.

Thousands
separator

Check this box to include a grouping separator. The
symbol used for this separator, and the number of digits in
the group, are set for the View  Options command on
the Home tab.

Scientific format

Check this box to display the values using scientific format

35
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To ensure that all decimal places are displayed
set Trailing zeros in fraction to “Show 0’s.”

The Draw  Results Listing command in legacy mode
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Specification

Meaning
(e.g. -2.435e003 instead of -2435.000).

Use scientific
format for small
values

Check this box to ensure that small values, which would
otherwise be displayed as 0.0000, are shown in scientific
format (e.g. 2.0987e-008).

Trailing zeros in
fraction

Chooses the way that trailing zeros are displayed in the
formatted numbers. It is possible to show the ―0‖
characters, to omit them, or to replace them with spaces.

Fonts and Indents Panes
These panes control the way that the results are formatted. The contents of these
panes are common to several different item windows, and are described in Chapter
7.
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7

Formatting Item Windows

Formatting Options
Many GraFit Item windows are built from a tabbed dialog box that allows various
settings to be entered. The Linear Fit, Non-linear Fit, Equation, Hard-coded
Equation and Transformation definition items are all built in this way. In each case,
the settings in the window can be displayed using the File  Print Print
Preview command36, and printed by the File  Print command. Each of these item
windows includes a Fonts and an Indents pane that control the way the information
is displayed when printing.

Fonts Pane
The Fonts pane selects the fonts to use when displaying the contents of the item
window.

The Fonts pane of the
Non-linear Fit item

36

The File  Print Preview command in legacy mode
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This pane behaves in the same way as a standard Windows font selection dialog.
The fonts to use can be set for a variety of different text elements, specified by the
Item selection. To see the effect of changing the font settings, use the File  Print
Print Preview command36.

Indents Pane
The Indents pane controls the organization of information for printing.

The Indents pane of the
Non-linear Fit item

Each of the different indent levels can be individually set. To see the effect of
changing the indent settings, use the File  Print Print Preview command36.
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8

Linear Fit Item

Overview of Linear Fitting
A linear fit item is used to control data fitting by linear regression. This item
specifies the data source and equation to use, and also presents the results of the
data fitting. The item is created from the main GraFit window using the Add 
Linear Fit command. The linear fit window itself contains a tabbed dialog box with
several panes that are used to specify how the fit is calculated. Each of these panes
is discussed below. Data fitting involves making appropriate selections in the
Settings pane (and possibly one or more of the other panes as described below),
then selecting the Calculate  Fit Data command37 on the Home tab. After fitting
the data the results can viewed from the Results pane.

Status Bar Indicators
When a fitting item is selected, the status bar shows the current fitting status,
indicating whether the item is currently Fitted or Not Fitted. In addition, the
status bar shows when a calculation is in progress. Whenever any calculation is
being processed, the calculation pane shows an animated abacus.

Fitting status pane
Calculation pane

37

The Calculate  Fit Data command in legacy mode
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Settings Pane
The Settings pane is used to specify the main details of the fit.

The Settings pane of the
Linear Fit item

Equation
Choose the equation to use for the data analysis. All the available equations are
linear, and are of the form given below:
𝑦 = 𝑎 + 𝑏𝑥 + 𝑐𝑥 2 + 𝑑𝑥 3 + ⋯
The default linear regression equation is y = a + bx.

Weighting
All types of regression analysis require information about the error distribution in
your data. The reason for this is explained fully in Chapter 20, but briefly it is
necessary to specify whether the inaccuracies are likely to be the same for each
data point (―Simple‖ weighting), are proportional to the value of the y data points
(―Proportional‖ weighting) or have been individually estimated (―Explicit‖
weighting). The default Simple weighting is often the most appropriate setting.

Data Table
The data to be fitted must be in a separate data table item within the GraFit
workspace. Select the table that holds the data from this drop-down list.

Data Layout
The data layout specifies how the data are arranged for data fitting. The default
layout, as shown in the figure above, is that the x and y data columns are to be
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selected individually. This is used to fit a single {x, y} data set. It is also possible
to specify that multiple data sets are present, which will result in several sets of
results being generated. The available options for a standard equation having a
single independent variable are given below.
Layout

Meaning
A single data set is present and the columns holding the x and
y data values are specified individually from the X data column
and Y data column entries. The x and y data columns do not
need to be in any particular order within the data table.
Multiple data sets are present, although all data sets have
common x data values. The x and y data columns are
consecutive in the data table. The location of the x column is
set from the X data column entry; the location of the final y
column is set from the Last Y data column entry. The number
of data sets present is determined automatically.
Multiple data sets are present, and the data sets have
different x data values. Pairs of x, y data columns are present
consecutively in the data table. The location of the first x
column is set from the First X data column entry; the location
of the final y column is set from the Last Y data column entry.
The number of data sets present is determined automatically.

X Data Column
This entry specifies the column that holds the x data values. See the Data Layout
section (above) for further information.

Limiting x Data Range
It can sometimes be useful to restrict data fitting to a subset of the values in the
columns. For example, it can be useful to fit just the initial portion of a data set.
Checking the Limit x range box allows a lower and upper limit to be set on data
that will be included in the analyses.

Y Data Column
This entry specifies the column that holds the y data values. See the Data Layout
section (above) for further information.

Error Column
If explicit weighting is chosen, the error values are read from a separate column,
which is selected here.

Results Pane
The Results pane holds a summary of the fitting results.
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The Results pane of the
Linear Fit item

If more than one set of data is specified in the Settings pane, each fit can be
viewed by clicking the arrow buttons. The File  Print and File  Print Print
Preview commands show the results in a more stylized manner, as illustrated
below:

Using Print Preview from
the Linear Fit item

The formatting of these results is controlled from the Number Format, Fonts and
Indents panes.
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Showing the Fitted Results on a Graph
A listing of the fitted parameter values can be displayed in a graph item window by
selecting the Results Listing command38 on the Graph tab. See Chapter 21 for
further information.

Fonts and Indents Panes
These panes control the way that the results are formatted. The contents of these
panes are common to several different item windows, and are described in Chapter
7.

38

The Draw  Results Listing command in legacy mode
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Equation Item

Overview of Equation Definitions
Equation definitions are used for non-linear fitting (see Chapter 6 for more
information about non-linear fitting items). The item is created from the main
GraFit window using the Add  Equation command. The equation window itself
contains a tabbed dialog box with several panes that are used to define the
equation. After defining the equation, it must be compiled using the Compile
command39, found in the Equation group of the Home tab, before it can be used.
Each of the panes in this item window is discussed below.

Status Bar Indicators
When an equation definition item is selected, the status bar shows whether the
equation is Compiled or Not Compiled.

Compilation status pane

39

The Equation  Compile command in legacy mode
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General Pane
The general pane allows a description of the equation to be entered.

The General pane of
the Equation item

The description is optional, but adding a text description of your equation
definitions is strongly recommended. As illustrated in the figure above, the
descriptive text allows rich formatting options, with multiple font types, styles,
sizes and colors allowed. It is also possible, as shown above, to include an OLE
object embedded in the text. In this particular example, a Microsoft Equation object
has been embedded within the text.
Note

The Microsoft Equation editor, which comes with Microsoft Word, is not
provided with GraFit.

Changing Font Styles
To alter the style of a selected region of text, use the commands available on the
Font tab40.

Inserting OLE Objects
To insert an OLE object into the description text, position the cursor where you
wish the object to be placed, and select the Object  Insert New Object
command41 from the Home tab.

40
41
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Choose the object type to create, and then click OK.

Editing OLE Objects
An inserted OLE object can be edited by double-clicking on the object, of by
choosing the appropriate menu command from the Object menu42 on the Home
tab.

X Variables Pane
The X Variables pane is used to define the names of the independent (x) variables
that are used in the equation. All equations must have at least one independent
variable, and can include more than one.

42

The Edit menu in legacy mode
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The X Variables pane
of the Equation item

Naming Rules
All name definitions for use in an equation definition are entered into a grid that
has space for a Symbol and a Description entry. All names must have a Symbol
entry, but the Description field is optional.

Description Entry
If a Description entry is made, GraFit will use this long name whenever it refers to
the name, for example when listing results. If no Description entry is present,
GraFit will use the Symbol entry. Description entries can incorporate any
characters, including spaces and punctuation characters that are illegal in Symbol
entries.

Symbol Entry
The symbol entry is the name used in the equation Definition page. Symbol names
must obey a number of rules, in a similar way to variable names within a computer
program.



The name must begin with a letter, and contain only letters and numbers. In
particular, a symbol name cannot contain the space character.
The following names are legal symbols:
Fred
k_on
x23
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The following names, however, are invalid:
2nd
k off
test-2
ten:



(starts with a number)
(contains a space)
(contains a minus sign)
(contains a punctuation character)

No distinction is made between upper and lower case characters within a
symbol definition. Therefore the symbol names grafit, GraFit, GRAFIT and
gRAfIT are all considered identical.

We recommend using meaningful names wherever possible when defining symbol
names. Using Final to represent the final concentration of a substance rather than
z will make understanding your definitions far easier for others as well as yourself.
In addition, it is often useful to add a full descriptive name.

Number of X Variables
After entering an x variable definition, the data entry grid will show a blank entry
position immediately below the defined variable. If you enter a second definition in
this location, a further blank entry position will appear. The number of rows of
information that are entered into the grid therefore defines the number of x
variables in the equation.

When to use Multiple X Variables
Most equations are of the form y = f(x), and so have just a single independent (x)
variable. In equations with multiple independent variables, the observed value (y)
varies as a function of more than one variable condition. For example, the rate of
an enzyme reaction may vary as a function of both substrate and inhibitor
concentrations. In this case, there are two independent (x) variables. In principle it
is possible to have any number of independent variables, although in practice it is
rare to fit data where more than two independent variables are present.

Parameters Pane
The Parameters pane is used to define the parameter values in the equation
definition. The parameter values are the ―unknowns‖ in the equation, and nonlinear regression allows data to be fitted in order to find optimal values for these
parameters.
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The Parameters pane
of the Equation item

The organization of the Parameters pane is very similar to that of the X Variables
pane, and the definition of Symbol and Description names is performed in an
analogous manner (see the X Variables Pane section above). The number of rows
of information that are entered into the grid defines the number of parameters in
the equation. At least one parameter must be defined. There is no formal limit to
the number of parameters allowed in a GraFit equation definition, but it is rare to
find equations that involve more than four or five parameters.

Constants Pane
The Constants pane is used to define constants in the equation definition.
Constants are used to allow the entry of a value into an equation definition that is
fixed in any single experiment, but varies from experiment to experiment. The
presence of constants is optional, but when present an equation definition can
include any number of constants. When constants are included in an equation used
for non-linear regression, their values are entered into the non-linear fit item
window as described in Chapter 6.
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The Constants pane
of the Equation item

The organization of the Constants pane is very similar to that of the X Variables
pane, and the definition of Symbol and Description names is performed in an
analogous manner (see the X Variables Pane section above). The number of rows
of information that are entered into the grid defines the number of parameters in
the equation. If no constants are required, as will be the case for many equations,
this page should be left blank.

Definition Pane
The definition pane describes the functional form of the equation using the Symbol
names of the x variables, the parameters and constants (if any) entered as on the
earlier panes.
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The Definition pane of
the Equation item

All equation definitions that are used within GraFit must have the functional form y
= f(x), i.e. it must be possible to describe the variation of y as some defined
function of x. The information on this pane describes the required equation in
symbolic form. At the top of the pane is an entry for Y name, which allows the y
axis to be given a Symbol name (using the rules described earlier).

Equation Definition Syntax
The equation definition is built up from the symbols representing parameters and
constants (if any) with whatever arithmetic operators and mathematical functions
are required. For the example shown in this Chapter, we have used the following
equation:
𝑣=

𝑘𝑐𝑎𝑡 . 𝐸0 . [𝑆]
𝐾𝑚 + [𝑆]

In the Equation definition entry, this becomes:
v = kcat * Eo * S / (Km + S)
The syntax used is similar to that of a programming language, and uses the rules
described below.
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Arithmetic Operators
Symbol
+

Operation

Example
x + y

Explanation

Addition

-

Subtraction

lim-off

Subtract off from lim

*

Multiplication

m * x

Multiply m by x

/

Division

a/b52

Divide a by b52

^

Exponentiation

23^N

Calculate 23N

=

Assignment

y = x*2

Assign y to be twice the value of x

Add x and y

Logical Operators
Symbol
>

Operation
Is greater than

Example
k>7

<

Is less than

x_value<con1

>=

Is greater than or equal to

test>=23.87

<=

Is less than or equal to

rate <= maxrate

=

Is equal to

i76=0

Note

The “=” symbol is used for both assignment and as a logical operator.
Which action is taken depends on the context.

Logical operators allow a comparison to be made. The result of the comparison is
either 0 if FALSE, or -1 if TRUE. To see how these operators work, consider a graph
of the form:
y = (x<test)*-1 + 3
Here, x is the x axis, and test is a constant that has the value 2. This function is
plotted below.
5
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3
Y
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0
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X

101

GraFit User’s Guide
These comparisons can be used to introduce a discontinuity into a curve, and
though they will seldom be used in equations, are extremely useful for displaying
limits etc. to annotate a graph. An alternative method to obtain discontinuities is to
use the If Then Endif constructs described below.
Note

To obtain a sharp discontinuity it is necessary to create the curve with
Resolution set to High (see page 145).

Numbers can be entered directly into the equation definitions, and can include
exponents, e.g. 27.87e-12.

Functions
A large number of functions are provided for use in equation definitions.
Function
abs(x)

Returns

acos(x)

Cos-1 of x.

alog(x)

Antilogarithm to base 10 of x.

asin(x)

Sin-1 of x.

atan(x)

Tan-1 of x.

cos(x)

Cosine of x.

exp(x)

𝑒𝑥 .

frac(x)

The fractional part of x. The fractional part of 13.387 is 0.387.

int(x)

The integer part of x. The integer part of 13.387 is 13.

log(x)

The logarithm to base 10 of x.

ln(x)

The natural logarithm of x.

sin(x)

Sine of x.

sqr(x)

The square of x, x 2.

sqrt(x)

The square root of x,

tan(x)

Tangent of x.

Absolute value of x, i.e. if x < 0 returns -x, otherwise returns x.

𝑥.

The expression within the brackets may be of arbitrary complexity, for example
exp(-k * sqrt(j - 1))
All the geometric functions (sin, cos etc.) use radians as their units.
The following predefined constants are also available:
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Constant
_pi_

Value
 = 3.1415926536

_e_

e = 2.7182818285

_rnd_

A random number between 0.0 and 1.0.

_grnd_

A random number with Gaussian error distribution. The number has
a zero mean and unit variance.

Multi-line Equation Definitions
In its simplest form as described earlier, the equation definition is a single line that
calculates the y value. For example, if the equation to be used was y = ax + b,
then the equation definition might be written as:
y = a * x + b
Here, a and b have been declared to be the symbols that represent the parameters,
x has been declared to be the symbol that represents the x data and y the symbol
that represents the y data. Note that the multiplication between a and x needs the
explicit inclusion of the multiplication operator, *. The equation definition can also
be defined over several lines in order to simplify a complicated definition. This
allows the calculation to be broken up into several steps.

Use of Temporary Variables
Temporary variables can be used to hold intermediate calculation results and
simplify definitions. For example, the following definition uses three temporary
variables, a, b and c.
a
b
c
y

=
=
=
=

1
Kd + total + Capacity
total * Capacity
-(-b + sqrt( sqr(b) - 4 * a * c )) / (2*a) )

The remaining symbols (Kd, total, Capacity) are defined in the equation editor
as parameters or constants. Values are assigned to the temporary variable using
the assignment operator, =, after which they may be used in expressions as
normal. Use of temporary variables makes the above definition more easily read,
and speeds up the calculation as the value for b need only be calculated once. Each
line of the definition is separated from the next by pressing the RETURN key.

Conditional Statements
The values that are evaluated can be controlled using the If statement. This takes
the form
If condition Then
.....statements.....
Endif
or alternatively,
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If condition Then
.....statements.....
Else
.....statements.....
Endif
For example, it is possible to return different values to the program depending
upon the value of a parameter, constant or independent variable:
If extra=1 Then
Return( a1 + b*x )
Endif
If extra=2 Then
Return( a2 + b*x )
Endif
If extra=3 Then
Return( a3+ b*x )
Endif
Return( a4+ b*x )

Comments
Comments can be added to annotate the equation definitions.
' Anything after an apostrophe is a comment
; as is anything after a semi-colon

Looping Statements
The For statement has the following syntax.
For varname = startValue To endValue
........statements.......
Next
or alternatively
For varname = startValue To endValue Step stepValue
........statements.......
Next

Goto Statement
Another statement that will be familiar to programmers is the Goto statement. In
GraFit equations this is implemented in the following manner:
:labelName
......statements.......
Goto labelName
labelName can be any valid name, using the same rules as apply to the names for
symbol names. The label may come before or after the Goto statement.
Note
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Estimates Pane
The Need for Starting Estimates
Non-linear regression works by taking initial estimates for the best-fit parameter
values, and by an iterative process calculates successively better values until the
best-fit values are reached. It is therefore necessary to provide the program with
suitable starting estimates, which should generally be of the same order of
magnitude as the actual ones. If an equation definition alone is provided, the
program cannot know what initial estimates are appropriate. In this event, when
the equation is used the program will ask you to enter initial estimates before
fitting the data.
To relieve users the inconvenience of estimating parameter values, GraFit provides
a means of generating these estimates automatically. It should be noted that the
method used is not foolproof, and requires familiarity with manipulating equations.
It does, however, make data fitting simpler, and can be over-ridden if the
estimates provided are inappropriate. In addition, equations can be defined without
provision for automatic initial estimation.

Method Used to Obtain Initial Estimates
The method used is based on performing linear regression on rearranged data. It is
often possible to rearrange data in such a way that a linear plot is obtained, with
the parameter values being related to the gradient and intercept. As linear
regression needs no initial estimates, this can be used to estimate these parameter
values providing the program knows the following.
1. The rearrangement that is needed.
2. How the parameter values relate to the gradient and intercept.
This process is illustrated using the previous example, where the equation is:
𝑣=

𝑘𝑐𝑎𝑡 [𝑆][𝐸0 ]
𝐾𝑚 + [𝑆]

We can rearrange this to a linear form by plotting v/[S] against v:
𝑣
𝑘𝑐𝑎𝑡 [𝐸0 ]
𝑣
=
−
[𝑆]
𝐾𝑚
𝐾𝑚
This is the so-called Eadie-Hofstee equation. Plotting v/[S] against v and allows the
slope and intercept to be found, from which it is possible to calculate kcat as
(-intercept/gradient)/[E0], and Km as -1/gradient. It must be stressed that this
approach does not provide strictly correct values for kcat and Km—this is why we
wish to use non-linear regression in the first place! (Further information can be
found in Chapter 19.) The values provided are suitable, however, to use as initial
estimates for the non-linear regression analysis. (It is instructive to compare the
initial estimates provided by this method with the final values produced by the nonlinear regression analysis. As they are demonstrably different, this illustrates the
danger of using linear regression of a linearized function for analyzing data.)
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The Estimates Pane

The Estimates pane of
the Equation item

To specify that initial estimates are provided for an equation, the Estimate from
linear transform box should be checked. If you do not want the program to
calculate initial estimates, simply leave the box unchecked.

Defining How to Rearrange the Data Points
For our current equation, the rearranged plot that we require is of v/[S] against v,
i.e., y/x versus y. The X Data and Y Data entries are used to define the data
points for such a plot (note that the stored data points in the data table are, of
course, unaffected). For this equation the definitions are:
ydata
and
ydata/xdata
respectively. The symbols ―xdata‖ and ―ydata‖ are predefined by the program to
represent the x and y data points.
These definitions allow the program to perform the rearranged plot, and any valid
single line expression can be used. The grid at the bottom of this page is used to
define how we obtain our initial estimates from linear regression on the rearranged
plot. Shown in the previous figure is the definition of kcat as (intercept/gradient)/Eo, and Km as -1/gradient. Use the scroll bar to bring any
further parameters into view. The symbols ―intercept‖ and ―gradient‖ are
predefined, and represent the intercept and gradient of the rearranged linear plot.
Other predefined symbol names may also be used when defining initial estimates of
your variables. The symbol min will give the value of the minimum y data point,
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and max the value of the maximum y data point. The corresponding minimum and
maximum x data points are minx and maxx, respectively. These values can be of
benefit if you need to obtain rough estimates of limits, where the limiting value can
be approximated by the maximum recorded value. It is also possible to enter
numeric values directly as estimates. In some situations, rough numerical values
provide suitable estimates without recourse to the more complex methods
described above.
If the Omit values equal to zero box is checked then any data values (x or y)
that are equal to zero will not be used during the data transformation. This is useful
with several transformations that involve taking logarithms or dividing by one of
the data values (as here). If this box is not checked then a data point which
happens to have a value of zero might cause an arithmetic error, resulting in the
estimates routine failing.

Compiling the Equation
To compile the equation, choose the Compile command39 from the Equation
group on the Home tab. Compilation translates your definition into an internal form
that can be executed rapidly. During compilation the definition is comprehensively
checked to ensure that the correct syntax has been used. If an error is detected a
message box will be displayed informing you of the mistake; after pressing the OK
button to continue the cursor will be placed at the most likely place of error.

An Error Message Box

To obtain further information on the specific error, click the Help button, or press
the F1 key.
Once the equation has been correctly compiled, it can be used for data fitting
and/or graph plotting.
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Transformation Item

Overview of Transformation Definitions
Transformation definitions are used in order to allow data and curves to be
displayed on a graph after application of a user-defined transformation. For
example, one use of a transformation definition would be to allow a doublereciprocal plot to be displayed. Transformations describe methods for rearranging
data and equations that can be applied during graph drawing without the need to
create a separate set of rearranged data.
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An example of a transformed double-reciprocal plot. The transformation definition
defines the way that the data points and the fitted curve are rearranged
The transformation item is created from the main GraFit window using the Add 
Transformation command. The transformation window itself contains a tabbed
dialog box with several panes that are used to define the transformation. After
defining the transformation, it must be compiled using the Compile command43,
found in the Transform group of the Home tab, before it can be used. Each of the
panes in this item window is discussed below.

43

The Transformation  Compile command in legacy mode
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Status Bar Indicators
When an equation definition item is selected, the status bar shows whether the
equation is Compiled or Not Compiled.

Compilation status pane

General Pane
All transformations are associated with an equation definition item, which must also
be present in the GraFit workspace. See Chapter 9 for more information about
defining equations. The general pane also allows a description of the transformation
to be entered.

The General pane of
the Transformation
item

The description is optional, but adding a text description of your transformation
definitions is strongly recommended. As illustrated in the figure above, the
descriptive text allows rich formatting options, with multiple font types, styles,
sizes and colors allowed. It is also possible, as shown above, to include any OLE
object in the text. In this particular example, a Microsoft Equation 3.0 object has
been embedded within the text.
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Data Points Pane
The Data Points pane describes how data points are transformed for plotting. If the
Transform data points box is unchecked, no data point transformation is used.
Otherwise, the remainder of the window describes how the data are to be
rearranged when this transformation is applied.

The Data Points pane
of the Transformation
item

In the sample shown above, the data transformation involves plotting the
reciprocals of the x and y data.

Data Transformation Definitions
Two transformation definitions need to be entered, one each for the transformed x
and y data. Use the edit fields to enter the transformation definitions. The rules for
these transformation definitions are the same as described in Chapter 9 for
equation definitions, although the definition is limited to a single line and only the
right hand side of the ―Definition =…‖ equation is entered. The definition can be of
arbitrary complexity, and can include mathematical functions, parameter names
etc. The pre-defined symbols xdata and ydata represent the original x and y data
values respectively. The symbol xdata2 can be used to access any data values
associated with the y data column (―y Data with Associated Value‖ column type—
see the discussion of column types in Chapter 5). In the example illustrated above
we wish to take reciprocals of these data; the definitions are therefore 1/xdata and
1/ydata. Any algebraic expression may be entered, for example
xdata/(ydata + sqrt(xdata))
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is a perfectly valid transformation definition. It is permissible to access the values
of parameters and constants in the equation, if desired. The symbol names of these
are listed at the bottom of the Data Points pane.

Generating Residuals Plots
A very useful symbol that is specific to the data transformation definition is ycalc.
This returns the y value that is calculated from the fitted parameters. Therefore, to
generate a residuals plot, define the transformed y data as:
ydata - ycalc

Axis Name Settings
When first creating a transformed plot, the text used to name the x and y axes is
taken from the Default X name for graph and Default Y name for graph
entries. The following special entries can be used:
Entry
%1

Effect

%2

All occurrences of this are replaced by the name of the untransformed
y data column.

All occurrences of this are replaced by the name of the untransformed
x data column.

Curve Pane
The Curve pane describes how fitted curves are transformed for plotting. If the
Transform curve box is unchecked, no curve transformation is used. Otherwise,
the remainder of the window describes the transformed curve definition.

The Curve pane of the
Transformation item
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In the sample shown above, the curve transformation displays a line through the
transformed data points making use of the fitted parameter values

Transformed Curve Definition
To draw the transformed curve (which in the example above gives the linear
Lineweaver Burk plot) it is necessary to have an appropriate equation definition.
For the example that we are using, the transformed equation is:
1
1
𝐾𝑚
1
=
.
+
𝑣 [𝑆] 𝑘𝑐𝑎𝑡 [𝐸0 ] 𝑘𝑐𝑎𝑡 [𝐸0 ]
What is being plotted is 1/v (the y axis) versus 1/[S] (the x axis). To show this
line, we therefore need an equation that is defined as:
𝑦′ = 𝑥′.

𝐾𝑚
1
+
𝑘𝑐𝑎𝑡 [𝐸0 ] 𝑘𝑐𝑎𝑡 [𝐸0 ]

Here, x' and y' are the transformed data. The transformed curve definition uses the
X name and Y name entries, which correspond to x' and y' in the above equation.
The syntax used for this definition is as described for equations (see Chapter 9),
and can occupy more than one line if required.

Fonts and Indents Panes
These panes control the way that the results are formatted. The contents of these
panes are common to several different item windows, and are described in Chapter
7.

Compiling the Transformation
To compile the equation, choose the Compile command43 from the Transform
group on the Home tab. Compilation translates your definition into an internal form
that can be executed rapidly. During compilation the definition is comprehensively
checked to ensure that the correct syntax has been used. If an error is detected a
message box will be displayed informing you of the mistake; after pressing the OK
button to continue the cursor will be placed at the most likely place of error.

An Error Message Box

To obtain further information on the specific error, click the Help button, or press
the F1 key.
Once the transformation has been correctly compiled, it can be used for graph
plotting.
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Notepad Item

Uses of Notepad
The notepad provides a text editor window where information can be stored in the
GraFit workspace. Uses include making notes about the data, the analysis of the
results, and writing brief documentation on how to use a particular data file or
template. The notepad item is created from the main GraFit window using the Add
 Notepad command.

The Notepad Item Window

The Notepad item
window

The font styles are set from the Font tab44. Notepad windows automatically wrap
their contents so that the line width is equal to the width of the window.

44

The Font menu, or the formatting toolbar, in legacy mode
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Alternatives to the use of Notepad Items
The notepad item provides a simple text editor that has many of the capabilities of
the Windows WordPad application. However, it does not provide the wealth of
features present in a dedicated word-processing application such as Microsoft
Word. It is, however, possible to harness the power of applications such as Word by
embedding documents into the GraFit workspace. For example, a Word document
can be embedded within the main GraFit window, as described in Chapter 18.
Incorporating notes in this manner can be a more suitable alternative to using a
notepad item.
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Creating Graphs

How to Create a New Graph
To create a new graph, first add a graph item window to the workspace using the
Add  Graph command. You will then be given a choice of graph type to create
from the Select Graph Type dialog (below). The resulting graph will be created
using the default size. If you want a graph of a specific size, press the Cancel
button, which will result in a blank graph page. Then use the New Graph tool to add
a graph at a specific location and size to an existing graph item window.
New Graph tool

Adding Graphs to an Existing Graph Item
It is possible to create as many graphs as required on each graph item page. To
add an additional graph to an existing graph item window, either select the New
Graph command45 from the Graph tab, which will create a graph of a default size,
or click the New Graph tool and drag to position the new graph where you wish it to
be placed.

Available Graph Types
Although GraFit can create a large variety of different graphs, the initial choice
when making a new graph is between four fundamental graph types. These differ in
the data that they use; for example, X/Y Scatter Graphs hold data with separate
numeric x and y values whereas a Column Chart has data values that associated
with named categories.

45

The Graph  New Graph command in legacy mode
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After selecting the type of graph to create, clicking the Create button will result in
a specific graph creation wizard that allows the graph to be customized. A
description of the kind of graphs that can be created for each type is given below,
and more detailed information is found in the following chapters.

X/Y Scatter Graph
X/Y Scatter Graphs have numeric ranges on both x and y axes. Some of the types
of graph that can be created are illustrated below.
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Column Chart
Column Charts are categorized by having a numeric range on the y axis and named
categories on the x axis. Some of the types of chart that can be created are
illustrated below.
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two data sets plotted.

Bar Chart
Bar Charts are categorized by having a numeric range on the x axis and named
categories on the y axis, and have the same range of styles available as column
charts. Some of the types of chart that can be created are illustrated below.
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Histogram
Histograms have numeric ranges on both x and y axes; the x axis represents value
ranges and the y axis shows the number of occurrences within the range. Some
histogram styles are shown below.
Note:
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Despite the similar appearance, a histogram is fundamentally different to a
column chart.
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Graph Item

Overview of Graph Items
Graph items display a page of information that can hold one or more graphs, and
may also display results or contain OLE objects. This item window is created from
the main GraFit window using the Add  Graph command. The appearance of a
blank graph item window (at 50% magnification, in landscape orientation) is shown
below.
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Controlling the Page View
The orientation of the printed page is controlled using the File  Print  Page
Setup command46. The magnification is set from the View tab47.

Grid Lines
By default, the graph is displayed with a background grid to help position the
various items that form part of the graph. This grid does not show during print
preview, and is not printed. It can be turned off by the Grid Lines command48, on
the Graph tab, which toggles their display. The color of the grid lines, and whether
GraFit graphs show gridlines by default, can be controlled from the Preferences
command49 on the Graph tab. The grid line spacing (inches or centimeters)
depends on whether you are using the metric or the US measurement system; this
is set from the Options command50 (Number Format page) on the View tab. The
top and left margins are shown on the graph as solid rather than dashed lines; the
margin is specified using the File  Print  Page Setup command46.

Element Outlines
By default, text elements and embedded objects are displayed with dotted and
solid outlines, respectively. These do not show during print preview or printing, and
can be hidden by the Outlines command51, on the Graph tab, which toggles their
display. Whether GraFit graphs show outlines by default can be controlled from the
Preferences command49 on the Graph tab.

Adding Drawing Objects
Various drawing objects can be added to the graph, as controlled by the Draw
command group52 on the Graph tab.

46
47
48
49
50
51
52
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Selection tool
Round Rectangle
Text
Line

Rectangle

Graph Wizard

Ellipse

Polygon

Selection Tool
When the selection tool is selected, the mouse pointer displays as an arrow.
Clicking on a drawing object will select it, allowing moving or resizing. Clicking on
the graph background and dragging will allow selection of a number of items, which
can also be achieved by clicking on items while holding down the SHIFT key.

All Other Tools
Use of all other drawing tools follows a simple procedure. The tool is selected,
which results in the mouse cursor being shown as a cross. Click the left mouse
button where you wish the element to be drawn and drag until it is the correct size.
When the button is released, the element is drawn using the current fill, line and
font settings (these can be specified, see later). Creating graphs using the Graph
Wizard will be discussed in the next chapter.

Manipulating Drawing Objects
Selecting Objects
To select an object, move the mouse pointer over it and left-click.
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Click to
select

Selected
Object

Moving Objects
To move an object or group of objects, select the objects required and then either
drag them to where you wish them to be placed, or use the cursor keys to move
them around. Holding down the CTRL key while pressing the cursor keys produces
smaller step sizes; hold down SHIFT gives larger ones.

Duplicating Objects
If the CTRL key is held down while dragging an object, a duplicate of the object will
be moved to the new location.

Sizing Objects
To resize an object, first select it and then drag one of the resizing handles that are
drawn in the corners of the object. Solid resizing handles are drawn on objects that
can be resized; hollow handles are found on objects that do not permit resizing.
This selected object has solid resizing handles that permit resizing.
This selected object has hollow resizing handles, and cannot be resized.
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Drag one of the
resizing handles to
alter the size of a
graph object.

The resizing action can be modified by holding down the SHIFT or CTRL keys while
dragging the handle. It is possible to combine these effects by holding down both
keys together.
Key

Effect on dragging

SHIFT

The aspect ratio of the object is maintained during resizing.

CTRL

The object remains maintains its current center position during
resizing.

Resizing Text Objects
Text objects have slightly different resizing behavior to other graph objects. Text
objects always wrap their text to fit, so the height of a text object is determined by
its width, the text it contains and the current formatting. Resizing a text object will
therefore change the text wrapping.

Common Actions
The following actions are common to many of the objects that are found on the
graph.
Action

Effect

Left click

The object under the cursor is selected, and any selected
objects are deselected. If the cursor is not over a drawing
object, then any selection is removed.

SHIFT

+ left click

Right click

The object under the cursor is added to the current
selection.
An object-specific context menu is displayed.
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Action

Effect

Left click + drag

The selected object(s) are moved. Dragging can be
stopped by right-clicking or by pressing the ESCAPE key.

+ left click +

CTRL

drag

SHIFT

+ left click +

drag
ALT

+ left click + drag

Double left click

The selected object(s) are duplicated, and a copy of these
of these is moved to the new location. This procedure can
be stopped by right-clicking or by pressing the ESCAPE
key.
The selected object(s) are moved, but the movement is
constrained to a purely horizontal or vertical direction,
depending upon the initial direction of the drag.
Certain objects are normally constrained in their
locations. For example, graph scale text is normally only
allowed to be moved normal to the axis orientation.
Holding down the ALT key removes such constraints and
allows arbitrary positioning.
For most objects, this displays the object Properties
dialog. The exceptions are text objects, for which this
results in editing of the text, and embedded objects, for
which this results in executing the default object action
(normally opening the item for editing).

The shape of the mouse cursor gives information about the current action, or about
which actions are available.
Cursor shape

Meaning
Standard cursor. This cursor is shown when the selection tool is
chosen, and the cursor is not over a selected object.
A drawing tool other than the selection cursor has been chosen.
Left click where you wish the object to be positioned, then drag
until it is the desired size.
The cursor is over a resizing handle, which can be dragged to
alter the shape of the element. There are several different
resizing cursors, depending upon which edge of the object is to
be resized.

,

,

The cursor is over a selected object that can be moved in any
direction, only in a horizontal direction, or only in a vertical
direction, respectively.
The cursor is over a selected object that can be moved in any
direction, and the CTRL key is down. This means that dragging the
element(s) will result in creation of a copy of the selection.
(Polygon objects only.) The cursor is over one of the lines of the
polygon, and the CTRL key is down. Under these circumstances,
left clicking will add an additional control point to the polygon.
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Cursor shape

Meaning
(Polygon objects only.) The cursor is over one of the control
points of the polygon, and the CTRL key is down. Under these
circumstances, left clicking will delete this control point from the
polygon.
(Text objects only.) The cursor is over the text object, which is
currently open for editing.

Grouping Objects
Drawing objects can be grouped in order to ensure that they can be moved as one.
To group objects, select those required and choose the Group command53, found
in the Objects group of the Graph tab. Objects that have been grouped can have
their grouping removed using the Ungroup command54.

Aligning Objects
Selected objects can be aligned by selecting those required, and choosing the
appropriate Align command55, found on the Graph tab. Objects are aligned
relative to all currently selected.

Setting the Z-Order
Objects are drawn on the graph page in a defined order, with the uppermost item
overlaying ones beneath. This z-order can be changed for a selected object by
using commands found in the Objects group56 of the Graph tab.

53
54
55
56

The
The
The
The

Command

Meaning

Bring to Front

The selected object is brought to the front of all objects
on the graph.

Send to Back

The selected object is placed underneath all objects on
the graph. This may result in the object becoming
obscured by others on the page.

Move Forward

The selected object is moved one place forward in the zorder.

Move Back

The selected object is moved one place back in the zorder.

Object
Object
Object
Object

 Group command in legacy mode
 Ungroup command in legacy mode
 Align command in legacy mode
menu in legacy mode
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Setting the Object Color
The fill, pen and text colors of an object are specified separately. Text color, as well
as the text formatting, is set from the Text tab56. Pen and fill colors are set from
the Graph tab56.

Setting the line color

Note

Some objects (notably graph objects) have more complex color settings
than can be made using the Color selectors. For these it is possible to
select other color options from the object Properties dialog57, this
command found on the Graph tab or by right-clicking on the object.

Setting Default Colors
The default fill, line and text colors for new graph objects can be specified by
altering the color when no object is selected. The new default colors will be used
next time an object is added. Alternatively, the Preferences command58 on the
Graph tab can be used to set these defaults. This command also lets the default
settings be stored for subsequent GraFit sessions.

Setting Text Properties
Text properties are specified by commands found on the Text tab59.

57
58
59
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The Edit  Properties command in legacy mode
The Graph  Preferences command in legacy mode
The Text menu, or on the Formatting Style toolbar, in legacy mode
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The font, size, style, alignment and orientation of the text can be specified from
this toolbar. Further text properties that are specific to particular objects may also
available from the Properties dialog57 for the selected object.
If a text object is selected by clicking on it, altering text properties such as font
face, size and color, will alter the appearance of the entire object. Finer control of
text settings is possible for editable text by double-clicking on the text item, then
selecting just a portion of the text. Changes to text formatting will then apply only
to the selected text.

Setting Default Text Properties
The default font properties for new text objects can be specified by altering a
property (for example, changing the font size) when no object is selected. The new
defaults will be used next time a text object is added.

Using Field Codes
Text within graphs can contain field codes that are substituted with values such as
entries from a data table. This allows graph text to incorporate information from
other item windows; such information is updated dynamically. Field codes are
entered between curly braces (―{}‖) and have the following syntax:
{―item name‖ command parameters}
The first entry is that of the item window from which the information is to be
obtained. This name must be surrounded by quotes if the item name contains
space characters. The next entry is a command name, which is specific to the item
window type. Finally, there are one or more optional parameters, which are specific
to the command and separated by spaces.

Data Table
Command

Parameter(s)

Description

AssValue

col index

Returns the associated value ―index‖ for
column ―col‖ (the lowest allowed index number
is 2, which is the x2 value; index number 3
gives the x3 value, etc.)

ColumnName

col

The parameter col is the number of the
column. The value returned is the name of the
column within the data table

Data

col row

The data entry from column ―col‖ and row
―row‖ is returned. The number formatting of the
data value is as used by the source column.

IfTrue

col row text

If the data value at column ―col‖ and row ―row‖
is not zero, then returns the text “text”.

IfFalse

col row text

If the data value at column ―col‖ and row ―row‖
is zero, then returns the text “text”.
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Result Item
Command

Parameter(s)

Description

xColumn

no

Returns the name of the x data column. For
data with a single dependent variable, ―no‖ is
the fit number; for data with two independent
variables, ―no‖ is the data set number; for
data with multiple independent variables then
―no‖ is the x data number.

yColumn

no

Returns the name of the y data column. For
data with a single dependent variable, ―no‖ is
the fit number; for data with two independent
variables, ―no‖ is the data set number.

errColumn

no

Returns the name of the error data column.
For data with a single dependent variable, ―no‖
is the fit number; for data with two
independent variables, ―no‖ is the data set
number.

parameter

fitno paramno

Returns the value of a fitted parameter from
the data fitting. The number formatting is
taken
from
the
result
item
format
specification. ―fitno‖ is the fitting number (1
if there is a single fit); ―paramno‖ is the
number of the parameter (1 for the first
parameter, 2 for the second, etc.)

paramname

fitno paramno

Returns the parameter name from the data
fitting. See the parameter description for
more information.

error

fitno paramno

Returns the error value from the data fitting.
See the parameter description for more
information.

Example

The following text would allow a data value present in the first row of the
second column of table ―My Data‖ to be included within the graph. The graph
text is dynamically updated whenever the underlying data value alters.
The answer to life the universe and everything is {"My Data" Data 2 1}
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General Object Properties
Selecting the Properties command57 on the Graph tab, or double-clicking on a
graph object, shows the object properties dialog box. This dialog box contains a
number of pages, some which are common to many objects and some which are
specific to the object selected. The common property pages are shown below;
specific property pages discussed later.

Fill Properties

Check the Fill box to fill the object with the selected color. If this box is unchecked,
the object will be transparent.
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Line Properties

The Line page sets the width, style and color of the line. It is possible to set the
Style to ―No line‖ if you do not wish a line to be drawn.

Rotation Properties

Objects can be rotated, and their rotation is specified from the Rotation page.
Rotation is entered in degrees, which is measured in a counter-clockwise direction.
The rotation can be set as an absolute figure, or relative to the current rotation.
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Location Properties

The location of the selected object is set from the Location page. This allows the
object position to be specified exactly, relative to the current margin or to the edge
of the page.

Arrows Properties

Objects that can have lines with terminating ends allow the end type to be specified
via the Arrows page. Choose from a variety of arrow styles for each end of the line,
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together with the end size and width. The arrowhead color is set to be the same as
the line color.

Font Properties

The Font page sets the font to use, together with the style, size and various effects
including superscript and subscript options.
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Paragraph Properties

This page sets the formatting for the selected paragraph(s) or text.

Exporting Graphs
While it is possible to insert graphs into other applications via the Clipboard, for
publishing purposes it is often important to create image files in a portable format.
The Export Graph command60 on the Graph tab allows graph images to be saved
using a file format that can be used by other applications. The following graph file
types can be generated:



Windows Metafile (WMF)



Enhanced Metafile (EMF)



Bitmap file (BMP)



Tagged Image Format File (TIFF)

(compressed or uncompressed)

For most purposes, the compressed TIFF format is the most suitable.

Windows Vista
When running GraFit on Windows Vista, the program uses the new Vista-style Save
dialog box, as shown below.
60

The File  Export Graph command in legacy mode
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Windows 2000/XP
Earlier versions of Windows use the older-style File Save As dialog box.
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X/Y Scatter Graphs

The XY Graph Wizard
Chapter 12 described the basics of creating graphs. Selection of an X/Y Scatter
Graph produces the ―XY Graph Wizard‖ to assist with the procedure (all settings
can be adjusted later, if required).

Select Data Source Page

The Select Data Source page allows you to choose the source and type of the data
to plot.

Legend text
The data set plotted is associated with an entry in the data legend. The entry
shows the symbol used to represent the data, and a descriptive text. By default,
the text used is taken from the y data column. However, if Name from Y is
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unchecked then you can enter your own text into this field. This text field can also
contain two special entries that allow the data set number or the fit number to be
inserted into the data legend:
Entry
%1

Linear/non-linear Fit

%2

Replaced
number

Replaced
number

by
by

the
the

fit
data

Source Item Type
Equation

Data table

Replaced by the data
number

Replaced by the data
number

(not applicable)

(not applicable)

A data legend showing the symbol and descriptive
text.

Source
Graphs are plotted using data that are present in one of the items found in the
GraFit workspace. The Source selection lists all items that contain suitable data for
plotting, and one of these must be selected. GraFit graphs can plot three different
types of plot on an X/Y graph, depending on the source selected.
Item Type

Effect
When raw data are plotted, the data table item is selected and
the x and y columns are selected for display. The data points
can optionally be joined with lines or curves. If the data have
been fitted to an equation, it is usually better to select the
data fitting item as this will also show the fitted curve.
To plot a theoretical curve, select the equation item for the
curve you want.
Selecting a data fitting item (linear or non-linear fit) results in
the data being plotted together with the fitted curve. This is
usually the way of plotting data fitting results.
Data fitting items may contain multiple fits, so when a data
fitting item is selected, you have the option of displaying a
single fit (and selecting which you require) or of plotting all
fits.

X data column / Y data column
When the Source is a data table item, it is necessary to select which columns hold
the x and y data values to be plotted. For all other source types, these selections
are not available.

Error column
Checking the Error column box allows a quick way of producing an error plot
when the Source is a data table item. Select the column that holds the error
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values from the list. More extensive error plotting options are available once the
graph has been produced (see page 164).

Transform as
Check the Transform as box to plot the data after transformation using the
selected transformation item. All available transformations (which must be present
in the workspace) are listed. Transformation of data is only available if the Source
is a data table or a non-linear fit item. See Chapter 10 for more information about
plotting transformed data.

Set Initial Scaling

The Set Initial Scaling page allows the scale of the x and y axes to be specified. By
default the scale is set automatically, and linear axes are chosen. These can be
altered as required (it is also possible to adjust the scale settings later). The text
used for the x and y axis can also be entered.
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Select Tick Styles

The Select Tick Styles page allows rapid selection of some of the more common
axis tick styles. More extensive tick style choices can be made once the graph has
been created.
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Select Data Point Style
(not equation items)

The Select Data Point Style page allows the data point representation to be chosen.

Size
Data points are scaled relative to the overall graph width, and so the absolute size
will depend upon the graph dimensions. Choose a size that represents your data
appropriately; with more data you should use smaller data points. If very many
points are present it can be more effective to set the Style as None, and to join the
data points with lines (next page).

Pen
Check this box to draw an outline around the data point. The size and color of the
outline can be specified.

Fill
Check this box to fill the point with the solid color selected. If Fill is not checked,
the data points will be transparent.

Mask curves
Check this option to ensure that any curves on the graph are not drawn
immediately adjacent to the data points.
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Enter Curve Parameters
(Equation items only)

When plotting theoretical curves, this page allows the parameter values that
describe the curve to be entered.

Read from table
When this option is selected, the parameter values are read from the data table
item and column that are selected. Any column in the data table can be selected,
but it is most convenient to use a column that has been specifically created to
facilitate parameter entry (see page 62).

Direct Entry
When this option is selected, the parameter values are entered directly into the
grid.

Enter Curve Constants
(Equation items only)
If the equation definition uses constants, their values are entered into this page.
The operation of this page is analogous to that of the Enter Curve Parameters
page described above.
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Select Fitting Curve Style
(Fitting and equation items only)

Fitting curve
Choose the width, line style and color of the curve that represents the fit.

X limits
By default, the fitted curve is drawn over the entire range of the x axis. Some
equations, however, are undefined over certain ranges (for example, at x < 0).
When the Start or End box is checked, GraFit will set the limit automatically, but
by unchecking these boxes it is possible to define the range over which the curve
should be displayed.

Resolution
Fitted curves are calculated for a range of values between the Start and End
limits. The Resolution entry controls how many points are used in this range. High
resolution uses more points, which takes longer and uses more memory. In
general, use the medium resolution unless the curve has a sharp discontinuity (e.g.
when plotting a step function). Under such circumstances use the high resolution
setting.
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Select Join Style
(not equation items)

Type
Chooses the type of join to use.
Effect

Join Type

None
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Effect

Join Type

Line

Bezier
Three degrees of curvature are available: slight,
medium and strong. The illustration shows a
medium curve. Bezier curves give smooth lines
between the points, and always pass each data
point.

Spline
Four orders of spline curve are available: 3, 4, 5
and 6; the illustration is created using order 3.
Higher orders give smoother curves. Spline curves
smooth out variation in the data, and do not
necessarily pass through the data points.

Width, Style and Color
These options control the appearance of the line that is drawn joining the points.

Modifying Graphs
Once created, graphs can be customized as required. This involves selecting the
appropriate part of the graph, and invoking a specific property sheet by doubleclicking, right-clicking or choosing the Properties command61 on the Graph tab.

61

The Edit  Properties command in legacy mode
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Selectable Regions of a Graph
The illustration below shows the various parts of a graph that can be selected. For
each, a specific property sheet is available that controls the formatting options.
y axis scale
Main graph region

Legend box

Legend
text
Data/curve
properties

x axis text

x axis scale

y axis text

Main Graph Region
The main graph region acts as the ―parent‖ of the other selectable regions and is
always visible (the other parts of the graph can optionally be hidden). Moving the
main graph region will also move all the other ―child‖ parts of the graph; however,
the child regions can be moved individually to position them. This ensures that the
whole graph can be moved around the page while maintaining the relative
positioning of the constituent parts.
Note
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The x and y axis scales have a particular relationship with the main graph,
as it is usual to ensure that their numbers line up with the scale marks. For
this reason, by default it is only possible to move the x axis scale in a
vertical direction, and the y axis scale in a horizontal direction. This effect
can be overridden by holding down the ALT key when moving the axis scale
texts.
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General Page

Graph frame
Check the various boxes to draw a line on the various edges of the graph.

Drawing options
Check this box to specify that the graph frame, axes and tick marks should be
drawn after the data points, which will result in these items lying on top of the data
points. By default, XY graphs have this option unchecked and column graphs have
it checked.

Visibility
The components of the graph are listed here, and their visibility can be set by
checking the appropriate box. Individual items on the graph can also be hidden
selecting the Hide Object command62 on the Graph tab.

Fill Page
The fill style applies to the graph background.

62

The Edit  Hide Object command in legacy mode
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Line Page
The line style applies to the frame drawn around the graph, as set on the General
page. It does not apply to the color of the tick marks, which are set on the
appropriate tick page.

X Ticks Page

X axis selector
X/Y graphs can have multiple x axes, and the tick settings for each are set
individually. Set the x axis number from this box (when first created, only a single
x axis will be available).

Tick settings
Ticks can be drawn on the inside, outside, both sides or neither side of the Upper
graph edge, the Lower graph edge, or on the X axis itself (assuming the scale
settings are such that this lies in the center of the graph). The tick sizes can be set
to small, medium or large, which are scaled relative to the overall graph width, or
to ―specific,‖ where the exact tick size is entered into the edit field.
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Left/Lower ticks outside

Left/Lower ticks inside

Left/Lower ticks both
sides

Axis offset
The axis offset controls the distance that the axis scale is drawn from the frame. If
the offset is 0, the scale is drawn immediately adjacent to the central graph frame;
increasing offset results in the scale being removed from the frame, as shown
below:

No offset

x axis offset

x and y axes both offset

If more than one x axis is present, it can be useful to set each to have a different
axis offset. This allows the two scales to be differentiated.

Tick marks
These settings control the width and color of the pen used to draw the tick marks.
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Major grid / Minor grid
These settings control the display of grid lines drawn across the axis at intervals
determined by the Major increment and Minor increment settings (Scale Page).

No grid

X Scale Page

152

x axis with major grid
(solid lines)

x axis with major grid
(solid lines) and minor
grid (dotted)

Chapter 14: X/Y Scatter Graphs

Scale Type
Select linear or logarithmic scaling.

Graph with linear x axis scale

The same graph with a logarithmic x
axis scale

Scale Start
If the box is checked, this value is set automatically from the graph data. Uncheck
the box to specify the starting value of the x axis (left edge).

Scale Finish
If the box is checked, this value is set automatically from the graph data. Uncheck
the box to specify the finishing value of the x axis (right edge).

Scale major increment
If the box is checked, this value is set automatically from the graph data. Uncheck
the box to specify the major increment value. The major increment value controls
how often scale numbers and major ticks are drawn.

Scale minor increment
If the box is checked, this value is set automatically from the graph data. Uncheck
the box to specify the minor increment value. The minor increment value controls
how often major ticks are drawn.
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Scale y axis position
If the box is checked, this value is set automatically from the graph data. Uncheck
the box to specify the axis position, which should lie in-between the Start and
Finish values.

The y axis position has been set so that it appears
between the Start and Finish values. If required, tick
marks can be drawn on the y axis line from the Y
Ticks page (Y axis Tick settings).

X axis selector
X/Y graphs can have multiple x axes, and the scale settings for each are set
individually. Set the x axis number from this box (when first created, only a single
x axis will be available).

Axis extent
By default, the Entire graph size box is checked, which ensures that the axis is
drawn over the whole graph width. Unchecking this box allows the axis to be drawn
over just a portion of the graph, which can be useful when multiple axes are
present. Enter the Start and End values as percentages of the whole graph width.
The Axis break symbol setting controls whether a break mark is drawn at the end
of the axis. This setting is used when drawing split axis scales (see Chapter 15 for
more information about multiple axes).

Y Ticks Page
The Y Ticks page controls the tick settings on the y axis in the same way as the X
Ticks page controls the tick settings on the x axis (see page 150).

Y Scale Page
The Y Scale page controls the scale settings for the y axis in the same ways as the
X Scale page controls scale settings on the x axis (see page 152).

Location Page
This sets the location of the graph within the graph page.
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Axis Scale Regions
The axis scale region controls the display and formatting of the scale numbers.

Scale Page

Number format
These settings determine the way that the numbers are displayed.
Setting

Description

Decimal places

Enter the number of decimal places to display. Note that
trailing zeros will be removed if the Trailing zeros in
fraction setting is ―Omit 0‘s.‖

Max digits

Enter the maximum number of digits to be used. The
displayed values will be rounded to ensure that only the
requested precision is displayed.

Thousands
separator

Check this option to separate groups of digits by a separator.
Typically, digits are grouped into threes and separated by a
comma. However, the grouping and the separator used
depend on values set by in the Options command63, Number
Format pane, found on the View tab.

63

The View  Options command in legacy mode
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Setting

Description

Scientific
format

Check this option to display numbers using scientific format.
For example, 1.234e+003 rather than 1234.

Power format

Check this option to display numbers using a power
representation. For example, 1.234 x 103 rather than 1234.

Trailing zeros
in fraction

This controls the way that trailing zeros are displayed in a
fraction.

Some examples of different formatting are shown below; all have Decimal places
set to 4, and Max digits set to 10.
Effect

Settings

Effect

Settings

Omit 0‘s

Omit 0‘s, scientific format

Show 0‘s

Omit 0‘s, power format

Text
These settings control the text display.
Setting

Description

Alignment

The scale text can be aligned to the left, right or centrally.

Orientation

Select the orientation of the text. The following orientations
are available:

Format string

Check this option to embed the numeric value within a text
string. The number is substituted for any occurrences of ―%1‖
within the entered text.

Values
The Scaling power setting allows a scaling factor to be applied to the numbers.
Before display, the scale numbers are multiplied by 10 raised to the power of the
value entered. The power must be a whole number, and may be positive or
negative. For example, an entry of -4 would cause the value of 40,000 to be
displayed as 4. An entry of 3 would cause the value 0.002 to be displayed as 2
(0.002 x 103 = 2). A scaling power of 0 results in the actual value being displayed
(100 = 1).
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Scaling power entries are very useful when dealing with large or small data values.
By scaling the displayed numbers it is possible to produce graphs that are correctly
scaled, but to enter conventionally ranged values into the data table. For example,
time values in nanoseconds could be entered into the data table as whole numbers
of nanoseconds then a Scaling power of -9 applied.

Axis Text Regions
Axis text properties are controlled in exactly the same way as normal text objects.
See Chapter 13 for further information.

Legend Box Region
The legend box lists all the data sets currently present within the graph.

Legend Page

Order
The current arrangement of items within the legend box is displayed. This order
can be changed by selecting an entry and clicking the Move Up or Move Down
buttons.
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Layout
This section controls the number of columns into which the data entries are
arranged.

4 data entries, with Number of
columns set to 1 (the default
setting).

4 data entries, with Number of
columns set to 2.

Custom Margins and Spacing
Checking the Custom margins and spacing box allows the spacing of the
elements within legend box to be set explicitly.

Fill Page
This page sets the fill settings for the legend box.

Line Page
This page specifies the line used to draw the surround of the legend box.

Location Page
This page controls the position of the legend box within the graph page.
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Data/Curve Properties
Data Points Page

This page is equivalent to the Data Point Style page of the XY Graph Wizard. See
page 143 for further information.
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Join Points Page

This page is equivalent to the Join Style page of the XY Graph Wizard. See page
146 for further information.
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Fitted Curve Page
(fitted data and equations only)

This page is equivalent to the Fitting Curve Style page of the XY Graph Wizard. See
page 145 for further information.
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Data Source Page
(fitted data only)

Select the data fitting item to be plotted from the Results selection, which lists all
the available linear and non-linear fits in the GraFit workspace. Fitting items can
hold several fits, and the Fit number can be chosen. The first fit is fit 1, which in
most cases will be the only fit present.
Check the Transform as box if you wish to display the data points and fitted curve
transformed as defined in the selected transformation. All the transformations
present in the workspace are listed. See Chapter 10 for information about defining
transformation items.
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Data Source Page
(raw data only)

Select the Data table item that holds the data, together with the columns that
hold the x and y data.
Check the Transform as box if you wish to display the data points transformed as
defined in the selected transformation. All the transformations present in the
workspace are listed. See Chapter 10 for information about defining transformation
items.
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Error Bars Page

General
This section defines the general types to use for the error bars, including the width
and color of the pen used to draw them. The Style choice is only available after
error bars are selected in one of the X error bars or Y error bars sections.
Style

Effect
The error bars are drawn as simple lines.
The ends of the bars are delimited with a ―T‖ bar.

The XY type option is only available if error bars are present on both axes.
XY type

Effect
Error bars are drawn for the x and y axes separately.
A single error bar is drawn, which extends diagonally to show
the x and y error extents.
A single error bar is drawn, which extends diagonally to show
the x and y error extents.
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The Source data entry must be completed if Explicit errors are specified for either
x or y errors. Select the data table that is used for the explicit errors from the list
given.

X error bars
This section is used to specify the type of errors present on the x axis.
Error type

Effect

None

No error bars are drawn. This is the default setting.

Absolute

The size of the error bar is the same for each data point of the
data set; this size is entered into the field to the right of this
button.

Proportional

The size of the error bar depends upon the magnitude of the
data point; the size is expressed as a percentage of the data
point value and is entered into the field to the right of this
button.

Explicit

The size of the error for each data point is specified
individually. The error values must be stored in a data table,
which is specified in the General section, and the size of the
positive and negative parts of the error bar is set separately.
The data column that holds the positive error values is
selected from the list marked ―+.‖ If only this option is
chosen, the error bar just has a single lobe.
To specify additionally the size of the negative lobe, click the
―-‖ button, and select the column that holds the value of this
error. If you select the same column as selected for the
positive error, this will result in symmetrical error bars.
The Invert check boxes allow the direction of the error bars
to be reversed, drawing the error bar in the opposite direction.

Some examples of error bar types are shown below.

No error bars

Absolute error bars on
the y axis

Proportional error bars on
the y axis
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Absolute error bars on
the x axis, proportional
errors on y

Explicit error bars on the
y axis; only the positive
lobe is shown

Explicit error bars on the
y axis; the positive and
negative lobes each use
the same error column

Y Error bars
This section is used to specify the type of errors present on the y axis. The settings
are analogous to those described above for x error bars.

Axis Association Page

The Axis Association page allows the data to be associated with the various axes
that are present (see Chapter 15 for information on multiple axes). XY graphs can
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contain many different x and y axes, and the data can be associated with one (the
minimum) or many different axis scales. Check the boxes of all axes that you wish
to be associated with this data set.

Equation Page
(equation data only)

This page selects the equation that describes the curve to be plotted. All equation
items present in the GraFit workspace are listed.
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Parameters Page
(equation data only)

This page is equivalent to the Curve Parameters page of the XY Graph Wizard, see
page 144 for further information.

Constants Page
(equation data only)
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This page is equivalent to the Curve Constants page of the XY Graph Wizard, see
page 144 for further information. This page is present even for equations that do
not define any constants, as is the case for the figure above.

Legend Text Regions
Legend text properties are controlled in the same way as normal text objects,
except that legend text cannot be displayed rotated. See Chapter 13 for further
information on text formatting.
Note

The overall width of the data legend depends on the size of the individual
legend text elements. Each of these can be individually sized using the
mouse.

Adding Extra Data to the Graph
Additional data sets, fitted results or equations can be added to the graph by
selecting the main graph region, then choosing the Add Data command64 on the
Graph tab. This re-invokes the XY Graph Wizard to allow further data to be added.
Most of pages are equivalent to those described earlier for creating new graphs,
although those pages that control initial scaling are not relevant, and so are not
displayed.

Set Axis Associations Page
When graphs are first created, they have a single x and y axis, with which the
selected data sets are associated. However, after creation it is possible that a graph
may have additional axes, and so the axis association needs to be specified when
adding data. This results in an additional Axis Associations page being added to the
Wizard.

64

The Graph  Add Data command in legacy mode
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This is equivalent to the Axis Association parameters page described on page 166.
Check the boxes of the axes with which your data should be associated. In the
figure shown above, the graph has a single x and y axis and so no modification is
needed.
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Using Multiple Graph Axes

When to Use Multiple Axis Scaling
Graphs created using GraFit can optionally have several different x and/or y axes,
which are independently scaled.

Overlaying Data that have Different Scales
Multiple axes are useful when data need to be overlaid, but have quite different
numerical ranges. For example, in the plot below there are two separate y axes,
but a common x axis. Two different data sets are plotted, each associated with
different y scales.

6

Data associated
with 2nd y scale

100

Data set #1

80
4
60
40

2

20
0
1st y scale

Acetonitrile ( )

Absorbance ()

Data set #2
Data associated
with 2nd y scale

2nd y scale

0
2

4

6

8

10

12

Fraction Number
XY scatter graphs can have as many different x or y axes as you require; bar
charts and column charts allow unlimited numeric axes (the x and y axes,
respectively, for these plots).

Split Axes
Split axes are used when it is necessary to show some region(s) of a data set at a
different scale to the remainder. The example drawn below has a single split x axis.
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GraFit uses multiple axes to construct the splits, and permits any number of splits
on both x and y axes.

100

Response

80
Axis split

60
40
20
10-9

10-8

10-7

10-6

10-5 10-4 10-3

[Inhibitor]

Creating and Managing Multiple Axes
By default, GraFit graphs have just a single x and y axis. Any additional axes must
be added to the graph using the Axis Manager, which allows axes to be created or
deleted, and simplifies generation of split or multiple axes.

Running the Axis Manager
To activate the Axis Manager, use the mouse to select the graph that you wish to
modify, then choose the Axis Manager command65 from the Graph tab. This will
launch the Axis Manager Wizard.

65
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Six options are available on the initial page:



Add a new x axis



Add a new y axis



Split an existing x axis



Split an existing y axis



Remove x axis



Remove y axis

If only a single axis is present, the Remove axis options will not be available, as a
minimum of one axis must exist. Select one of the options, and click the Next
button.

Adding a New Axis
Choosing to add a new axis will give the following page.
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A number of initial tick styles and axis text locations can be chosen, and in addition
it is possible to specify that the new axis is created offset from the main graph. All
new axes have associated axis and scale text, which needs to be positioned as
appropriate. In addition, the new axis ticks are set and scaled independently of any
tick settings already present on the graph. When you have made your initial
choices, press the Finish button to add the new axis.

Splitting an Existing Axis
Choosing to split an existing axis from the Axis Manager will give the following
page.
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The axis to be split should be selected from the list available. The initial split
position can be set using the slider control. By default, the axis is split in the
middle, i.e. at 50%. Use the slide to set this to an appropriate position. The axis is
split so that the scale for two new axes is set as below, using the Split value to set
the end of the first scale and the start of the second.

Original Axis
Start

Finish

Split Axis
Start

Split value

Finish

After entering a suitable Split value, click the Finish button to create the new
axis.

Removing an Axis
If you elect to remove an axis using the Axis Manager, you will be presented with a
list of all axes that can be deleted.

Choose the axis to remove, then click the Finish button to delete it from the graph.
Any data or curves that are associated with the deleted axis become re-associated
with the default (first) axis. You can modify axis associations by editing the
properties associated with the data set. To do so, select the data symbol (found in
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the data legend), and choose the Properties command66 from the Graph tab (or
double-click on the data symbol).

Working with Multiple Axes
Axis Text and Axis Scale Text
Each axis has a separate text legend that can be positioned and edited as required,
and a separate scale text that can also be formatted as required.

Data/curve
properties

y axis
text (2)
y axis scale (1)

y axis scale (2)

y axis text (1)

Visibility of Axis Text and Axis Scale Text
There are often cases where it is not necessary to show a separate axis text and/or
axis scale text for each axis. The various items can be hidden by selecting the item,
then choosing the Hide Object command67 on the Graph tab. Objects can also be
hidden and unhidden from the General page of the graph properties (double-click
on the main graph area, or choose the Properties command66 when the main
graph is selected).

Data Association
Any dataset that is added to a graph can be associated with one or all axes. When
using multiple axes to display data that have distinct ranges, it is usual to associate
each dataset with one specific axis. For split axes, it is usual to associate all
datasets with each axis. The data association for an axis is set from the Axis
66
67
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Association Page, found by double-clicking on the appropriate Data/Curve
Properties region of the data legend (see figure above). Further information about
modifying data properties is found in Chapter 14.

Axis Scaling and Sizing
Each of the multiple axes has separate scaling, size and tick settings. These are
modified from the Scale or Ticks pages of the graph properties. To access these,
select the graph and choose the Properties command66, or double-click on the
main graph region. For more detailed information about setting these properties,
see Chapter 14.

Scaling

Use the Axis selector to choose which axis is to be scaled, then set the scale as
appropriate.

Sizing
The Axis extent settings on the page shown above control the proportion of the
graph over which the current axis extends. When using multiple axes to show data
of with different numerical ranges, it is normal to have the axis set to occupy the
Entire graph size. However, in some circumstances it can be useful to limit the
axis to a small region. For example, this can be a good way to overlay residuals, as
illustrated below.
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[Substrate]
In this graph there are two y axis scales, the first which holds the normal fitted
data, and the second that is used to plot the residual error. The first y scale is set
to occupy from 0 to 70% of the graph size, the second is set from 70 to 100%.

Setting the Split Position
Split axes are created by using axis extents less than the full graph size, and by
including a suitable Axis break symbol. In order to modify the split position along
the axis, it is necessary to change the Start and/or End position of the Axis
extent. This must be done for each axis concerned.

Tick Settings
Each axis has full control over where, and how often, ticks are drawn. For this
reason, when a new axis is created it often the case that the initial tick settings
overlap existing settings from existing axes. If this is the case, it is necessary to
modify the tick settings for one or more axis in order to obtain a suitable
appearance.

178

Chapter 15: Using Multiple Graph Axes

The Ticks page also includes an Axis selector section, which allows each different
axis to be selected. After choosing the axis to modify, alter the tick settings as
required.

179

GraFit User’s Guide

180

C H A P T E R

1 6

Column and Bar Charts

The Chart Wizard
Chapter 12 described the basics of creating graphs. Selection of Column Chart or
Bar Chart produces the ―Chart Wizard‖ to assist with the setup (all settings can be
adjusted later, if required). Column and bar charts differ only in their orientation,
and so the same process is carried out for each. The process of editing charts is
broadly similar to editing X/Y graphs, and Chapter 14 should be consulted for
further information.

Select Data Source Page

The Select Data Source page allows you to choose the source and type of data to
plot.
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Legend text
The data set plotted is associated with an entry in the data legend. The entry
shows the symbol used to represent the data, and a descriptive text. The initial
text used to describe the entry can be entered into this field.

Source
Graphs are plotted using data that are present in one of the items found in the
GraFit workspace. The Source selection lists all items that contain suitable data for
plotting, and one of these must be selected.

Category axis
Select which column holds the category names that are to be plotted.

Upper data
The Upper Data selection is used to choose the data column that holds the values
to be associated with the selected categories.

Error column
Checking the Error column box allows a quick way of producing an error plot.
Select the column that holds the error values from the list. More extensive error
plotting options are available once the graph has been produced.

Lower data
Check the Lower data box to generate a High-Low chart (where the entries have
both an upper and lower value). If this box is unchecked, a standard chart will be
produced; if checked then it is necessary to choose the column that holds the lower
data values for the High-Low chart.

Lower error column
When the Error column and Lower data boxes are both checked, the error values
for the lower data are selected from this box.
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Set Initial Scaling

The Set Initial Scaling page allows the scale of the data axis to be specified. By
default the scale is set automatically, and a linear data axis is chosen. These can be
altered as required (it is also possible to adjust the scale settings later). The text
used for the data and category axes can also be entered.
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Select Tick Styles

The Select Tick Styles page allows rapid selection of some of the more common
axis tick styles. More extensive tick style choices can be made once the graph has
been created.
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Select Bar Style

The Select Bar Style page allows the chart bar representation to be chosen.
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Select Data Point Style

It is possible to use data points to represent the values, if required. By default, no
data point style is selected.
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Select Join Style

It is possible to draw lines that join the points, if required. By default, no lines are
drawn.
Click the Finish button to create the chart.
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Histograms

The Histogram Wizard
Chapter 12 described the basics of creating graphs. Selection of Histogram
produces the ―Histogram Wizard‖ to assist with the procedure (all settings can be
adjusted later, if required). The process of editing histograms is broadly similar to
editing X/Y graphs, and Chapter 14 should be consulted for further information.

Select Data Source Page

The Select Data Source page allows you to choose the source and type of data to
plot.

Legend text
The data set plotted is associated with an entry in the data legend. The entry
shows the symbol used to represent the data, and a descriptive text. The initial
text used to describe the entry can be entered into this field.
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Source
Graphs are plotted using data that are present in one of the items found in the
GraFit workspace. The Source selection lists all items that contain suitable data for
plotting, and one of these must be selected.

Values column
Select which column holds the data values whose distribution is to be plotted.

Numbers column
Check this box if a second column is present that holds a count of the number of
items an item in the Values column is present. If unchecked, that it is assumed
that each entry in the Values column is represented once only; if checked then
the column that holds the number of entries must be selected.

Start position
Enter the starting position for the histogram grouping. The histogram records the
number of occurrences of data values within a specified data range. This range is
defined as having an origin at the Start position value, and the group size is set
by the Increment value.

Increment
Enter the histogram increment value, as defined above.

Set Initial Scaling

The Set Initial Scaling page allows the scale of the data axis to be specified. By
default the scale is set automatically, and linear axes are chosen. These can be
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altered as required (it is also possible to adjust the scale settings later). The text
used for the x and y axes can also be entered.

Select Tick Styles

The Select Tick Styles page allows rapid selection of some of the more common
axis tick styles. More extensive tick style choices can be made once the graph has
been created.
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Select Bar Style

The Select Bar Style page allows the histogram bar representation to be chosen.
Click the Finish button to create the chart.
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Embedding and Linking

What is Embedding and Linking?
Embedding and linking are two related ways that information from one application
can be incorporated into a different program. Also known as Object Linking and
Embedding (OLE), it provides a uniform mechanism for Windows programs to
cooperate and to share information. Most Windows applications allow information to
be copied between programs using the Clipboard. For example, a picture could be
copied from one application and pasted into a second. The problem with simple cut
and paste is that the second application often has no idea what information is being
transferred. In non-OLE applications, this often means that once the information is
copied it is impossible to make any subsequent changes to the image. OLE gets
around this by allowing two cooperating applications to pass information between
themselves in such a way that editing is still possible, even after pasting into an
application that has no knowledge about the information transferred. Both
embedding and linking are extensions of the standard Clipboard cut and paste
mechanism.

Original Cut and Paste Model
The original use of the Clipboard was to pass a representation of the object being
copied. For example, copying a graph might place an image of the graph on the
Clipboard. Pasting would then insert this picture, as distinct from inserting the
information required to draw the graph.

Standard cut and paste inserts an image representing the source object into the
target application. This image is simply a picture, and contains no information
about the underlying data in the source application.
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Embedded Objects
Embedded objects hold both a display representation and the underlying data. A
copy of the current state of the source object is created and is passed to the target
application. This means that subsequent changes within the source application do
not affect the newly pasted object. In turn, although the embedded object can be
edited, any changes are not reflected in the original source document. Because a
complete copy of the source data is placed in the target application, files containing
embedded objects can be large.

Embedding places a copy of the internal data into the target application, as well as
an image representing the source.

Linked Objects
Linked objects also copy a representation of the original data, but do not copy the
data itself to the target. Instead, the target application maintains a link to the
original source file. Changes to this source data file result in the information copied
to the target application also changing. In addition, if the linked object is edited
from within the target, this will change the original document. Because linking must
always involve files, it is only possible to create a link after the information in the
source application has been saved to disk.

Linking does not copy the original data, but allows the target application to
maintain links to the original source file. Changes to the source result in the target
application being updated.

Using Embedding and Linking
Windows applications that are able to employ OLE use the convention that Edit 
Copy from the source program will place the necessary information on the
Clipboard, and Edit  Paste from the target application will embed an object.
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Therefore, it is the standard that embedding is used by default. To link to an
object, the same Edit  Copy command is used in the source program, but,
depending upon the target application, the object is inserted with the Edit  Paste
Link or Edit  Paste Special command.
The OLE object can be activated by double-clicking on its representation within the
target, or by accessing the object menu that resides on the Edit menu (and is
often also available by right-clicking on the object).

Comparison of Data Transfer Types
The following table compares the various ways that data can be transferred
between applications via the Clipboard.

How to paste
information in
this format

Non-OLE
Clipboard
transfer

Embedding

Linking

For non-OLE
applications, Edit 
Paste

For OLE
applications, Edit 
Paste

For OLE
applications, Edit 
Paste Link or Edit
 Paste Special
and choose to
paste as a link

Allows information
to be edited after
pasting

Allows information
to be edited after
pasting

Pasted information
is stored within
the target
document

Since data are
kept within the
source file, this
allows efficient use
of space when
several documents
may wish to link to
the same object

No link maintained
with the source
document

Linked information
is kept in a
separate file,
which may
become ―lost‖

For OLE
applications, Edit 
Paste Special and
select a non-OLE
format
Advantages

Disadvantages

Compact data
format

No editing allowed
after pasting

Documents
containing
embedded objects
tend to be large
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Note

The default action for a Windows application that supports OLE is to embed
information whenever possible if the Edit  Paste command is used. As
described in the table above, embedding is not always the most appropriate
way of sharing the information, and linking is frequently more desirable, for
which you need to select the Edit  Paste Special command.

Embedding and Linking without using the Clipboard
Data objects can also be inserted into a target application directly, using an Insert
Object command, which is often found on the Edit menu.

The Insert Object command allows the insertion of OLE objects into a document
When the Create New button is selected, an empty object of the selected type is
inserted as a new embedded OLE item. If the Create from File button is chosen, it
is possible to initialize the embedded item using the contents of an existing file, or
to create a linked object.
The Create from File option allows
creation of an embedded object
based on the contents of an
existing file. If in addition the Link
button is checked, a linked object
will be created rather than an
embedded one

Embedding and Linking with GraFit
GraFit can act as both a container of OLE items that come from other source
applications, and as the source of OLE items that are inserted into other targets.
The situations where GraFit can act as container (target) or source are discussed
below.
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GraFit as an OLE container
There are several places where it is possible to insert OLE items into GraFit.

GraFit Project Window
The main GraFit project window can hold OLE objects, which are inserted from the
Clipboard using the Paste or Paste Special commands68 from the Home tab, or
created anew using the Object  Insert New Object command69 on the Home
tab. Objects inserted into the project window are always displayed as icons.
Activation of these objects will always launch their source application in a separate
window.

Graph Window
All graph windows can hold OLE objects, which can be inserted from the Clipboard
as usual or created anew using the Object  Insert New Object command.
Objects inserted in a graph window can be moved and sized as required. In-place
editing is available by double-clicking on the item. The size of the object can be
reset using the Object  Reset Original Size command70 from the Home tab.

Equation and Transformation Definition Windows
These GraFit item windows hold textual comments, which can incorporate
embedded OLE objects. See Chapters 9 and 10 for further details.

GraFit as an OLE source
The contents of a GraFit workspace can be embedded or linked into other
applications. What is displayed is the contents of a particular graph window,
although the entire workspace information is copied. To embed a GraFit graph into
another application, first activate the graph to use, then choose the Select All
command71 from the Home tab to ensure that all graph items are selected.
Note

It is extremely important to use the Select All command, as no OLE
information is copied unless all items are selected). When all objects are
selected, the Copy command is replaced by Copy All.

Next choose the Copy All command72. Insert the information into an OLEcompliant application using Edit  Paste or Edit  Paste Special as appropriate to
the application in question.

68
69
70
71
72

The
The
The
The
The

Edit
Edit
Edit
Edit
Edit







Paste or Edit  Paste Special commands in legacy mode
Insert New Object command in legacy mode
Reset Original Size command in legacy mode
Select All command in legacy mode
Copy All command in legacy mode
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Data Fitting Basics

This chapter describes some of the basic principles behind data fitting. A more
complete description of the theory is given in Chapter 20, and additional
information can be found in several reviews.73–78 Within GraFit, data are fitted
using the Non-linear Fit or Linear Fit item windows, which are described in Chapters
6 and 8, respectively.

When Is Data Fitting Appropriate?
Data fitting is the mathematical analysis of a data set in order to analyze trends in
the data values. This will usually involve linear or non-linear regression analysis of
these data values, in order to define a set of parameter values that best
characterize the relationship between the data points and an underlying theoretical
model. While many types of data can be usefully presented in graphical form, not
all such data are suitable for data fitting.

Types of Data
In general, data can be divided into three groups.

1. No Systematic Trend
There are many examples of such data, and two are displayed below.

73

Cleland, W.W. (1967) Adv. Enzymol. 29, 1-32.
Bevington, P.R. (1969) Data Reduction and Error Analysis for the Physical Sciences McGrawHill.
75
Duggleby, R.G. (1981) Analytical Biochemistry 110, 9-18.
76
Press, W.H., Teukolsky, S.A., Vetterling, W.T. & Flannery, B.P. (1992) Numerical Recipes in
C. Cambridge University Press.
77
Motulsky, H.J. & Ransnas, L.A. (1987) FASEB J. 1, 365-374.
78
Leatherbarrow, R.J. (1990) TIBS 15, 455-458.
74
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Such data are typically presented as bar or column charts, or as scatter plots with
the data points joined by lines (or possibly by a smooth curve). As no systematic
relationship describes the data, they are not suitable for data fitting.

2. The Trend is described by a Known Equation
This is the situation where data fitting is most useful. In this case, based on
knowledge of the experiment, and the laws that govern it, the data are described
by a known equation, i.e.
𝑦 = 𝑓 𝑥, 𝑝1 , 𝑝2 , 𝑝3 , …
In non-mathematical terms, the observed data, y (also known as the dependent
variable), varies as a function of some experimentally controlled value x (the
independent variable) and one or more parameters p1, p2, p3, etc. The exact form
of the equation depends on the experiment and the conditions that are used: it
might be a simple linear equation,
𝑦 = 𝑎𝑥 + 𝑏
or a more complex function. In either case, the purpose of data fitting is find values
for the parameters in this equation that best describe the data. For a simple linear
equation, as shown above, this is done by linear regression. In general, however, a
more complex equation will apply. Such data are fitted by non-linear regression.
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GraFit allows non-linear equations of arbitrary complexity to be used for data
fitting.

3. A Systematic, But Uncharacterized Trend is Present
Occasionally, data may be collected that show a distinct trend, but no known
equation describes this relationship. For example, an empirically determined
calibration curve may be collected. If the physical basis for the shape of the data is
not well defined, the appropriate equation is unknown. In such situations it can be
useful to fit the data to a general-purpose equation, such as a polynomial. This will
allow values to be extrapolated from the standard curve, although any parameter
values that are obtained will not have physical meaning. The use of data fitting for
this purpose is illustrated in Chapter 21.

Regression Analysis
Regression analysis finds the ―best fit‖ line or curve through a series of data. This is
considered to be the one that minimizes the sums of the squares deviations of the
experimental data points from the theoretical curve. GraFit uses regression to allow
the analysis of experimental data.

Practical Considerations
The Errors are in the y Data
It is the convention to assume that the x data values represent the independent
variable, and the y data values represent the dependent variable, i.e. the x data
are what is varied in the experiment (for example time, concentration, etc.), and
the y data are the experimentally observed values.

y axis

x axis
The vertical distance (the gray lines in the above diagram) between the data point
and the curve or line is that which is minimized by normal regression analysis, i.e.,
it is assumed that all errors are present in the y data. An important aspect of
experimental design is to ensure that the x data are as accurate as possible so that
this assumption is valid.
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The Data Values Have a Suitable Numerical Range
A consequence of computer calculation is that rounding errors can occur,
particularly if very large or very small numbers are used. This is because
computers only store decimal numbers with a limited numerical precision. Although
this should not affect most calculations, it is advisable to scale any set of very large
or very small values prior to performing calculations. For example, if a series of
time values were entered as 0 to 10-15 seconds, the rounding errors could be
significant. Entering the data as 0 to 1 femtoseconds may be more appropriate.

Types of Regression Analysis
Regression acts to minimize the sum of the squares deviations of the experimental
values from values calculated using some theoretical equation. However, the
mechanics of the calculations are different for linear and non-linear equations.

Linear Regression
Linear regression is a technique that should be familiar to most scientists. It is the
mathematical equivalent of using a ruler to draw the ―best‖ line through a series of
data points to obtain values for the slope and intercept of this line. The calculations
needed to perform linear regression are relatively simple, and are even found on
many scientific calculators.

Polynomial Regression
Polynomial regression is an extension of linear regression, where the equation is
𝑦 = 𝑎 + 𝑏𝑥 + 𝑐𝑥 2 + 𝑑𝑥 3 + 𝑒𝑥 4 + ⋯

Non-linear Regression
Non-linear regression allows data to be fitted in the more general case to any
equation where the y data value can be described as a function of the x data and a
series of parameters, i.e.
𝑦 = 𝑓 𝑥, 𝑝1 , 𝑝2 , 𝑝3 , …
As a result, it is applicable to many more situations than linear regression, and is
more generally useful for analyzing experimental data. The only drawback to nonlinear regression is that the calculations are too complex perform using a
calculator, and require a computer program such as GraFit.

Additional Considerations for Non-linear Regression
The more complex nature of the non-linear regression calculations does require
some further considerations compared with linear regression.

Equation to Use
Non-linear regression can employ a vast range of different equations. It is therefore
necessary to select an equation that is appropriate to the particular experimental
situation before fitting the data.
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Initial Estimates
The mathematical method used to perform non-linear regression acts to take
starting estimates for the parameters in the equation, and optimize them during
the calculations. As described in Chapter 9, GraFit provides a mechanism for
providing these initial estimates automatically for some equations, but in principle
it is necessary to give the calculations some rough estimates prior to data fitting.

Convergence Criteria
Unlike linear regression, non-linear regression does not provide an exact solution,
but, by an iterative process, calculates successively better parameter values until a
suitable tolerance is reached. The criteria for defining this tolerance are determined
by the program, and can be specified when using GraFit.

Weighting Scheme
Both linear and non-linear regression analyses incorporate assumptions about the
accuracy of the data points. Normally, they assume that all data points are equally
accurate, and so carry equal weighting in the analysis. It is also possible to use
other weighting schemes that give different weighting to one or more data values.
A full description of weighting is found in Chapter 20.

Linear Regression of Transformed Data
A familiar method of analyzing non-linear data graphically is to rearrange the data
to a linear form, find the ―best line‖ through the points, and so derive the
parameter values. This is illustrated in the following example. Enzyme kinetic data
are described by a hyperbolic equation of the form:
𝑦=

𝐴𝑥
𝐵+𝑥

This can be linearized by plotting 1/y versus 1/x, as
1 1 𝐵 1
= . +
𝑦 𝑥 𝐴 𝐴
The ease of linear regression analysis makes it tempting to use in order to fit data
that have been rearranged in this way. However, the results that are obtained are
not statistically optimal. This is because the regression calculations make
assumptions about the error distribution that are not usually valid after
transformation. The distortion of the experimental errors by the above
transformation is easily demonstrated in the following graphs.
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Here, the error involved in the high data points of the transformed plot is much
greater than in the low data points — this is simply a consequence of the reciprocal
transformation. Linear regression (unless suitable compensation is made for the
distorted errors) is therefore not an appropriate way to analyze the data, and the
original data should be fitted to the appropriate non-linear equation.

Information Obtained from Data Fitting
Data fitting provides the following information regarding the experimental data that
are analyzed.
1. The values of the parameters in the equation used that best describe the data.
These parameters may include (for example) rate constants, inhibition
constants etc. whose values need to be determined.
2. The accuracy of these calculated parameters.
From this information it is possible to judge how well the data fit the experimental
model (equation) that was used. In most cases, however, it is the numerical values
of the parameters that are important, and whose values are required from the
analysis.
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Multiple Regression
The most common form of non-linear equation that is analyzed by GraFit is of the
form
𝑦 = 𝑓(𝑥)
where the right hand side of this expression may contain one or several
parameters. Such an equation has one dependent (y) and one independent variable
(x). In addition, GraFit can be used to analyze equations with more than one
independent variable, i.e.
𝑦 = 𝑓(𝑥1 , 𝑥2 , 𝑥3 , … )
In this case the analysis is termed multiple non-linear regression. GraFit allows
unlimited independent (x) variables, as well as unlimited numbers of parameters.
Note, however, in all cases it is assumed that only the y axis data contain errors.
Note

Multiple regression is sometimes also referred to as “global analysis.”

Uses for Multiple Regression
Multiple regression is essential when the data to be examined are inherently
multidimensional. Examples include peak-shape analysis of 2D spectra. However,
there are several situations where multidimensional data are collected, but are
traditionally analyzed by a performing a series of normal two-dimensional (x, y)
curve fitting.

Example
The progress of an enzyme-catalyzed reaction at a fixed concentration of substrate
is given by the equation:
𝐴𝑡 = 𝐴∞ 1 − 𝑒 −𝑘𝑡
Here, At is the extent of reaction at time t, A the maximum extent of reaction, and
k the rate constant at this concentration of substrate. The value of k from this
equation is related to the kinetic parameters by the equation:
𝑘=

𝑉𝑚𝑎𝑥 [𝑆]
𝐾𝑚 + [𝑆]

In this equation, Vmax and Km are the parameters that we need to obtain from data
fitting. The usual way of analyzing these data is to collect a series of progress
curves (A as a function of t) at varying concentrations of substrate. For each
concentration of substrate the data are fitted to the first equation, and a value for k
obtained. The resulting k values are then fitted to the second equation to find Vmax
and Km. A better solution is to recast the equation as a three-dimensional one,
where the progress of the reaction varies with t and [S], which are the two
independent variables. The equation is obtained by combining the previous ones:
𝐴𝑡 = 𝐴∞ 1 − 𝑒𝑥𝑝 −

𝑉𝑚𝑎𝑥 [𝑆]
.𝑡
𝐾𝑚 + [𝑆]
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This allows Vmax and Km to be determined directly from the raw data, which has two
x variables (t and [S]).
A sample set of data that has been fitted in this way can be found in the Examples
data subdirectory, and is named ―Multiple rate.‖

Advantages of Multiple Regression
Use of multiple regression simplifies the analysis, as the curve fitting need only be
carried out once. In the above example, the value of A  is fixed for the entire
experiment and only found once for the multidimensional equation. However, if the
data are analyzed by several applications of the first equation, the A value would
be determined several times.

Disadvantages of Multiple Regression
The disadvantages of multiple regression are as follows.



Conceptual. It is often difficult to visualize the problem in more than two
dimensions.



Finding initial estimates. This is sometimes difficult for the same reasons.



Difficulty of display. The current version of GraFit does not support threedimensional plotting; the display of four-dimensional data is even more
problematic!

Defining Equations
Definition of equations having multiple independent variables is achieved in the
same way as the definition of normal two-dimensional x/y equations, but the
equations have more that one x variable.

Fitting Data by Multiple Non-linear Regression
For a normal data set that contains x/y data, these data must be present in the
data table with the x data and the y data in separate columns. When multiple
independent variables are involved, there are special considerations as to how the
data should be arranged.

Case 1: The equation has only two independent variables
In many circumstances there will be just two independent variables in an equation.
In these circumstances, it is common to collect one set of {x1, y} data at a
particular x2 value, then the next set of {x1, y} data at a different x2 value etc. In
the case of the example described above, this would entail collecting A versus t at
one particular [S], then another set of A versus t at the next [S] and so on.
When this arrangement of data is present, it is convenient to enter the {x1, y} data
into the data table, and to associate the x2 value with the y data column. For
example, the data can be entered as shown below.
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Note that the y data each have an associated x2 value. For this particular data set,
all the y data are associated with the same x1 data, which corresponds to the Nonlinear Fit data layout type:

(See Chapter 6 for more details about the Non-linear Fit window.)
It is also possible to have a separate set of x1 data for each y data, corresponding
to the Non-linear Fit data layout type:

Case 2: The equation has several independent variables
When an equation has several independent variables it is necessary to have the x1,
x2, xn, y data in separate columns. This corresponds to the Non-linear Fit data
layout type:

In order to distinguish the various data types, it is essential that all the x data
columns are set to ―x(n) Data‖ with the ―n‖ value representing the order of the x
variable found in the equation definition. See Chapter 5 for further details on
column types.

Data Fitting
Apart from the considerations above, fitting data that have multiple independent
variables is no different from fitting standard equations. A sample set of data that
has been fitted in this way can be found in the Examples data subdirectory, and is
named ―Multiple rate.‖
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Plotting Results from Multiple Regression
The data that form the basis for multiple regression have three or more
dimensions. To represent such data would, strictly speaking, require a
multidimensional plot, which is not available. However, the usual representation for
such data is to plot multiple curves, representing the raw data as collected, on the
same graph. This is particularly simple for the situation noted as ―Case 1‖ above.
Choosing to create a graph to display the non-linear fit will automatically generate
a suitable plot. In the case of the sample data set, the fitted curve is shown below.
The file that generated this curve can be found in the ―Samples‖ sub-directory of
your My GraFit Data directory, named ―Multiple rate‖.
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Theory

To make best use of GraFit, it is helpful to know some of the theory behind
regression analysis. Chapter 19 provided a general overview; this section describes
more of the theoretical background.

Regression Analysis
Regression analysis is a technique used to calculate the ―best fit‖ line or curve
through a data set by minimizing the deviation of the data from the curve.
Mathematically, it finds values for various unknown parameters in an equation (for
example, the slope and intercept of a straight line) that produce the smallest
possible sum of the squares deviations of the experimental values from the
calculated ones. This quantity that is minimized is denoted by the symbol 2 (chisquared). The value of 2 includes the variance of the data point (the variance of
data point i is i), so that data points that have greater errors contribute less to the
analysis. It is calculated as:
∆𝑦𝑖 2
𝜒2 ≡
𝜎𝑖
yi is the difference between the experimental and calculated y data values (the
subscript ―i‖ is used to indicate the ―ith‖ data value).
A further useful statistic is 𝜒𝜈2 , or the reduced chi-squared. This is defined as below.
𝜒𝜈2 =

𝜒2
𝜈

Here,  is the number of degrees of freedom, which is given by  = N  n; N is the
number of data points and n is the number of variables in the equation.
Regression analysis is the mathematical equivalent of finding the best line by eye—
it has the advantage, however, of being non-subjective. It is also possible to fit the
―best curve‖ through the data by non-linear regression. This has no manual
equivalent (because humans are very poor at judging accurate curvature), but is
equally simple mathematically using computational methods.
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Assumptions in Regression Analysis
Regression analysis is probably the most powerful method to analyze data.
However, such analysis involves several assumptions about the function chosen
and the error structure of the data. These assumptions are listed below.

The Correct Equation is used
This assumption is often overlooked, but should be borne in mind when using
any data analysis technique. It is important to be aware that deviations from
ideality are often caused by use of an inappropriate equation. Graphical
methods provide a useful means to see whether the chosen model equation is
appropriate. This is because use of an inappropriate equation often results in
systematic deviations from the curve, which is easy to see in a graph.
Residual plots of y versus x are useful to assess whether the equation is
appropriate. Systematic deviations in the residuals can mean that the equation
used was inappropriate to describe the data. The differences between
experimental and calculated values can be calculated using options available in
the data table (see Chapter 5). The data shown below have been fitted to a
single exponential decay, and to a double exponential decay, and the residuals
from each have been plotted. Clearly, the residuals from the double exponential
fit are smaller and more randomly distributed, and show that this fit is superior.
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Only the Y Data Contain Errors
Only the dependent variable, which by convention is always the y variable (yi),
is subject to error; the other (xi) is known exactly. This requirement should be
satisfied by suitable experimental design — the x data values often comprise
time or concentration values, which should be known with precision.

The Errors are Normally Distributed
The errors in the y data values should follow a normal distribution function, i.e.
if sufficient replicates were taken they would have a Gaussian spread about the
true y value. Two common factors that invalidate this assumption are the
presence of (i) systematic errors, and (ii) outliers (data points that are wildly
inaccurate, usually due to operator or machine failure). Systematic errors
invalidate any data analysis, and should be removed by correct experimental
design. Outliers can be eliminated by use of ―robust‖ techniques, as will be
described later in this chapter.

The Correct Weighting is used
An explanation of what ―weighting‖ of data in regression analysis is, why it is
incorporated into all such analysis (including the subjective regression
performed by drawing the ―best line‖ using a ruler), and how the appropriate
weighting can be determined are described later.

Linear Regression
The simplest case for regression analysis is when the equation is linear. For the
linear equation:
𝑦 = 𝑎 + 𝑏𝑥
2

is defined as:
∆𝑦𝑖
𝜒2 ≡
𝜎𝑖
𝜒2 =

2

1
𝑦𝑖 − 𝑎 − 𝑏𝑥𝑖
𝜎𝑖2

2

In this equation, 𝜎𝑖2 is the standard deviation of the data point i.
The best fit to this equation will yield parameter values for a and b that produce the
minimum possible value of 2. This is equivalent to saying that the first derivative
of 2 with respect to a and b is equal to zero:
𝜕 2
𝜕
𝜒 =
𝜕𝑎
𝜕𝑎

1
𝑦𝑖 − 𝑎 − 𝑏𝑥𝑖
𝜎𝑖2

= −2

1
𝑦𝑖 − 𝑎 − 𝑏𝑥𝑖
𝜎𝑖2

2

=0
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𝜕 2
𝜕
𝜒 =
𝜕𝑏
𝜕𝑏

1
𝑦𝑖 − 𝑎 − 𝑏𝑥𝑖
𝜎𝑖2

= −2

𝑥𝑖
𝑦𝑖 − 𝑎 − 𝑏𝑥𝑖
𝜎𝑖2

2

=0

If we rearrange these equations it is possible to solve for a and b exactly to give
values for these parameters that minimize 2. This is shown in the equations below.
𝑦𝑖
𝑥𝑖
2
2
𝜎
𝜎
𝑖
𝑖
1
𝑎=
∆
𝑥𝑖 𝑦𝑖
𝑥𝑖
𝜎𝑖2
𝜎𝑖2

𝑏=

1
∆

∆=

1
𝜎𝑖2

𝑦𝑖
𝜎𝑖2

𝑥𝑖
𝜎𝑖2

𝑥𝑖 𝑦𝑖
𝜎𝑖2

1
𝜎𝑖2

𝑥𝑖
𝜎𝑖2

𝑥𝑖
𝜎𝑖2

𝑥𝑖 𝑦𝑖
𝜎𝑖2

Weighting
This analysis presupposes that we know the standard deviation, 𝜎𝑖2 , for each data
point. In general, we will not have such information available. However, only
relative uncertainties need be known, and if we assume that all the data points
have the same inherent errors, the equations simplify to give:
1
𝑎=
∆

1
𝑏=
∆

𝑦𝑖

𝑥𝑖

𝑥𝑖 𝑦𝑖

𝑥𝑖

𝑁

𝑦𝑖

𝑥𝑖

𝑥𝑖 𝑦𝑖

𝑦𝑖

𝑥𝑖

𝑥𝑖

𝑥𝑖 𝑦𝑖

∆=
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This assumption that the errors are constant is often made, for example in the
simple linear regression calculations performed by pocket calculators. Although
often true, this assumption is not always valid. In many experiments the
uncertainty varies with the magnitude of the y value, such that the percentage
error is constant. To account for the different types of error distribution we
introduce a weighting factor, which is related to 1/𝜎𝑖2 and is used to multiply all
elements of the above matrices.

Weighting Types
The following types of error distribution are easily accounted for, and can be
selected for use in the GraFit program within the Linear Fit or Non-linear Fit item
windows.

Constant error
The standard error, 𝜎𝑖2 , is the same for each data point and therefore a
weighting factor of 1 is used (―Simple weighting‖). This type of error is often
given by instrumental variations (for example, a gauge may be read to an
accuracy of 0.1 units, etc.).

Statistical error
For statistical variation, where 𝜎𝑖2 varies in proportion to yi, the weighting factor
is 1/yi. This type of error distribution is uncommon, but is found in systems
where the main errors arise from sampling, for example counting low numbers
of radioactive disintegrations.

Proportional error
For many experiments the percentage error is constant. In this case,  is
proportional to y, leading to a weighting factor of 1/yi2. A typical example of
such errors might be when, for instance, a measuring instrument is accurate to
2% of the delivered volume, and the so error is proportional to the recorded
value.

Individually determined error
All the above cases make assumptions about the error of each measurement.
However, if sufficient replicates of each data point are available, or a complex
error function is applicable, it is possible to calculate 𝜎𝑖2 for each point and use
these values explicitly. This method can also be used if you know that certain
values are less accurate than others (for example if they were measured in a
different way) as again only relative 𝜎𝑖2 values need be given.
In practice, the use of simple weighting or proportional weighting is most often
appropriate. If the errors are small the weighting function chosen has only a small
effect on the calculated values. We will see later how it is possible to estimate
which type of error function best describes a set of data. If any data values are
close to 0, it is not appropriate to use proportional weighting, and simple weighting
should be selected.
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Non-linear Regression
For an equation that is not a linear function the determination of best-fit
parameters becomes slightly more difficult, although the principles discussed above
still apply. The difficulty arises because it is not possible to derive an exact
analytical expression for minimizing 2. It is possible, however, to take initial
estimates for the best-fit parameter values and to improve on them by a series of
iterative calculations until values are obtained that approach the minimum 2 value.
Apart from this mathematical inconvenience, non-linear regression functions in the
same way as linear regression. We still need to know the weighting that has to be
applied to the data, and the calculations still aim to minimize 2. The advantage is
that non-linear regression may be used to analyze any function that may be written
y = f(x), i.e. the y data value is dependent upon some arbitrary single-valued
function of the x data value.
GraFit performs non-linear regression using the method of Marquart79 using a
numerical second order method to calculate partial differentials. In this way it is
possible to incorporate equations of arbitrary form. For an excellent explanation of
regression analysis the reader is referred to the text by Bevington80.

Standard Errors of the Calculated Parameters
As well as giving the best-fit values for the parameters, regression analysis can
provide estimates of the standard error of each parameter. GraFit calculates these
errors by the matrix inversion method. These estimated standard errors are useful
to show how accurate the calculated parameters are. As a rough guide, the
standard error should not be greater than about 10% of the parameter value if you
are to have confidence in the calculated parameters. High standard errors will be
obtained if the data are of poor quality, or if the data do not allow accurate
estimation of one or more of the parameters.

Robust Weighting
One of the assumptions of regression analysis is that all the data points have a
normal error distribution. However, a common feature of actual experimental data
is the presence of one or two observations that are well outside the error range of
the other observations. The stray data points are usually due to mistakes by the
experimentalist (incorrect addition of reagents, inaccurate keying in of data, etc.)
and are termed outliers. If these points are included in the analysis they will
disproportionately affect the results, since the square of the residuals for these
points will dominate the fit. It is possible to edit the data manually to remove such
points, but it is preferable to eliminate them in a less subjective manner. Robust
methods achieve this by applying an additional weighting factor varying, for

79

80

Marquart, D.W. (1963) J. Soc. Ind. Appl. Math., 11, 431-41.
The Marquart method is sometimes also referred to as the Marquart-Levenburg method. It
is perhaps best explained in reference 2.
Bevington, P.R. (1969) Data Reduction and Error Analysis for the Physical Sciences.
McGraw-Hill Book Company.
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example, from 1.0 for points that have low residuals, to 0 for extreme outliers —
effectively eliminating such points.
GraFit employs optional robust weighting using the algorithm of Mosteller & Tukey 81
as implemented by Duggleby82. An additional ‗bisquare‘ weight, b, is incorporated
into the analysis, and is calculated as:
𝑏𝑖 =

1 − 𝑢𝑖2
0

2

if 𝑢𝑖 ≤ 1
if 𝑢𝑖 > 1

Here, with z being the residual weighted by the a priori weight and N the number of
observations:
𝑧𝑖
𝑢𝑖 =
6 𝑧𝑖 /𝑁
Including robust weighting will result in improved estimates for the parameters in
the presence of outliers. This is, however, gained at the expense of more
calculation, which will slow down the fitting procedure.
The effect of using robust weighting is seen in the graph below:
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The data, which contain a single outlier, have been fitted to a straight line with and
without robust weighting enabled. When robust weighting is omitted, the presence
of this outlier markedly affects the calculated results. With robust weighting
selected, however, the rogue data point is rejected, and the calculated line now
correctly follows the main trend.

81
82

Mosteller, F. & Tukey, J.W. (1977) Data Analysis and Regression. Addison-Wesley, Reading
MA, USA pp.353-65.
Duggleby, R.G. (1981) Analytical Biochemistry 110, 9-18.
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Determining the Most Appropriate Weighting
For most experimental data the error is commonly either independent of the value
of the observation (simple or constant errors) or is proportional to the y data value
(proportional errors). Simple errors may be caused by instrumental uncertainties
(for instance, a machine reading may be only accurate to  some intrinsic error,
independent of the magnitude of the reading). Providing sufficient data points have
been sampled, it is possible to determine the correct weighting by examination of
the residual error (the experimental minus the calculated value). A plot of the
residuals versus the observed value (y versus y) is diagnostic of the type of error
involved. For simple errors by definition, the residual is independent of y, as is seen
in the plot (a). If the errors are of a proportional nature the residual plot will be as
plot (c). A plot of the relative residual (y/y versus y) results in the profiles (b) and
(d) for simple and proportional errors respectively, and confirms the error
distribution.
C o ns t a n t
E rro r
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b

y

 y /y

0

y

0
P ro p o rt i o na l
E rro r

y

0

0
c
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 y /y

0

y

0

y

0

0

Plot of Residual Errors
Above is shown the type of residuals plots obtained when the error is constant or
proportional in nature. It must be stressed that visualization of clear-cut plots of
this kind depends upon having many data values to define the curves. The dotted
lines on the plots show the envelope within which all points are expected to be
found. Residuals can be calculated using options available in the data table (see
Chapter 5).
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Testing Goodness of Fit — F Test
There are situations where it is necessary to know whether a set of data is fitted
better by one particular equation or another. The F test is a statistical way of
judging the goodness of fit by two different equations. This test compares the 2
values obtained from the two fits and the degrees of freedom in each, and
calculates the probability that the fits are equally good. A low probability value
indicates that one of the two equations (that giving the lower 𝜒𝜈2 ) fits the data
significantly better. To be significant the probability should be lower than 0.1, and
preferably lower than 0.05. To perform the F test, use the column type options
available in the data table (see Chapter 5).

Nested Models
In the case where data have been fitted to two related models, where one is an
extension of the other by virtue of having one of more additional parameters, the F
statistic is calculated from the equation below.
𝜒12 − 𝜒22 / 𝜈1 − 𝜈2
𝜒22 /𝜈2

𝐹=

Comparison of Equations with Equal Numbers of Parameters
Here the F statistic is calculated from the ratio of the 𝜒𝜈2 values:
𝐹=

2
𝜒𝜈(1)
2
𝜒𝜈(2)

If the fits are equally appropriate, this ratio will be 1.0; the F test assesses the
significance of the observed differences.

Mean and Standard Deviation
For a full description of means and standard deviations, see any text on statistics
(for example, that by Bevington80). A brief description follows.
The mean value of a set of data points is defined as:
𝜇≈𝑥=

1
𝑁

𝑥𝑖

Here,  is the mean of the parent distribution, and x is the mean of our
experimental sample. The uncertainty, or standard deviation, of the data points, ,
is estimated from the data as follows:
𝜎≈𝑠=

1
𝑁−1

𝑥𝑖 − 𝑥

The uncertainty of the mean, , is given by the equation:
𝜎𝜇 =

𝜎
𝑁

≈

𝑠
𝑁
217

GraFit User’s Guide
All the above equations assume that the uncertainties of all the data points are
equal. If they are not, for reasons described earlier, we must use equations that
incorporate weighting. For example, calculation of the mean becomes:
𝜇≈𝑥=
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𝑥𝑖 /𝜎𝑖2
1/𝜎𝑖2

C H A P T E R

2 1

Worked Data Fitting
Examples

This chapter provides some further examples of data fitting to help acquaint you
with the program. The examples are presented so that they can be worked through
in a step-by-step manner. The data files that are used can be found in the
―Samples‖ sub-directory of your My GraFit Data directory. Don‘t worry if the
examples do not seem relevant to the type of data that you need to analyze — the
same principles are involved in all data fitting.
This chapter assumes that you are familiar with the basic functioning of the
program, and if not you may like to consult the earlier chapters.

Using One of the Equations Provided
We will fit the data obtained from an NMR titration curve to obtain the pKa of an
ionizable group.
Background The position of a peak in the NMR spectrum (the chemical shift position)
resulting from a magnetic nucleus that is part of a titratable group depends upon the
equilibrium between the two ionized forms. For example, in the following equilibrium:

A− + H+ ⇌ AH

Nuclei close to the ionizable group, A, will have chemical shift values that depend on the
ratio of A and AH. By definition, the acid dissociation constant, Ka is given by

𝐾𝑎 =

A− [H+ ]
[AH]

It is usually more convenient to use pKa values, where

p𝐾𝑎 = −log10 𝐾𝑎

The variation of the ratio of A and AH is given by the Henderson-Hasselbalch equation:

pH = p𝐾𝑎 + log10

[A−]
[HA−]

The chemical shift observed for the nucleus varies between that measured at the extreme
acid range, AH, and that at the extreme alkaline range, A, depending on the ratio of
[A-]/[HA].

The data obtained are chemical shift values (in units of ppm, or parts per million)
at various pH readings. These values need to be fitted to a single ionization curve
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where the start and end chemical shift values and the pKa are the unknown
parameters.

Fitting the Data
The example data are in the file ―pH Titration‖, which can be opened using the File
 Open command. Two columns are present in the data table: pH and Chemical
Shift. No other workspace items are present.

Load the Equation
The first action to take is to load the correct equation. Use the Add Stock Item
command83 on the Home tab; select the ―pH‖ tab and choose the ―pKa, Single‖
equation definition item.

Add a Non-linear Fit Item to the Workspace
Use the Add  Non-linear Fit command to add a non-linear fit item to the GraFit
workspace.

Fill out the Non-linear Fit Item Settings
Complete the Settings page as shown below:

Set up Initial Estimates
The ―pKa, Single‖ equation is one for which initial estimates for the parameter
values are difficult to provide automatically. Therefore it is necessary to enter these
initial estimates explicitly. For equations that require initial estimates it is essential

83
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to set these from the Estimatrix page. Click on the Estimatrix tab, then on the
Interactive Estimator button.

Enter values into the Estimated value grid; as you move the entry position, the
new values will be used to create a theoretical curve (red) on the plot. As described
in Chapter 20, the starting estimates for non-linear regression should be
reasonably close to the true values, but it is not necessary to be too exact. The
program then iterates to find successively better values until a satisfactory fit is
found. When you are satisfied with your estimated values, click OK to return these
as the starting estimates on the Estimatrix page.
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Fit the Data
To fit the data, choose the Fit Data command84 on the Home tab. The results are
then calculated, and can be displayed using the File  Print Preview command, or
viewed from the Results page.

Graph the Fit
To plot a graph of the fitted data, add a new graph to the workspace using the Add
 Graph command. Elect to create an X/Y Scatter Graph, then use the newlycreated non-linear fit item as the source of the data:

Show the Results on the Graph
It is often a good idea to display the data fitting results on the graph. To do this,
select the Results Listing command85 (on the Graph tab), and elect to display the
results of your non-linear fit item.

84
85

222

The Calculate  Fit Data command in legacy mode
The Draw  Results Listing command in legacy mode

Chapter 21: Worked Data Fitting Examples
The information displayed in the results listing includes the parameter values for
the fitted data, but can also show various other pieces of information about the fit.
To customize the display, double-click on the results listing once it has been
generated. The following dialog box is displayed:

The Final Result
For these data, the final result is shown below. Here, the results listing has been
added to the graph, and in addition the pKa value has been indicated visually using
the ―pKa, Single, Show pKa‖ transformation. It is clear in this instance that the
fitted curve describes the data well.
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Value

Std. Error

pKa
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Limit2

6.8001
9.6005
8.0015

0.0006
0.0003
0.0003

(To use this transformation, load it using the Add Stock Item command83, then
click on the graph and select the Add Data command86 from the Graph tab. The
data source is the Non-linear fit item, and the Transform As box should be
checked to allow the ―pKa, Single, Show pKa‖ transformation to be selected.)

Checking the Weighting
It is often useful when performing an experiment for the first time to estimate the
type of weighting that should be used. It must be stressed that for these checks to
be meaningful a large number of data points should be available, and the equation
describing the data must be well established.
As was described in Chapter 20, plots of residual error (y) versus y or y/y versus
y give characteristic patterns for the common simple and proportional error
distributions. We will produce these plots for the data that have been fitted above.

Drawing Residual Plots
We will plot the residual plot y versus y. To make this plot we need a column of
data containing the y values. This can be created after data fitting by selecting the

86
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data table, then setting the Column Type (Table tab87) of one of the columns to
Calculated Values  Difference

Select the Non-linear fit that was generated above, and click OK.
It is advisable to set the column name so that you can identify it; in the current
example it has been set to ―Differences‖
To create a graph of the residuals on a new graph page, select the Add  Graph
command, and create an X/Y Scatter Graph. Create this graph using the data table
as the source, the Chemical Shift for the x data and the Differences column for the
y data:

Elect to join the points with a straight line, as below.

87

Table  Column Type in legacy mode
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The resulting graph is shown below.
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pH
As is clear from the shape of this plot (see the discussions in Chapter 20), it was
probably correct to use simple weighting with these data.
y versus x plots are easily made by plotting pH against the Differences. To make
y/y versus y plots, it is possible to create a new column to hold the result of
dividing the Differences column by the original y data column (Chemical Shift). This
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can be created after data fitting by setting the Column Type of one of the next
available columns to Column Combinations  A/B.

Using Robust Weighting
Robust weighting is additional weighting that is applied to a data set. It acts to
reject data points that are very much in error, and so removes the occasional rogue
data point or ―outlier‖ that may be present in a data set. A complete description of
the background to robust weighting can be found in Chapter 20.
To show the detrimental effects of outliers on curve fitting, and see how robust
weighting eliminates these effects, an analysis has been created which can be
found in the file ―Robust weighting‖. The data being have a linear relationship, but
are fitted using a linear equation defined as a non-linear equation in order to make
use of the robust weighting option that is available for non-linear fitting.
Note

It is not possible to use a linear fitting item when using robust weighting.

The graph obtained by plotting the data with the best-fit lines obtained with and
without robust weighting is shown below.
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As is apparent, without robust weighting selected the presence of the outlier biases
the fit considerably. This is because the large sum-of-squares residual from this
point has a disproportionate effect on the regression analysis. However, using
robust weighting eliminates the outlier, and the regression line is drawn through
the majority of the data points.

Defining a New Equation (1)
There are very few examples found in the literature where both raw data and
calculated values are included. However, the paper by Roughton et al. (1955)88 is
notable because the raw data are presented with a set of calculated results. Also
the equation to be fitted is somewhat complex. Because of this, these data provide
a good test for a data analysis package. The Roughton paper examines the binding
of oxygen to sheep hemoglobin, as a function of the pressure of oxygen.
Hemoglobin has four non-equivalent sites, and the binding is described by the
equation:
Saturation =

𝐾1 𝑝 + 2𝐾1 𝐾2 𝑝2 + 3𝐾1 𝐾2 𝐾3 𝑝3 + 4𝐾1 𝐾2 𝐾3 𝐾4 𝑝4
× 100%
4 1 + 𝐾1 𝑝 + 𝐾1 𝐾2 𝑝2 + 𝐾1 𝐾2 𝐾3 𝑝3 + 𝐾1 𝐾2 𝐾3 𝐾4 𝑝4

In this equation, p is the pressure of oxygen, and K1 to K4 are the equilibrium
constants for the binding of four successive moles of oxygen per mole of
hemoglobin.
The data are in the file ―Hemoglobin saturation‖. Read this file in using the File 
Open command. An interesting feature of these data is that some data points were
collected with greater accuracy than others. To account for this it is necessary to
use Explicit weighting.
88
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Roughton, F.J.W., Otis, A.B. & Lyster, R.L.J. (1955) Proc. Roy. Soc. London Ser B 144,
29-54.
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Defining the Oxygen Binding Equation
To define this equation we need to create a new definition in our workspace using
the Add  Equation command. (See Chapter 9 for a complete description of
defining equations.)
Definition of the new equation requires that we make appropriate entries in this
item window.
X Variables

Symbol

Description

p

p

pO2

Parameters

Symbol

Description

K1

K1

K1 value

K2

K2

K2 value

K3
K4

K3
K4

K3 value
K4 value

Y name:

Sat

Definition:89

Sat = 100*(K1*p + 2*K1*K2*p*p + 3*K1*K2*K3*p*p*p +
4*K1*K2*K3*K4*p*p*p*p) / (4*(1 + K1*p + K1*K2*p*p
+ K1*K2*K3*p*p*p + K1*K2*K3*K4*p*p*p*p))

The appearance of the equation definition item after entering this definition, and
changing the name of the item, is shown below.

89

As this definition is for demonstration purposes only, it is defined in this way as this is the
nearest form to that of the equation given. Although the definition would function in this
form, it is rather inefficient to write it like this, and a better approach would be to enter
the mathematically simpler:
Sat = 100 * K1*p*(1 + K2*p*(2 + K3*p*(3 + K4*p*4))) /
(4*(1 + K1*p*(1 + K2*p*(1 + K3*p*(1 + K4*p)))))
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To fit these data, add a new non-linear fitting item using the Add  Non-linear fit
command, then complete the Settings page as below:

Note the use of Explicit weighting, which requires the selection of the column that
holds the error values. The results of the analysis are as follows:

230

Chapter 21: Worked Data Fitting Examples

100

%Saturation

80
60
40
20

Parameter

Value

Std. Error

K 1 value

0.0962

0.0047

K 2 value

0.1017

0.0290

K 3 value

0.3467

0.1071

K 4 value

0.9176

0.0634

0
0

10

20

30

40

50

pO2
For comparison, the results quoted by Roughton et al. are given below.
Parameter
value

Standard
Error

K1

0.0961

0.0049

K2

0.1040

0.0293

K3
K4

0.3352
0.9263

0.1018
0.0648

It should be borne in mind that Roughton et al. performed their regression analysis
without the aid of personal computers or even pocket calculators!

Defining a New Equation (2)
The hybridization of RNA and cDNA molecules is used to provide information about
the genome organization and complexity of an organism. This hybridization can be
described by the equation:
𝑑
=𝐵+
𝐷0

𝑛

𝑃𝑖 1 − 𝑒 −0.693

𝑅𝑜𝑡 𝑅𝑜𝑡 0.5

𝑖

𝑖=1

Here, d/D0 is the fractional hybridization at any given value of Rot (moles second
L-1 of nucleotides of RNA), B is a background value, Pi is the proportion of the total
cDNA hybridized to the ith component, and Rot0.5(i) is the Rot value at which 50%
of the cDNA of the ith component is hybridized. In practice, the data obtained may
be fitted assuming three binding components, giving a total of seven independent
variables. Green et al.90 have presented a sample of such data; these can be found
in the file ―DNA hybridization‖.
90

Green, S., Field, J.K., Green, C.D. & Beynon, R.J. (1982) Nucleic Acids Research 10, 14111421.
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Defining the Equation
The equation can be defined as follows:
X Variables
Rot

Symbol
Rot

Description
Rot value

Parameter
B
P1

Symbol
B
P1

Description
Background
Proportion Component 1

Rot0.5(1)
P2

R1
P2

Rot 0.5 (1)
Proportion Component 2

Rot0.5(2)

R2

Rot 0.5 (2)

P3
Rot0.5(3)

P3
R3

Proportion Component 3
Rot 0.5 (3)

Y name:

Sat

Definition:

Sat = B + P1*(1-exp(-0.693*Rot/R1))
+ P2*(1-exp(-0.693*Rot/R2))
+ P3*(1-exp(-0.693*Rot/R3))

Fitting the Equation
The following initial estimates are appropriate to analyze the data.
B
P1

0.05
0.3

Rot0.5(1)

0.2

P2
Rot0.5(2)

0.3
40.0

P3
Rot0.5(3)

0.3
600.0

It is interesting to note that when Green et al. published their results in 1982,
using an Apple II computer and employing a ―Patternsearch‖ algorithm they
reported that these data were fitted in approximately two hours of calculation.
Compare this to the amount of time taken by GraFit using a modern PC, which
should fit the data in a fraction of a second.
The calculated result is displayed below.
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Multiple Regression
Multiple regression is used when the observed data values depend on more than
one dependent (x) value. As an example of this, we will examine the data listed by
Toney & Kirsch91. These data consist of observations of the rate constant of a
reaction, k, as a function of the pKa of the group involved in the reaction and the
molecular volume of this group, Vol. The data are described by the equation:
log 𝑘 = 𝛽. 𝐾𝑎 + 𝑉.Vol + 𝑐
Here, , V and c are unknowns in the equation, which is a multiple linear equation
having two independent variables. The data presented in the paper are in the file
―Multiple linear.‖ It is possible to fit these data by defining a new specific equation.
The required definitions are as follows.
Equation Name:

Multilinear kinetics

X Variables
pKa

Symbol
pKa

Description
pKa value

Vol

Vol

Molecular volume

Parameter

V
c

Symbol
Beta
V
C

Description
Beta
V
Constant

Definition:

beta*pKa + V*Vol + C

The results obtained from fitting these data are:
Variable
91

Value

Standard Error

Toney, M.D. & Kirsch, J.F. (1989) Science 243, 1485-1488.
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0.39

0.05

V

-0.055

0.005

c

-0.7

0.5

Displaying Multidimensional Data
Displaying data sets that have more than one x axis can be difficult. One solution is
to remove all but one dimension from a plot. For example, in the above data, a plot
of (logk  V.Vol) versus pKa will result in a linear graph with a slope  and intercept
c. We can create the (logk  V.Vol) data using the data manipulation abilities of
GraFit; the result for V is obtained from the curve fitting.
The first step (assuming that the data have already been fitted) is to allow the
calculated V value to be accessed. This can be done by creating a data column that
displays the fitting results. To do this, select a blank column and choose the
Column Type  Data Fitting  Results command (Table tab92), and select the
appropriate Non-linear Fit item.
The second step is to select the next blank column and choose the Column Type 
Data Processing  Calculated Function command to set up a calculation. The
following calculated function allows the column to be filled with the (logk – V.Vol)
entries.

92
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Note the use of the Data() function to access data present in the data table. The
appearance of the data table that uses this calculated function is shown below.

The result, plotting (logk  V.Vol) versus pKa and using a transformation definition
to display the appropriate line through the data, is shown below.
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Reading Values from a Calibration Curve
A calibration curve records the variation of an observed value when an
experimental condition is altered in a defined manner. For example, an
instrumental reading may be measured for various known concentrations of a
solution. The standard curve that is produced can then be used to allow, in this
example, the concentrations present in an unknown solution to be determined by
extrapolating values from the curve.
These processes can be performed using GraFit by the following procedure.
1. Fit the data to an equation that describes the observed trend.
2. Use the Column Type  Calculated Values  x Values or Column Type 
Calculated Values  y Values commands (Table tab93) to read values from
the fitted curve.
The sample data file ―Standard curve‖ holds the analysis described below.

Choosing an Equation to Fit the Data
In many circumstances, the relationship between the x and y data values will be
well defined. In these cases, the data will be fitted by linear or non-linear
regression in the usual manner. However, some calibration data show a clear trend
of how y varies with x, but are not necessarily defined by a well-characterized
equation.
For example, the data below show the absorbance reading given by varying
concentrations of a compound, and a straight line fit to the data.
1.2

Absorbance

1
0.8
0.6
0.4
Linear Fit
0.2
0
0

20 40 60 80 100 120 140 160 180 200
Concentration

In theory, the plot of absorbance versus concentration should be linear, but the
data shown above describe a shallow curve. While it might be of interest to find out
why this effect occurs, the only important consideration here is to allow readings to
be taken from the calibration curve. Quite clearly, fitting the data to a straight line
is not suitable.
93
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1.2

1.2

1

1

Absorbance

Absorbance

Under these circumstances, the best recourse is to fit the data to an arbitrary
equation that allows a smooth curve to be drawn through the data. As there is no
theoretical basis for the equation, any calculated parameter values will have no
physical significance. The choice of equation will depend upon the shape of the
data, and it is possible that more that one equation would prove suitable. In the
case shown above it might be appropriate to use a polynomial, or any equation that
can produce a gentle curve. Below is shown the results of fitting the data to a
second order polynomial (𝑦 = 𝑎 + 𝑏𝑥 + 𝑐𝑥 2 ) using a Linear Fit item, and to a first
order rate equation by non-linear regression. The latter equation has no possible
theoretical justification, but has a suitable mathematical form to allow a smooth
curve to run through the data.

0.8
0.6
0.4
2nd order
polynomial

0.2
0

0.8
0.6
0.4

1st order
rate equation

0.2
0

0

20 40 60 80 100 120 140 160 180 200

0

Concentration

20 40 60 80 100 120 140 160 180 200
Concentration

Reading Values from the Fitted Curve
Either of the fitted curves shown above will allow the concentration values that
correspond to a series of measured absorbance values to be read from the curve.
This is performed by entering the unknown absorbance values into a data column,
then generated the calculated values in a separate column using the Column Type
 Calculated Values  x Values command (Table tab93).
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Fitting Several Data Sets with Some Parameters
Common and Some Specific
To illustrate, imagine that you have collected two linear data sets, and that you
already know that for this experiment the slope is the same for each although the
intercepts are different. Using GraFit it is possible to fit these two data sets to find
the best slope that is common to each, and the two intercept values that are
specific to the two data sets. Indeed, it is possible to fit two or more data sets to
any of the normal equations that GraFit can use and to share one or several
parameters between the data sets.
The example below shows how this is done for the paired linear data. Two raw data
sets are illustrated below (these data are in the example file ―Paired linear
regression‖). Fitting these two data sets individually results in similar, but not
identical, values for the slope. This is shown in the figure below.
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y

Fit to common slope
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y1, slope = 1.975
y2, slope = 1.975
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If the data sets are known to have the same slope, this can be incorporated into
the data fitting as follows.

Method Used to Share Variables between Data Sets
Sharing variables between data sets involves using an equation with a second
independent (x) variable, which is defined in such a way that that this value acts as
a switch to decide which parameters apply to the data value. For the simple
example described above, the independent variables are x and dataset;
parameters a1 and a2 are the two intercepts, and b is the common slope. The
equation is then defined as
If dataset=1 Then
y = a1 + b*x
Return
Endif
y = a2 + b*x
How does this work? When data from the first data set are accessed, the value of
dataset is 1 and the equation returns
a1 + b*x
When data from the second data set are accessed, the value of dataset is 2 and
the equation returns
a2 + b*x
Therefore the value of a1 is determined, in effect, from only the first set of data,
and a2 from the second. However, the slope b is applicable to all the data. The
graph below shows these data fitted to a common slope in this manner.
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y

Fit to individual slope
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y2, slope = 1.970
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The dataset setting is set using the Column Type  Data Types  y Data with
Associated Value command (Table tab93), resulting in the appearance shown
below.

It is simple to extend this approach to many data sets. The equation to find the
best slope through four data sets and a separate intercept for each is:
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If dataset=1 Then
y = a1 + b*x
Return
Endif
If dataset=2 Then
y = a2 + b*x
Return
Endif
If dataset=3 Then
y = a3 + b*x
Return
Endif
' assumes that dataset must be 4
y = a4 + b*x

Example — Paired Denaturation Curves
This technique of sharing parameters between two or more data sets is not limited
to linear equations. Any equation may be recast in this manner. For example, the
equation below describes the denaturation of a protein as a function of the
concentration of a denaturing solvent94.
𝑚 𝐷 − ∆𝐺
𝑅𝑇
𝐹 =1−
𝑚 𝐷 − ∆𝐺
1 + exp
𝑅𝑇
exp

In this equation, F is the fraction of the protein that is denatured, [D] is the
concentration of denaturant (e.g. guanidinium hydrochloride or urea), R is the gas
constant, T is the temperature, G is the stability of the protein, and m is a slope
factor. Finding the difference in stability between two proteins is often more
important than determining the absolute stability. If the proteins are highly related,
it can be assumed that the value for m is the same for each, but G differs.
Using the technique described above, it is possible to fit two data sets to a common
m value but different G values. In this case, the equation to be used can be
defined as
If dataset=1 Then
a = exp((m*D - G1)/(8.314*T))
Else
a = exp((m*D - G2)/(8.314*T))
Endif
y = (1 - a/(1 + a))
The x variable is the concentration of denaturant, D, the slope factor is m and the
two values of G are G1 and G2. The temperature is T, and should be defined as a
constant. The dataset column (x2) must hold the value 1.0 if the x and y columns
are from the first data set, and 2.0 if they are from the second. (Clearly, this can

94

Jandu, S.K., Ray, S.R., Brooks, L. & Leatherbarrow, R.J. (1990) Biochemistry 29, 62656269.
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be extended to further data sets if required.) The value a in the above definition is
a temporary value used to simplify the calculation.
The figure below shows the guanidinium hydrochloride unfolding of a native
protein, and of a mutant variant of this protein. The mutation has caused the
protein to become less stable, making it unfold at lower concentrations of
denaturant. The solid lines indicate the fitted curves, using the above equation.
The difference in stability can therefore be determined.

1.2
Native

Fraction Denatured

1.0
Mutant
0.8
0.6
0.4
0.2
0.0
0
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3
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6

[GdnHCl]

Enzyme Inhibition Samples
The final set of samples concern the analysis of enzyme inhibition data. These
sample files are relatively complex and provide the basis for your own enzyme
inhibition analyses. If you need to fit inhibition data, we recommend that you
examine the files to see how they analyses have been set up.

Competitive Inhibition Fitting
The files ―Competitive Inhibition‖ and ―Competitive Inhibition LB‖ show how it is
possible to fit data to a competitive inhibition model. They differ in that the first of
these files shows an Eadie Hofstee transformation, while the second uses a
Lineweaver Burk transformation.
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Competitive Inhibition

Raw data values
8

I= 0
6

I= 6

6

I = 10
I = 20

4

(Column 7)
(Column 8)

Rate

Rate

Rate (1)
Rate (2)
Rate (3)
Rate (4)
Rate (5)
Rate (6)
Rate (7)
Rate (8)
Rate (9)
Rate (10)
Rate (11)
Rate (12)

I= 3

4

(Column 9)
(Column 10)

2

2

(Column 11)
(Column 12)
(Column 13)

0

0
0

2

4

0

6

2

4

6

8

[Substrate]

[Substrate]

Lineweaver-Burk plot

6

0.6

1 / Rate

Rate

0.8
4

2

0.4

0.2
0
0.4 0.6 0.8

1 1.2 1.4 1.6 1.8

2 2.2 2.4 2.6

Rate / [Substrate]

0
0

0.2

0.4

0.6

0.8

1

1 / [Substrate]

Reduced Chi²: 0.0094
Parameter

Value

Std. Error

Vmax
Km
Ki

8.9147
2.4453
5.2035

0.2682
0.1720
0.2681

Contents of “Competitive Inhibition”
sample data file

Parameter

Value

Std. Error

Vmax
Km
Ki

9.0873
2.5422
1.9008

0.1213
0.0973
0.0710

Contents of “Competitive Inhibition LB”
sample data file

Production of a Dixon Plot
The sample data file, ―Dixon plot‖, analyses a set of inhibition data to a competitive
fit, then displays the data using a Dixon plot. The data file shows how it is possible
to generate complicated rearrangements of the underlying data (which is needed to
generate the Dixon plot).
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Dixon Plot
Competitive Fit
0.8
[S] =1.0000
[S] =2.0000
[S] =3.0000
[S] =4.0000
[S] =5.0000
0.6

[S] =6.0000
[S] =7.0000
[S] =8.0000
[S] =

1/Rate

[S] =
[S] =

0.4

[S] =
Data set #7
Data set #8
Data set #9
Data set #10

0.2

Data set #11
Data set #12
Data set #19
Data set #20
Data set #21
0

Data set #22
0

0.2

0.4

0.6

0.8

1

1.2

1.4

1.6

1.8

[Inhibitor]

2

Data set #23
Data set #24

Parameter

Value

Std. Error

Vmax
Km
Ki

9.0521
2.5263
1.9418

0.1317
0.1055
0.0924

Contents of “Dixon plot” sample data file

Comprehensive Inhibition Modeling
The final sample data file is the most complex that we provide. The ―Enzyme
Inhibition‖ file carries out a full analysis of four different inhibition models for the
same data set, allowing assessment of whether the data are best described by a
Competitive, a Non-competitive, a Mixed or an Uncompetitive inhibition
mechanism. The output for the sample data set used is reproduced below. For this
particular set of data it can be seen that a competitive inhibition model best fits the
data, as this produces the best fit (both by eye and by examination of the reduced
chi2 values). (The mixed type inhibition gives a similar fit quality, but the additional
parameter in this model does not significantly improve the fit. The high error value
of the additional Ki‘ value is also a good indication that the extra parameter is not
appropriate for these data.)
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Competitive model

Non-Competitive model
I=0
I=1.0
I=2.0
I=4.0
Rate (5)
Rate (6)
Rate (7)
Rate (8)
Rate (9)
Rate (10)
Rate (11)
Rate (12)

Rate

4000

2000

0
0

2

4

6000

I=0
I=1.0
I=2.0
I=4.0
Rate (5)
Rate (6)
Rate (7)
Rate (8)
Rate (9)
Rate (10)
Rate (11)
Rate (12)

4000

Rate

6000

2000

0

6

0

2

4

[Substrate]

6

[Substrate]

Reduced Chi²: 64387.8893

Reduced Chi²: 232468.9108
Parameter

Value

Std. Error

5320.8514
0.2646
0.1336

211.8898
0.0423
0.0203

Parameter
Vmax
Km
Ki

Vmax
Km
Ki

Value

Std. Error

6365.0292
0.5911
1.1252

519.7938
0.1403
0.1826

0.008

0.008

0.006

1 / Rate

1 / Rate

0.006

0.004

0.004

0.002

0.002
0
0

2

4

6

8

0

10

0

1 / [Substrate]

2

4

6

8

10

1 / [Substrate]

Mixed type model

Uncompetitive model
I=0
I=1.0
I=2.0
I=4.0
Rate (5)
Rate (6)
Rate (7)
Rate (8)
Rate (9)
Rate (10)
Rate (11)
Rate (12)

Rate

4000

2000

0
0

2

4

6000

I=0
I=1.0
I=2.0
I=4.0
Rate (5)
Rate (6)
Rate (7)
Rate (8)
Rate (9)
Rate (10)
Rate (11)
Rate (12)

4000

Rate

6000

2000

6

0

[Substrate]

0

2

4

6

[Substrate]
Reduced Chi²: 65843.5622

Reduced Chi²: 415505.5294
Parameter

Value

Std. Error

5379.6409
0.2752
0.1512
13.3794

226.6466
0.0460
0.0330
11.8828

Parameter
Vmax
Km
Ki
Ki' value

Vmax
Km
Ki

Value

Std. Error

6478.1123
0.7032
0.8107

819.7069
0.2509
0.2008

0.008

0.008

1 / Rate

1 / Rate

0.006

0.004

0.006

0.004

0.002

0.002
0
0

2

4

6

1 / [Substrate]
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0
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6

8

10

1 / [Substrate]
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2 2

Equations Provided

GraFit comes with a large number of equations provided. These equations may be
edited to see how they have been defined, and further equations can be added.
This chapter briefly describes the equations that come with the program. It does
not attempt to discuss the detailed background of each equation, as it is assumed
that the user of a specific equation will be familiar with this.
The equations and transformations that come with the program are installed into
the Group Item Store directory, and can be accessed using the Add Stock Item
command95. Equations are grouped into separate sub-directories, which appear as
different pages on the Add Item dialog box.

95

The File  Add Stock Item command in legacy mode
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Equation and transformation definitions are distinguished by the nature of their
icons. The following sections describe the contents of these various pages.

2 Substrates
The definitions on this page are designed to analyze enzyme kinetic data involving
two substrates.

Ping pong
Use this equation where a ping pong mechanism applies. The equation relating the
rate of reaction, v, to the concentration of substrates A and B and the constants KA
and KB is:
𝑣=

𝑉𝑚𝑎𝑥 𝐴 [𝐵]
𝐾𝐵 𝐴 + 𝐾𝐴 𝐵 + 𝐴 [𝐵]

Ping pong Lineweaver
Burk

[B] = 0.15
1
[B] = 0.25
0.8
[B] = 0.5
0.6

1/Rate

This transformation generates a
Lineweaver Burk plot for the fitted
data.

1.2

[B] = 2

0.4

[B] = 50

0.2
0
0

2

4

1/[A]

Ternary

[B] = 50

8

[B] = 5
6
[B] = 1

4

Rate

Use this equation where a ternary
complex is formed. The equation
relating the rate of reaction, v, to the
concentration of substrates A and B
and the constants KA, KA and KB is:

10

[B] = 0.5
[B] = 0.25

2
0

𝑉𝑚𝑎𝑥 𝐴 [𝐵]
𝑣= ′
𝐾𝐴 𝐾𝐵 + 𝐾𝐵 𝐴 + 𝐾𝐴 𝐵 + 𝐴 [𝐵]
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[A]

Ternary Lineweaver Burk

3
[B] = 0.25

[B] = 0.5
[B] = 1

2

[B] = 5

1/Rate

This transformation generates a
Lineweaver Burk plot for the fitted
data.

4

1

[B] = 50

0
0

2

4

6
1/[A]
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Enzyme Inhibition
Competitive Inhibition

𝑣=

[I] = 0

6

[I] = 1
[I] = 4

4

Rate

In this multidimensional equation,
rate is monitored versus [substrate]
and [inhibitor]. The equation for
competitive inhibition is:

8

𝑆 [𝐸0 ]𝑘𝑐𝑎𝑡
𝑆 + 𝐾𝑚 1 + 𝐼 /𝐾𝑖

[I] = 8
2

0
0

2

4

6

Competitive Eadie
Hofstee

10

10
[I] = 0

8

[I] = 1

Rate

6

Use this to display the Eadie Hofstee
plot.

8

[Substrate]

[I] = 4
[I] = 8

4
2
0
0

2

4

6

8

10

Rate/[Substrate]

Competitive Lineweaver Burk
This transformation displays the Lineweaver Burk plot.

Mixed Inhibition
In this most general inhibition equation, rate is monitored versus [substrate] and
[inhibitor], using the equation:

𝑣=
𝐾𝑚

𝑉𝑚𝑎𝑥 . [𝑆]
[𝐼]
[𝐼]
1+
+ 1 + ′ [𝑆]
𝐾𝑖
𝐾𝑖

Mixed Lineweaver Burk
This transformation displays the Lineweaver Burk plot.

Mixed Eadie Hofstee
Use this to display the Eadie Hofstee plot.
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No inhibition
This equation is the normal Michaelis Menten enzyme kinetics equation.

Non-competitive
Inhibition

𝑣=

[I] = 0

6

Rate

In this multidimensional equation,
rate is monitored versus [substrate]
and [inhibitor]. The equation for noncompetitive inhibition is:

8

4

[I] = 1

2

[I] = 4
[I] = 8

0
0

1
1 + [𝐼] 𝐾𝑖
𝐾𝑚 + [𝑆]

2

𝑉𝑚𝑎𝑥 . 𝑆 .

4

6

Non-competitive Eadie
Hofstee

10

10
[I] = 0

8

[I] = 1
6

[I] = 4
[I] = 8

4

Rate

Use this to display the Eadie Hofstee
plot.

8

[Substrate]

2
0
0

2

4

6

8

10

Rate/[Substrate]

Non-competitive Lineweaver Burk
This transformation displays the Lineweaver Burk plot.

Non-tight binding
This equation describes standard, or non-tight binding inhibition. Use in contrast to
the tight binding inhibition equations (see below).
𝑣 = 𝑣0 1 −

[𝐼]0
𝐾𝑑 + [𝐼]0

Non-tight binding (offset)
This equation describes standard, or non-tight binding inhibition. Use in contrast to
the tight binding inhibition equations.
The equation assumes that inhibition does not proceed to 100%, but that there is a
background rate that is not being inhibited. In real-world situations, this can
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happen (for example, due to residual impurities in the enzyme preparation). If the
background value is significant, take care to question whether it is real.
𝑣 = 𝑣0 − background . 1 −

[𝐼]0
+ background
𝐾𝑑 + [𝐼]0

Tight binding
This equation describes tight binding inhibition, where [I] is comparable to [E].
Note: The concentration of enzyme is treated as a parameter, rather than a
constant. This is because even in circumstances where you ―know‖ the enzyme
concentration, it is unlikely that this will be known with sufficient precision. After
fitting your data to this equation, always ensure that the fitted [E] value is
sensible; if it is not (far higher or lower than the actual [E]) then it is possible that
you need to consider an alternative inhibition mechanism.
𝑣 = 𝑣𝑜

[𝐸]0 − [𝐼]0 − 𝐾𝑑 +

[𝐸]0 − [𝐼]0 − 𝐾𝑑
2[𝐸]0

2

+ 4[𝐸]0 𝐾𝑑

Morrison, J. F. (1969) Kinetics of the reversible inhibition of enzyme-catalysed
reactions by tight-binding inhibitors. Biochim. Biophys. Acta 185, 269-286.
Cha, S. (1975) Tight binding inhibitors - I. Kinetic behavior. Biochem. Pharmacol.
24, 2177-2185.

Tight binding (offset)
This equation describes tight binding inhibition, where [I] is comparable to [E]. This
equation assumes that inhibition does not proceed to 100%, but that there is a
background rate that is not being inhibited. In real-world situations, this can
happen (for example, due to residual impurities in the enzyme preparation). If the
background value is significant, take care to question whether it is real.
See the description of the tight binding equation for more information.
𝑣 = 𝑣𝑜 − background

[𝐸]0 − [𝐼]0 − 𝐾𝑑 +

[𝐸]0 − [𝐼]0 − 𝐾𝑑
2[𝐸]0

2

+ 4[𝐸]0 𝐾𝑑

+ background

Uncompetitive Inhibition
In this multidimensional equation, rate is monitored versus [substrate] and
[inhibitor]. The equation for uncompetitive inhibition is:
𝑉𝑚𝑎𝑥
. [𝑆]
[𝐼]
1+
𝐾𝑖
𝑣=
𝐾𝑚
+ [𝑆]
[𝐼]
1+
𝐾𝑖
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Uncompetitive Lineweaver Burk
This transformation displays the Lineweaver Burk plot.

Uncompetitive Eadie Hofstee
Use this to display the Eadie Hofstee plot.

Enzyme Kinetics
Allosteric kinetics (Hill)
The Hill equation describes enzyme kinetics for an
allosteric enzyme. For equation is:
𝑉𝑚𝑎𝑥 [𝑆]𝑛
𝐾 𝑛 + [𝑆]𝑛

6
Hill Curve

Rate

𝑣=

8

The Hill coefficient, n, equals 1 if standard kinetic
behavior is followed, but differs significantly from 1 if
the enzyme kinetics are cooperative.

4
2

0
0

2

4

Allosteric kinetics (Hill), Linear plot

6

[Substrate]

This transformation is used to display the linearized Hill plot where v/(Vmax  v) is
plotted versus [S]. The slope is [S]n / Kn.

Enzyme Kinetics
This equation fits the basic Michaelis-Menten enzyme kinetics equation:
𝑣=

𝑉𝑚𝑎𝑥 [𝑆]
𝐾𝑚 + [𝑆]

In this equation, the rate, v, varies with the concentration of substrate, [S],
depending upon the maximal rate, Vmax, and the Michaelis constant, Km.

Enzyme Kinetics, Eadie
Hofstee

10
8

Eadie Hofstee Plot

This transformation draws the linear
Eadie-Hofstee plot for fitted enzyme
kinetic data.

Rate

6
4
2
0
0

2

4

Rate/[Substrate]
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Enzyme Kinetics,
Lineweaver Burk

Lineweaver Burk Plot
1

1/Rate

This transformation draws the linear
Lineweaver Burk plot for fitted
enzyme kinetic data.

1.5

0.5

0
0

2

4

6

1/[Substrate]

Enzyme Kinetics, show Km

when using this transformation.

Enzyme Kinetics, show Vmax

6

Rate

This transformation displays the Michaelis constant,
Km. For best results set the curve resolution to High

8

Kinetic Curve
4

Show Vmax
Show Km

2

Show Vmax/Km

0

Displays the limiting rate, Vmax (= kcat[E0]).

0

2

4

6

8

10

[Substrate]

Enzyme Kinetics, show Vmax over Km
This transformation displays the linear portion at the beginning of the graph where
[Substrate] << Km.

Kinetics, contaminating S
Occasionally the reagents etc. used in an enzyme assay will contain traces of
contaminating substrate. Therefore the rate will vary with added substrate, Sadd as:
𝑣=

𝑉𝑚𝑎𝑥 𝑆𝑎𝑑𝑑 + 𝑆𝑐𝑜𝑛
𝐾𝑚 + 𝑆𝑎𝑑𝑑 + 𝑆𝑐𝑜𝑛

In this equation, [Scon] is the concentration of contaminating substrate.

Exponential
This page contains equations for calculating the rate constants of various
exponential decay processes.
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Double Exponential

10
8
6

Amount

If two decay processes occur
simultaneously the observed values
decay with time following the double
exponential decay equation:

2

𝑦 = 𝐴0(1) . 𝑒 −𝑘 1 𝑡 + 𝐴0(2) . 𝑒 −𝑘 2 𝑡
Here, the two processes
separate A0 and k values.

Single Decay

4

0
0

have

1

2

3

4

5

Time

Double Exponential - phase 1
This displays the first of the two phases in isolation.

Double Exponential - phase 2
This displays the second of the two phases in isolation.

Double Exponential with offset
This equation is used when a double exponential process decays to a non-zero limit
value.

Single Exponential

𝑦 = 𝐴0 . 𝑒 −𝑘 1 𝑡

8
6

Amount

The equation for a single exponential
decay is:

10

The observed values decay with time,
t, from an initial value, A0, at t = 0,
to 0 at t = . The rate constant for
the decay is k. (The half-life for the
process, T½, is given by loge2/k.) To

Double Decay

4
2
0
0

1

2

3

4

5

Time

display a linearized plot of this equation, set the y axis to have a logarithmic scale.

Single Exponential with offset
If the observed values do not decay to 0, but to some defined offset or background
value the equation for a single exponential process is
𝑦 = 𝐴0 . 𝑒 −𝑘 1 𝑡 + offset
In this equation, ‗offset‘ is the limit of the decay.

Triple Exponential
For a triple exponential decay process the equation is:
𝑦 = 𝐴0(1) . 𝑒 −𝑘 1 𝑡 + 𝐴0(2) . 𝑒 −𝑘 2 𝑡 + 𝐴0(3) . 𝑒 −𝑘 3 𝑡
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Triple Exponential with offset
This equation is used when a triple exponential process decays to a non-zero limit
value.

IC 50
These equations are used for analyzing radio-immuno assays or Dose-response
curves.

IC50 0-100%
This equation fits inhibition data to a 2-parameter equation, where the lower data
limit is 0, and the upper data limit is 100, i.e. the data are both background and
range corrected.
𝑦=

100%
𝑥
1+
𝐼𝐶50

𝑠

In this equation, s is a slope factor. The equation assumes that y falls with
increasing x.

IC50 0-100% - show IC50
This transformation displays the IC50 value on the plot. For best results set the
curve resolution to High when using this transformation.

IC50 background corrected
This equation fits inhibition data to a 3-parameter equation, where the lower data
limit is 0, i.e. the data are background corrected.
𝑦=

Range
𝑥
1+
𝐼𝐶50

𝑠

In this equation, s is a slope factor. The equation assumes that y falls with
increasing x.

IC50 background corrected - show IC50
This transformation displays the IC50 value on the plot. For best results set the
curve resolution to High when using this transformation.

IC50 background corrected - show limit
This transformation displays the limit value on the plot.
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IC50 full 4 param

𝑦=

Range
𝑥
1+
𝐼𝐶50

𝑠

80

Response

Fits data to a full 4-parameter
equation, which is usually the best
way to fit results from RIA analysis
or inhibition data (see Halfman,
198196). The binding or inhibition is
then characterized in terms of an
IC50 value:

100
IC50 Curve
Limit

60

Background
40
20
0
10-8

10-7

10-6

10-5

10-4

Dose

+ background

Here Range is the maximum y range, and s is a slope factor. The x axis represents
the concentration of analyte. Data fitted to this equation are usually displayed with
a logarithmically scaled x axis. For convenience, the equation as defined attempts
to provide initial estimates for the parameter values.
Note

Estimating starting values is difficult when there are 4 unknown
parameters. The method used within this definition works most of the time,
but can give occasional poor fits. Under such circumstances, enter initial
estimates explicitly in the non-linear fit window.

The curve displays inhibition with increasing dose. It is also possible to use the
same equation for increasing response with dose. In this case, the y range is a
negative value, and the ―Background‖ is the maximum response.

IC50 full 4 param - show background
This transformation displays the calculated background value.

IC50 full 4 param - show IC50
This transformation displays the calculated background value.

IC50 full 4 param - show limit
This transformation displays the limiting value of the data.

Ligand Binding
This page contains various equations describing the binding of ligands to surfaces,
receptors, enzymes etc.

96
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1 Site

10

𝑦=

𝐿 . 𝐶𝑎𝑝
𝐾𝑑 + [𝐿]

8
6

Bound

This is the simplest form of binding
equation. The equation is

Binding Curve

4

Show Capacity
2

Show Kd

Here, y is either the amount bound
0
2
4
6
8
10
or is some factor proportional to it
Free
(e.g. radioactivity, absorbance etc.),
or the number of moles bound per
mole of receptor. The capacity for binding ligand, Cap, is either an amount bound
in terms of moles of ligand, or a stoichiometric quantity in terms of moles of ligand
per mole receptor depending upon the definition of y. The dissociation constant of
ligand from the receptor is Kd. The concentration of free ligand, [L], is the x data
0

axis.

1 Site – Scatchard Plot

values calculated by fitting to a
single-site binding curve, and draws
the line for the Scatchard plot. Use
this display curve with the Scatchard
data transformation.

8
Scatchard Plot

Bound/Free

The Scatchard plot is the usual way
to linearize binding data. This display
equation takes the Cap and Kd

10

6
4
2
0
0

2

4

6

8

10

Bound

1 Site – Show Capacity
This transformation shows the capacity on the plot.

1 Site – Show Kd (1 site)
This transformation shows the dissociation constant, Kd. For best results set the
curve resolution to High when using this transformation.

1 Site (with background)

6
Binding Curve
Show Capacity

Bound

Often binding experiments have an
inherent background y value. This
value can usually be determined
separately by control experiments.
However, such controls sometimes do
not accurately reflect the real
experiment, and it can be preferable
to treat this background as a
separate parameter to be obtained
from the data fitting. The equation is:

8

4

Show Kd
Show Background

2

0
0

2

4

6

8

10

Free
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𝑦=

𝐿 . 𝐶𝑎𝑝
+ background
𝐾𝑑 + [𝐿]

Here, the parameters are the same as for the single site ligand binding except for
the inclusion of a background or offset value.

1 Site (with background) - Scatchard
Use this transformation to display Scatchard plots for binding data containing a
background value.

1 Site (with background) - Show background
This transformation shows the background value.

1 Site (with background) - Show Capacity
This transformation shows the capacity.

1 Site (with background) - Show Kd
This transformation shows the dissociation constant, Kd. For best results set the
curve resolution to High when using this transformation.

2 Site

4

Bound

Often there is more than one type of
site involved in binding the ligand.
This equation describes the case of
two sites characterized by individual
Kd and Capacity values. The equation
is:

6

Ligand Binding, 2 Sites

2

0
0

2

4

𝐿 . 𝐶𝑎𝑝(1)
𝐿 . 𝐶𝑎𝑝(2)
𝑦=
+
𝐾𝑑 (1) + [𝐿] 𝐾𝑑 (2) + [𝐿]

6

8

10

Free

2 Site - Show Capacity (total)
This transformation shows the total binding capacity for ligand.

2 Site - Show Capacity 1
This transformation shows the capacity of the first binding site.

2 Site - Show Curve 1
This transformation shows the binding curve for the first binding site in isolation.

2 Site - Show Curve 2
This transformation shows the binding curve for the second binding site in isolation.
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2 Site (with background)
This equation describes the situation where two independent binding sites are
present, but the y value at zero ligand concentration is not zero. The equation for
this is:
𝑦=

𝐿 . 𝐶𝑎𝑝(1)
𝐿 . 𝐶𝑎𝑝(2)
+
+ background
𝐾𝑑 (1) + [𝐿] 𝐾𝑑 (2) + [𝐿]

2 Site (with background) - Show background
This transformation shows the background binding.

2 Site (with background) - Show Capacity 1
This transformation shows the capacity of the first binding site. This value is on top
of the background.

2 Site (with background) - Show Capacity (total)
This transformation shows the total binding capacity for ligand, on top of the
background value.

2 Site (with background) - Show Curve 1
This transformation shows the binding curve for the first binding site in isolation.

2 Site (with background) - Show Curve 2
This transformation shows the binding curve for the second binding site in isolation.

Adair (2 sites)
The Adair equation describes the binding of ligands to multiple sites on a receptor
when the dissociation constants for binding of successive ligands are to be
individually defined from the data. The equation for n sites is:
𝐵=

𝐶𝑎𝑝. 𝐿 𝐾𝑑1 + 2𝐿2 𝐾𝑑1 𝐾𝑑2 + ⋯ + 𝑛 𝐿𝑛 𝐾𝑑1 𝐾𝑑2 … 𝐾𝑑𝑛
𝑛. 1 + 𝐿 𝐾𝑑1 + 𝐿2 𝐾𝑑1 𝐾𝑑2 + ⋯ + 𝐿𝑛 𝐾𝑑1 𝐾𝑑2 … 𝐾𝑑𝑛

In this equation, B is the amount bound, L the concentration of free ligand, Cap the
maximum capacity of the system to bind ligand, and Kd1, Kd2 etc. the successive
dissociation constants for ligand.

Adair (3 sites)
Use this equation for 3 binding sites.

Adair (4 sites)
Use this equation for 4 binding sites.
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Bound vs Total

10
8

Bound

The previous equations require the
6
unbound ligand concentration to be
4
Binding Curve
known. However, although the total
Tight-binding limit
ligand concentration is always known
2
(this is what you have added), the
0
proportion bound and free is not
0
10
20
30
40
50
always certain. This is particularly
Total
the case if the y axis is an
observation that is not directly
related to the bound concentration, for example fluorescence intensity or
absorbance. Here the equation relates the y axis to the total ligand added, t.
𝑦=−

− 𝐾𝑑 + 𝑡 + 𝐶𝑎𝑝 +

𝐾𝑑 + 𝑡 + 𝐶𝑎𝑝
2

2

− 4. 𝑡. 𝐶𝑎𝑝

Bound vs Total - tight binding limit
This transformation shows the maximum possible amount bound (or change in
absorbance etc.) for a given total amount of ligand added if the binding were
infinitely tight.

Cooperative
A generalized equation describing cooperative binding (or multiple binding sites of
differing affinities) is:
𝑦=

[𝐿]𝑛 . 𝐶𝑎𝑝
𝐾 𝑛 + [𝐿]𝑛

Here, n is a measure of the cooperativity. For normal binding to a single site, n
should not differ significantly from 1.0.

Cooperative (with background)
This is the same as the equation above, but includes an unknown background level
in the y axis observations, i.e.
𝑦=

[𝐿]𝑛 . 𝐶𝑎𝑝
+ background
𝐾 𝑛 + [𝐿]𝑛

pH
These equations are used when the observed value varies with pH. They usually
involve the determination of one or more pKa values from the experimental data.
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pKa, (min = 0)
This equation is used when the
observed parameter varies with pH
from 0 at low pH to a limiting value at
high pH. Examples include various
enzymatic activities. The equation is:
𝑦=

10
8
6
Y
pKa, min = 0

4

Show pKa
2

Show Limit

0

𝐿𝑖𝑚𝑖𝑡. 10(p𝐻−p𝐾𝑎 )
10(p𝐻−p𝐾𝑎 ) + 1

5

6

7

8

9

10

pH

pKa, (min = 0), Linearized Plot
This transformation displays the line for the linearized titration curve. The
linearized equation is:
𝑦=−

𝐾𝑎 . 𝑦
+

[H ]

+ Limit

pKa, (min = 0), Show Limit
This transformation displays the limit value of the y axis at high pH.

pKa, (min = 0), Show pKa
This transformation is used to represent the position of the pKa on the curve where
there is a single ionization and the starting value is 0. For best results set the curve
resolution to High.

pKa, (min = 0), High to Low
This equation is used when the
observed parameter varies with pH
from a limiting value at low pH to 0 at
high pH.

8
pKa, min=0
6
Y

Show Limit
Show pKa

4
2

0
5

6

7

8

9

10

pH

pKa, (min = 0), High to Low, Show Limit
This transformation displays the limit value of the y axis at low pH.

pKa, (min = 0), High to Low, Show pKa
This transformation is used to represent the position of the pKa on the above curve.
For best results set the curve resolution to High.
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pKa, Double

Limit 1

This equation is used when the
observed parameter varies from one
value at low pH to another at high pH,
with the variation depending upon the
ionization of two groups. The pKa

6
Y

𝐿𝑖𝑚𝑖𝑡2 − 𝐿𝑖𝑚𝑖𝑡1 . 10
10

p𝐻−p𝐾𝑎

1

p𝐻−p𝐾𝑎

+1

Limit 2
Limit 3

4

2

values of these groups determine the
shape of the curve.
𝑦 = 𝐿𝑖𝑚𝑖𝑡1 +

Double pKa

8

0
3

4

5

6

7

8

9

10

11

12

pH

1

+

𝐿𝑖𝑚𝑖𝑡3 − 𝐿𝑖𝑚𝑖𝑡2 . 10
10

p𝐻−p𝐾𝑎

2

p𝐻−p𝐾𝑎

2

+1

pKa, Double, Show Curve 1
This transformation shows the first of the two ionization curves in isolation.

pKa, Double, Show Curve 2
This transformation shows the second of the two ionization curves in isolation.

pKa, Double, Show Limit 1
This transformation displays the lower limit of the double curve.

pKa, Double, Show Limit 2
This transformation displays the middle limit of the double curve.

pKa, Double, Show Limit 3
This transformation displays the upper limit of the double curve.

pKa, Double Bell
Sometimes two ionizations determine
the value of the observed parameter.
If the first ionization results in
increasing activity and the second
destroys activity this results in a bellshaped curve. The equation assumes
that activity is zero at low and high
pH.

10
8

Bell Curve
1st Curve

6

2nd Curve

Y
4
2
0
4

5

6

7

8

9

pH

pKa, Double Bell, Curve 1
This transformation is used to display the effect of the first ionization in the bellshaped curve.

262

Chapter 22: Equations Provided

pKa, Double Bell, Curve 2
This transformation is used to display the effect of the second ionization in the bellshaped curve.

pKa, Double Bell, Limit
This transformation shows the upper limit of the bell-shaped activity profile.

pKa, Single

8
Single pKa

This equation is used when the
observed parameter varies from one
value at low pH to another at high pH,
with the variation depending upon the
ionization of a group. The pKa value of

6
Y

𝐿𝑖𝑚𝑖𝑡2 − 𝐿𝑖𝑚𝑖𝑡1 . 10
10

p𝐻−p𝐾𝑎

1

p𝐻−p𝐾𝑎

Show Limit1
4

Show Limit2

2

this group determines the inflection
point of the curve. The equation is:
𝑦 = 𝐿𝑖𝑚𝑖𝑡1 +

Show pKa

0
5

6

7

8

9

10

pH

1

+1

In this equation, Limit1 and Limit2 are the limits of the titration curve at low and
high pH.

pKa, Single, Linearized plot
This transformation displays the line for the linearized titration curve.

pKa, Single, Show Limit 1
This transformation displays the limiting y value at one extreme of pH.

pKa, Single, Show Limit 2
This transformation displays the limiting y value at the other extreme of pH.

pKa, Single, Show pKa
This transformation is used to represent the position of the pKa on the general
ionization curve. For best results set the curve resolution to High.

Rate
This set of equations fits data describing a first order rate equation.
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1st order

10

𝐴𝑡 = 𝐴∞ 1 − 𝑒

−𝑘𝑡

8
6

Amount

The equation for a process where the
observed value increases with time
is:

Here, At is the amount of A at time t,
A is the maximum amount of A

Rate Curve
4

Show Limit
Initial Rate

2
0
0

2

4

6

8

10

Time

formed, and k is the rate constant
that describes the process.

1st order, decay curve

10
Display Decay Curve

1

Amount

This transformation converts the
data into an exponential decay
curve. To linearize the curve, display
the y axis with a logarithmic scale.

0.1
0

1st order, show limit
This transformation
limiting value, A.

displays

2

4

6

8

10

Time

the

1st order, show initial
The initial part of the full curve (approximately the first 10%) is linear, with the
slope being k.A. This transformation shows the initial linear portion.

1st order (offset)

𝐴𝑡 = 𝐴∞ 1 − 𝑒 −𝑘𝑡 + offset

8
6

Amount

If the observed y value has a
background or offset at time t=0
(due to experimental constraints, for
example a starting absorbance may
not be zero) the equation becomes:

10

Rate Curve + Background
Limit

4

Background
2
0
0

2

4

6

8

10

Time

1st order (offset), decay curve
This transformation plots the rate equation as an exponential decay. Use it with
‗Decay Curve (+Offset)‘ transformed data.

1st order (offset), show limit
This transformation displays the limiting value for the equation containing an offset.
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1st order (offset), show offset
Use this transformation to show the offset value.

1st order rate versus [S]

10

𝐴𝑡 = 𝐴∞ 1 − exp −

8

[S] = 5
1
0.5
0.25

6

Amount

To find enzyme kinetics parameters,
it is often necessary to carry out a
series of first order rate reactions at
different substrate concentrations.
The rate constant versus [S] is then
analyzed using the Michaelis Menten
equation. Using this 3D equation
allows these procedures to be
combined, giving:

4
0.1
2
0
0

2

4

6

Time

𝑉𝑚𝑎𝑥 . [𝑆]
.𝑡
𝐾𝑚 + [𝑆]

1st order rate versus [S] (offset)
This equation is the same as that above, but also includes an unknown background
value:
𝐴𝑡 = 𝐴∞ 1 − exp −

𝑉𝑚𝑎𝑥 . [𝑆]
.𝑡
𝐾𝑚 + [𝑆]

+ background
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2 3

Standard Templates

Data fitting templates provide a quick way of analyzing data and plotting graphs. In
general, you are recommended to construct your own specific templates that are
best suited to the data you wish to analyze. However, GraFit comes with a few
standard templates that can be used for common data fitting situations.

About the Standard Templates
All the standard data fitting templates are defined so that as the data values are
entered, the results are calculated and data plotted in the background.

Accessing Templates
To access one of the data fitting templates, select the File  New command.
Choose the template from the list shown.
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Template Layout
All the standard templates are formatted so that the data are entered into a data
table that is on the left of the screen, and the fitted data and results are updated in
the graph on the right. This graph is plotted as the data are being typed into the
program.

Screen Size
To ensure compatibility with the majority of systems, the standard templates are
formatted so that they display correctly when GraFit is run as a maximized window
at a screen resolution of 1024  768.

Using Your Own Templates
In general, we recommend that you build your own templates for common data
fitting situations. The advantages of building your own templates are summarized
as follows:

268



Specific data analyses can be created.



Graphs can incorporate user-specific features such as corporate logos or the
name of the user.

Chapter 23: Standard Templates



Graphs can be customized to use specific fonts and/or styles. Users with color
printers may wish to incorporate color into their graphs; those with
monochrome printers will probably wish to create graphs in black and white.



Users with high-resolution displays can make best use of the available screen
resolution when laying out the various windows.

See Chapter 4 for more information about working with template files.

Description of the Standard Templates
The standard templates generally come in three related versions:



General Tab. These analyses are appropriate for a single set of x / y data



Multiple Tab. These analyses allow a number of data sets (typically up to 8) to
be analyzed together and comparison plots made.



Replicates Tab. These analyses are used where there are replicate data sets
(up to 8 replicates for each data point). The data are fitted to the mean of the
replicates, with error bars drawn to illustrate the spread of the data.

The descriptions that follow apply to the General case only, but can be
extrapolated to the Multiple and Replicates cases. The files themselves contain
instructions on how to use them and should be consulted for more specific
information.

Enzyme Kinetics
This template analyzes enzyme kinetic data to the basic Michaelis-Menten enzyme
kinetics equation:
𝑣=

𝑉𝑚𝑎𝑥 [𝑆]
𝐾𝑚 + [𝑆]

A graph is made of the fitted data together with an inset Lineweaver Burk plot, as
shown below.
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Enzyme Kinetics Data

4

0.3

1 / Rate

Rate

6

2

0.2
0.1
0
0

0.2 0.4 0.6 0.8

1

1 / [Substrate]

0
0

2

4

6

8

[Substrate]

Parameter

Value

Std. Error

Vmax
Km

8.2186
1.9235

0.2298
0.1621

IC 50
This fits data to a full 4-parameter equation. The binding or inhibition is then
characterized in terms of an IC50 value using the following equation:
𝑦=

Range
𝑥
1+
𝐼𝐶50

𝑠

+ background

A graph is made of the fitted data, as shown below.
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IC50 Data

100

Response

80

60

40

20
10-9

10-8

10-7

10-6

10-5

[Inhibitor]

Parameter
Y Range
IC 50
Slope factor
Background

Value

Std. Error

75.0926
1.47142e-007
0.7194
26.0055

6.9937
3.99433e-008
0.1517
4.5106

Ligand Binding
This template analyzes ligand binding data to single-site saturation equation:
𝑦=

𝐿 . 𝐶𝑎𝑝
𝐾𝑑 + [𝐿]

A graph is made of the fitted data together with an inset Scatchard plot, as shown
below.
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Single-site Ligand Binding
12
10

0.4

6
[Bound] / [Free]

[Bound]

8

4

0.2

2

0
0

2

4

6
8
[Bound]

10 12

0
0

20

40

60

80

[Free]

Parameter
Capacity
Kd value

Value

Std. Error

17.3459
29.7734

0.6126
2.5451

Linear Regression
This template allows data to be fitted using linear regression, and the results
plotted.
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Linear Regression
y = 3.4167 + 0.3833.x

8

y

6

4

2
0

2

4

6

8

10

x
Correlation coefficient: 0.7936
Parameter

Value

Std. Error

a (intercept)
b (gradient)

3.4167
0.3833

0.6251
0.1111
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Exponential
This template fits data to a single exponential decay function, using the following
equation:
𝑦 = 𝐴0 . 𝑒 −𝑘𝑡
A graph is created showing the fit.

Exponential Decay
140
120

y

100
80
60
40
20

0

2

4

6

x
Parameter
Initial value
Rate constant

Value

Std. Error

130.1490
0.3799

1.2017
0.0066

Exponential Offset
This template fits data to a single exponential decay function that goes to a
background, non-zero value, using the following equation:
𝑦 = 𝐴0 . 𝑒 −𝑘𝑡 + background
A graph is created showing the fit.
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Exponential Decay with Offset
140
120

y

100
80
60
40
20

0

2

4

6

x
Parameter
Initial value
Rate constant
Offset

Value

Std. Error

128.1367
0.3947
2.3126

3.3007
0.0243
3.4885

Exponential Decay Various Models
This template fits a single data set to a variety of exponential decay models:



Single Exponential



Single Exponential with Offset



Double Exponential



Double Exponential with Offset

By comparing the fits obtained using the various models, it is possible to assess
whether the data justify fitting to models that are more complex than a simple
single exponential.
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Exponential Decay, various models
100
y
Single

80

Single + offset
Double
Double + offset

y

60

40

20

0

2

4

6

8

10

x

Ligand Binding Various Models
This template fits a single data set to a variety of Ligand binding models:



Single Site



Single Site with Background



Two Sites

By comparing the fits obtained using the various models, it is possible to assess
whether the data justify fitting to models that are more complex than a simple
single site model.
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Ligand Binding, Various Models
10
[Bound]
Single

8

[Bound]

Single + back
Double

6

4

2

0
0

2

4

6
[Free]

8

10

12
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A P P E N D I X

1

Hard-coded Equations

Overview of Hard-coded Equations
Hard-coded equation definitions use specialized pre-compiled equation libraries to
increase data fitting speed and/or provide greater flexibility in generating initial
estimates. The GraFit program provides the capability to use hard-coded equations,
though none are supplied as standard. At present some equipment manufacturers
use these to allow GraFit to fit very large quantities of data more quickly than
would be possible with the standard equation definition items. Hard-coded equation
items simply substitute for the normal equation definitions when fitting data by
non-linear regression (see Chapter 9). It should be stressed, however, that for the
vast majority of applications the normal user-defined equation definition is quite
sufficient.

What are Hard-coded Equations?
Hard-coded equations are pre-compiled code library files and have a .GFL file
extension. They are normally supplied for specialist applications; it is not possible
to generate them yourself. If you believe that you have an application that might
benefit from use of a hard-coded equation library, please contact Erithacus
Software technical support for further information.

Advantages


Pre-compiled code results in faster analysis.



The partial derivative calculations that are intrinsic to non-linear regression
analysis can be performed explicitly rather than by numerical approximation,
resulting in greater speed and better precision.

Disadvantages


The definitions cannot be modified.



It is not possible to write your own hard-coded equations.
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Enabling Hard-coded Equations
The menu commands to insert hard-coded equations are not present by default,
and must be explicitly enabled. The Options command97 on the View tab, Options
page controls this; to use hard-coded equations ensure that the Enable hardcoded equation definitions box is checked.

Inserting a Hard-coded Equation Item
Hard-coded equation items are added using the Add  Hard-coded Equation
command. The hard-coded equation window itself contains several panes that are
used to define the equation. Each of the panes in this item window is discussed
below.

97
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The View  Options command in legacy mode

Appendix 1: Hard-coded Equations

General Pane
The General pane is used to define the location of the hard-coded equation library
file, and shows a description of the equation as provided by the library supplier.

The General pane of
the Hard-coded
Equation item

Locating the Equation Library File
Click the browse button to locate the equation definition library file. Once loaded,
the full path of this file is shown, and a description of the equation is displayed.

X Variables Pane
The X Variables pane is used to show the names and number of the independent
(x) variables that are used in the equation. These names are pre-defined by the
equation library vendor, and cannot be edited.
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The X Variables pane
of the Hard-coded
Equation item

Parameters Pane
The Parameters pane is used to show the parameters in the equation definition.
These names are pre-defined by the equation library vendor, and cannot be edited.

The Parameters pane
of the Hard-coded
Equation item
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Appendix 1: Hard-coded Equations

Constants Pane
The Constants pane is used to define constants in the equation definition.
Constants are used to allow the entry of a value into an equation definition that is
fixed in any single experiment, but varies from experiment to experiment. The
presence of constants is optional, but when present an equation definition can
include any number of constants. When constants are included in an equation used
for non-linear regression, their values are entered into the non-linear fit item
window as described in Chapter 6.

The Constants pane
of the Hard-coded
Equation item
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GraFit Symbols Font

GraFit Symbols Font
GraFit is supplied with a font that can be used to represent the various graph
drawing symbols used by the program. This can be useful when annotating graphs,
for example, when labeling axes. The font is called GraFit Symbols and can be
used just like any other Windows font.
The various symbols are associated with the characters as shown in the following
table.
A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

               
a

b

c

d

e

f

g

h

i

j

k

l

m

n

o

p

               
S

T

U

V

W

X

Y

Z

1

2

3

4

5

         

Note





The GraFit symbols font does not contain any hinting information to assist
reproduction on low-resolution displays. For this reason, it will not display
well on screen, although it will print correctly.
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Index

Non-linear Fit command, 73, 220,
230
Notepad command, 115
Transformation command, 109

.
.BMP file, 137
.CSV file, 52
.DIF file, 52

Add Stock Item command, 30, 35, 220,
224

.EMF file, 137

Adobe Acrobat, 18

.GFC file, 35

Align command, 129

.GFF file, 33

Allosteric Data, 228

.GFL file, 279

Allosteric Kinetics, 252

.GFR file, 35

Arithmetic operators, 101

.TIF file, 137

Arrows, 135

.TXT file, 52

ASCII format, 52

.WMF file, 137

Axis break symbol, 178

_
_grnd_ function, 69, 103
_rnd_ function, 68, 103

A

Axis manager, 172, 174, 175
Axis offset, 151
Axis scaling, 177

B
Bar charts, 120, 181

Activation
Software, 18

Bezier curves, 147

Adair Equation, 259

Bring to Front command, 129

Add command, 27
Add Data command, 169, 224
Add Data Table command, 39
Add menu, 27
Equation command, 93, 229
Graph command, 117, 123, 222, 225
Hard-coded Equation command, 280
Linear Fit command, 87

Bitmap file, 137

C
Calculate menu
Fit Data command, 87, 222
Calculated values, 63
Calibration Curve, 236
Changing Computers, 21
Chart Wizard, 181
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Chi2, 80

Comment statements, 104

Chi-squared, 209, 211

Competitive Inhibition, 242, 244

Clear command, 27, 47, 48

Compile command, 93, 109

Clipboard
Windows, 195, 196, 197

Constants, 77, 98, 144, 168, 283

Clipboard, 193, 194

Cooperative binding, 260

Column
Combinations, 56

Copy command, 45, 46, 194, 197

Column charts, 117, 119, 181
Column Combinations, 56
Column constant, 68
Column Format command, 49
Column type, 52
A - B, 53, 56
A . B, 57
A / B, 56, 227
A + B, 56
Calculated Function, 67, 234
Column Summary, 58
Constants Entry, 63
Derivative, 70
Difference, 67, 225
F Test, 58
General, 54
Information, 62
Mean, 57
No. Data Points, 57
Parameter Entry, 62
Results, 61, 234
Series, 70
Smooth, 71
Standard Deviation, 57
Standard Error of the Mean, 57
Subset, 71
x Data, 54
x Values, 64, 236, 237
x(n) Data, 54
y Data, 55
y Data with Associated Value, 55,
240
y Values, 66, 236
Column Width command, 40
Columns
Copying and pasting, 45
Deleting, 48
Selecting, 45
288

Context Help, 31

Copy To command, 51
CSV format, 52
Cursor shapes, 40, 128
Customize button, 24
Customizing Menus and Toolbars, 25
Cut and paste, 193

D
Data
Association, 176
Copying, 45
Deleting, 47
Export, 51
Fitting several data sets
simultaneously, 238
Import, 51
Import / Export, 51
Inserting values, 48
Layout, 75, 88
Missing, 41
Numbers, 41
Overlaying, 171
Pasting, 45
Rescaling, 67
Selecting, 44
Smoothing, 71
Sorting, 49
Text, 41
Types, 41
Data entry position, 39, 40, 43, 45, 51,
53, 79
Data Filters, 35
Data fitting
Basics, 199
Multiple Non-linear Regression, 206
Data function, 68

Index
Data table
Appearance, 49
Locking columns, 72

Embedding objects, 193
Enhanced metafile, 137

Deactivation
Software, 20

Enzyme inhibition
Competitive, 249
Mixed, 249
Non-competitive, 250, 251

Degrees of freedom, 209

Enzyme Inhibition, 242

Delete command, 48

Enzyme kinetics, 252, 269
Ping Pong, 248
Ternary Complex, 248

Data table item, 39

Denaturation Curves, 241
Derivative, 70
DIF format, 52
Difference calculation, 53
Directories, 34, 36
Dixon Plot, 243
Dose-response Curves, 255
Double exponential decay, 254
Drag and drop, 26
Draw menu
Results Listing command, 82, 91, 222
Drawing Objects, 124

E
Edit Current Cell command, 40
Edit menu
Clear command, 27, 47
Copy command, 45, 194, 195, 197
Copy To command, 51
Edit Current Cell command, 40
Hide Object command, 149, 176
Insert New Object command, 197
Insert Object command, 196
Paste command, 45, 194, 195, 196,
197
Paste From command, 35, 51
Paste Link command, 195
Paste Special command, 196, 197
Properties command, 130, 147, 176
Rename command, 28
Reset Original Size, 197
Select All command, 197

Equation definition, 93, 99, 100
Equation definition syntax, 96
Equation menu
Compile command, 93, 107
Equations, 247
Compiling, 107
Defining, 228
Error Messages, 107
Functions, 102
Multi-line Definitions, 103
Multiple Regression, 206
Temporary variables, 103
Erithacus Software
Contacting, 14
Error bars, 164
Error Message, 113
Error Messages, 107, 113
Errors, 203, 209, 210, 211, 212, 214
Estimates
Interactive, 78
Estimatrix, 66, 77, 78, 79, 221
Evaluation Mode, 19
Exponential decay, 254, 274
Exponential decay with Offset, 274
Export Graph command, 137

F
F test, 58, 217
Nested models, 217

Editing item names, 28

Field Codes, 131

Embedded object, 28

File
.GFF, 33
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File menu, 26
Add Stock Item command, 30, 35,
220, 247
Close command, 35
Export Graph command, 137
Import Data command, 35, 51
New command, 30, 36, 37, 267
Open command, 33, 220, 228
Page Setup command, 29, 124
Print command, 28, 81, 90
Print Preview command, 28, 81, 85,
86, 90, 222
Save As command, 34, 36
Save command, 34
Store Stock Item command, 30, 34
Files
Creating new, 35
Exporting graphs, 137
Importing Data, 35
Opening, 33
Saving, 34
Template, 35
Filters
Import / Export, 35
Fit Data command, 28, 73, 222
Fitting criteria, 79, 80
Font selection, 83, 85
Font settings, 91, 115, 136, 137
Footers, 30
Formatting numbers, 49, 82, 155
Functions, 102

G
Global Analysis, 205
GraFit
Installing, 17
Running, 23
Technical Support, 15
Templates, 30
Uninstalling, 21
GraFit Items, 27
GraFit Workspace, 25, 33
Graph
Axis associations, 169
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X ticks, 150
Graph menu
Add Data command, 169, 224
Axis manager, 172
New Graph command, 117
Preferences command, 124, 130
Graph types, 117
Graphs, 123
Adding data, 169
Aligning objects, 129
Arrow properties, 135
Axis association, 166
Axis scale, 155
Axis text, 157
Chart bar style, 185
Colors, 130
Creating, 117
Curve resolution, 145
Data point style, 186
Data point styles, 143
Data/curve properties, 159
Default text properties, 131
Duplicating objects, 126
Error plots, 140, 164, 182, 190
Exporting, 137
Fill properties, 133
Font properties, 136
Grid settings, 152
Grouping objects, 129
Histogram bar style, 192
Initial scaling, 190
Initial scaling, 141
Join style, 187
Join styles, 146
Legend, 139, 182, 189
Legend box, 157, 169
Line properties, 134
Location, 154
Main graph region, 148
Multiple axes, 171
Object locations, 135
Plotting equations, 144
Rotation properties, 134
Scaling, 183
Selectable regions, 148
Selecting objects, 125
Sizing objects, 126
Split axes, 171
Text, 130

Index
Text objects, 127
Tick styles, 142, 184, 191
Transformations, 141
Visibility, 149
X scale, 152
Y scale, 154
Y ticks, 154
Z ordering, 129
Grid Lines command, 124
Group command, 129

H

Insert New Object command, 94, 197
Installation, 18
Interactive Estimator, 78, 221
Internet, 15
Items
Loading and Saving, 34

L
Legend Box, 157
Margin settings, 158
Ligand binding, 271

Hard-coded Equation definition, 279

Ligand binding equations, 256

Hard-coded Equations
Enabling, 280
Inserting, 280
Library Files, 281

Limiting x data range, 77, 89

Hardware Requirements, 17
Headers, 30

Linear fitting, 73, 87
Linear regression, 211, 272
Basics, 202
Lineweaver Burk plot, 204, 269

Help commands, 31

Linked object, 28

Help menu
Contents command, 31

Linking, 196
Linking objects, 193

Henderson-Hasselbalch equation, 219

Lock Column command, 72

Hide Object command, 149, 176

Logarithmic scaling, 153

Hill Plot, 252

Logical operators, 101

Histogram, 120, 189
Histogram Wizard, 189

I

M
Marquart algorithm, 214
Mask curve option, 143

IC50 equations, 255, 270

Mean, 57, 217

Icon
Changing, 28

Menu and Toolbars, 23

Icon command, 28

Michaelis-Menten enzyme kinetics, 269

Ignore Data command, 42

Michaelis-Menten Equation, 252

Import Data command, 35, 51

Mixed Inhibition, 244

Import/Export Filters, 35

Move Back command, 129

Indents, 83, 86, 91

Move Forward command, 129

Initial estimates, 78

Multiple axes, 171

Initial Estimates, 105, 106, 203, 220

Multiple Regression, 205, 233
Advantages, 206

Insert command, 48

Metafile, 137
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Disadvantages, 206
Plotting results, 208
Uses, 205
Multiple x variables, 75, 97

N

Polynomial regression
Basics, 202
Preferences command, 54, 124, 130
Print preview, 28
Print Preview, 81, 222

Nested models, 217

Printer
Changing, 30

New Graph command, 117

Printing, 28

NMR Titration Curve, 219

Properties command, 54, 130, 131, 133,
147, 176, 177

Non-competitive Inhibition, 244
Non-linear fitting, 73
Non-linear regression, 214
Non-linear regression Basics, 202
Notepad item, 115
Number formatting, 49, 81, 82, 90, 155

O

Proxy Settings, 19

Q
Quick Access Toolbar, 23, 24

R
Random numbers, 68, 69

Object embedding and linking, 193

Rate equations, 263

Object menu, 129
Align command, 129
Group command, 129
Ungroup command, 129

Reduced chi-squared, 209

OLE objects, 95, 123, 124, 193, 197
Options command, 34, 35, 36, 50, 82,
155, 280

Regression analysis, 74, 202, 209
Assumptions, 210
Basics, 201
Linear, 211
Non-linear, 214
Reset Original Size command, 197

Outliers, 211, 215

Residual plots, 210, 216

Outlines command, 124

Residuals, 216, 224
Residuals plot, 112

P
Page Settings, 29
Page Setup command, 124
Paired Data Sets, 238
Parameters, 97, 282
Paste command, 45, 46, 51, 194, 197
Paste From command, 35, 51
Paste Special command, 197
PDF files, 18
Ping Pong Kinetics, 248
pKa determination, 261
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Results, 81, 89
Results Listing command, 82, 91, 222
Ribbon Bar, 23
Robust weighting, 74, 211, 214, 227
Rotation of objects, 134
Row constant, 68
Row Height command, 40
Rows
Selecting, 45

Index

S

Sort Column(s) command, 49

Savitzky-Golay smoothing, 70, 71

Technical Support. See GraFit, Technical
Support

Scaling power, 156

Template files, 34, 35

Scatchard plot, 271
Screen resolution, 268

Templates, 30, 36, 267
Standard, 267

Select All command, 197

Temporary variables, 103

Selection Tool, 125

Text Alignment, 156

Send to Back command, 129

Text format, 52

SetBlank function, 68, 69

Text menu, 130

Size Column to Fit command, 40

Text Orientation, 156

Software Activation, 18

Text settings, 156

Software Updates, 21

Theory, 209

Sort command, 49

TIFF file, 137

Spline curves, 147

Transformation menu
Compile command, 109, 113

Split axes, 171
Splitter box, 39
Standard Curve, 236
Standard deviation, 57, 217
Standard Error of the Mean, 57
Statistics, 57
Status Bar, 73, 87, 93, 110
Stock Items, 30
Store Stock Item command, 34
Symbol syntax, 96
Symbols font, 285
Syntax
Symbol names, 96

T
Table menu
Column Format command, 49
Column Properties command, 54
Column Width command, 40
Delete command, 48
Ignore Data command, 42
Insert command, 48
Lock Column command, 72
Preferences command, 49
Row Height command, 40
Size Column to Fit command, 40

Transformations, 109, 141, 162, 163
Compiling, 113
Curves, 112
Data points, 111
Defining, 113
Error Messages, 113

U
Uncompetitive Inhibition, 244
Ungroup command, 129
Uninstalling GraFit, 21

V
ValidData function, 68, 69
View menu
Grid Lines command, 124
Options command, 34
Show Outlines command, 124
Zoom command, 51
Visibility
Graph objects, 149

W
Weighting, 74, 88, 203, 211, 212, 213
Checking, 224
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Determining weighting type, 216
Explicit, 228
Window menu
Icon command, 28

X/Y Scatter Graph, 118, 139
XY graph wizard, 139, 159, 160, 161,
168, 169

Windows metafile, 137

Z

X

Zoom command, 51

X Variables, 97, 281
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